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CHAPTER 1

Introduction
There are several types of online output and print-based output that you can produce in Flare.
HTML5 is the recommended online output type, and for print-based output, PDF and Word are preferred. Each output type has its own set of advantages.
It is easy to confuse output types with targets, but they are two different (although related) concepts. A target is one instance of an output type. It is the engine that takes all of your files and settings, and brings them together to produce the end result. When you build your final output, you are
essentially building one or more of the targets in your project.
This chapter discusses the following:
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Initial Targets Provided
When you create a new project using one of Flare's factory templates, one or more new targets are
added to your project.
However, just because you are provided with one or more targets initially, this does not mean that
you are limited to just that target in your project. In Flare you can add targets using any of the available formats, and you can make as many copies of an existing target that you want. For example,
your project might end up containing three targets that are all based on the output type (in addition
to other targets).
A target file has an .fltar extension and is stored in the Project Organizer under the Targets folder.
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Steps for Using Targets
Following are the basic steps involved with targets:
1. Determine Output Type The first task in developing output for your project is to determine
which type of output is most appropriate for your needs. You might even need to produce multiple outputs and require more than one output type. See "Determining the Output Type" on
page 12.
2. Add Target You can add as many new targets as you want to a project. You can also copy
existing targets. See "Adding Targets" on page 48.
3. Rename Target Let's say that you have compared the different output types available and
decided that HTML5 is the output type that best meets your needs. However, you want to produce two online Help systems from your project. The solution is to add a new HTML5 target or
make a copy of another HTML5 target so that you now have two targets based on the HTML5
output type. You can then rename the targets to help identify them. See "Renaming Targets"
on page 52.
4. Open Target You can open a target at any time to edit it. See "Opening Targets" on page 53.
5. Set Primary Target You can have as many targets in a project as you want, and any of your targets can be built (generated) whenever you like. However, chances are that you will have one
target that you work with more than the others. Therefore, you can set it as your primary target. See "Setting a Primary Target" on page 54.
6. Edit Target Settings Using the Target Editor, you can edit properties for any of your targets.
See "Editing Target Settings" on page 55.
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Batch Targets
In addition to regular targets, you can use batch targets to generate and/or publish one or multiple
targets in a batch from the user interface, perhaps scheduled to run at a specific time. See "Building
Output Using a Batch Target" on page 320.

Multilingual Targets
If you want to create multilingual output, you can create a multilingual target. To do this, you can
link translated Flare projects to your current project. When you build your output, Flare will generate
output using the target files found in each linked project. When you open the output, you will be able
to access files for each language.

Exporting Projects Using Targets
You can export project files and content based on targets that you create. One reason you might
want to use this feature is to quickly and easily archive projects, especially if you have an extremely
large Flare project and need to archive only parts of it. Another use for this feature is translation. If
you only need a portion of a master project to be translated, you don't want to send the translator all
of the files, but rather a smaller version of the project containing only the files requiring translation.
For more information see the Flare online Help.
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CHAPTER 2

Determining the Output Type
One of the first tasks in developing output for your project is to determine which type of output is
most appropriate for your needs. You might even need to produce multiple outputs and require
more than one output type.
This chapter discusses the following:
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Online Output Versus Print-based Output
There is a fine line between what is called "online output" and what is called "print-based output."
The truth is that topics in virtually any of Flare's online output types can be sent to a printer, and
therefore considered print-based. Similarly, any of the print-based output types can be viewed electronically, and therefore considered online.
The real distinction between online and print-based outputs has to do with their primary purpose.
Online outputs are usually intended to be viewed on a screen, rather than on a printed page. The
idea is to show only small pieces of content at a time and allow users to jump around to other topics
or elements of the output.
On the other hand, print-based output follows a more traditional format that you would find in an
actual book or manual—with the pieces of the output following one after the other on pages until the
end of the book (e.g., title page, table of contents, preface, chapters, index, appendixes—with page
numbers, as well as header or footer content, shown along the way).
Then there is EPUB output, which is intended to be viewed on a screen, but follows a structure
closer to print-based outputs.
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HTML5—Recommended Online Output Type
HTML5 is the recommended online format in Flare. This output type supports the HTML5 specification developed by the World Wide Web Consortium (http://w3.org) and the Web Hypertext
Application Technology Working Group (http://whatwg.org). Therefore, the HTML5 format results in
better markup and offers additional features not found in the older WebHelp outputs in Flare.
The HTML5 output consists of a collection of files that you will distribute to users. The output will be
displayed in the user's Internet browser window. The main entry file has an .htm extension.

Key Features
Following are some of the key features of the HTML5 format:
Because HTML5 output is quite different from the other online formats, it requires its own skin. In
fact, you have more than one skin from which to choose.

CHAPTER 2

14

SIDE NAVIGATION SKIN
One popular option is the Side Navigation skin, in which the main navigation is positioned at the left
or right. This allows you to use a flexible, frameless output while continuing to have a more traditional configuration that looks like the Tripane format.
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TOP NAVIGATION SKIN
Then there is the Top Navigation skin. This lets you generate a flexible, frameless output like a
modern website, with the main navigation items at the top of the screen.
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TRIPANE SKIN
Another alternative is to use a Tripane skin, which lets you generate output in a traditional format
with three distinct frames (a navigation pane on the left, a toolbar and search on the top, and the
main body pane).
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SKINLESS OUTPUT
You can even tell Flare not to use any skin at all for HTML5 output. In this situation, you would rely
on proxies or links inserted directly into your content, or you would have no links or navigation at all.

SKIN COMPONENTS
You can also use smaller skin components that work with related proxies. With these, you can add
and design menus and toolbars, inserting them in your content anywhere you like. For Side Navigation, Top Navigation, and skinless outputs , you can also create search bars and customized results pages.
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NOTE: If you want to translate interface elements in an HTML5 skin, you can do this using
a language skin or using the UI Text tab located in the Skin Editor. This tab lets you perform all of the localization tasks that you would normally accomplish in a language skin.
Be aware that translations in the Skin Editor are prioritized over translations in a language
skin, so you should try to perform your localization tasks in one place to avoid conflicts.

FRAMELESS
Pages in HTML5 output do not use <frameset> or <frame> tags, like they do in regular WebHelp
output. In addition, HTML5 Side and Top Navigation outputs are completely frameless, meaning
they also do not contain iframes. This means that output is much easier for web crawlers to find,
thus improving search engine results.
NOTE: If your HTML5 output is enabled with MadCap Pulse, the comments area at the
bottom of topics is wrapped in an iframe. Therefore, the output is technically not entirely
frameless. However, because it is only the comments that are contained in the iframe, the
main topic content still retains the benefits (e.g., better search results) of frameless output.

RESPONSIVE SKINS
Responsive web design (RWD) is a way to construct your HTML5 output so that the display is adjusted automatically depending on the device. Therefore, on tablets and smart phones, users will see
a condensed look that is more appropriate for those devices, compared with larger monitors. You
can get the same effect if you shrink your browser to a smaller size. Responsiveness is automatically built in to HTML5 skins.

RESPONSIVE CONTENT
Styles and media queries can be used to make your content responsive in HTML5 output. This lets
you present information—both its substance and structure—differently depending on the size of
the screen or device. Flare provides a Responsive Layout window pane that helps you create this
kind of content more easily. You also have the option of using third-party solutions (most notably
the Zurb Foundation grid system) by adding the appropriate styles in your stylesheets and topics.
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SPECIFIC PAGE ADDRESSES
With the regular WebHelp output, you can only give readers a single URL path, which opens the
starting page for the output. With HTML5 output, you can point end users to a specific page in the
output by giving them the exact URL path. Because HTML5 output also allows for pagination in
search results, you can also direct users to specific page addresses in search results.
EXAMPLE
Let's say you generate regular WebHelp output, with the primary output file called
"MyOutput.htm." When you view the output with the initial topic shown (say it's called
"Welcome.htm"), the URL path in the browser might look something like this.
http://www.mycompany.com/docs/MyOutput.htm
And if you then click on another topic (say, "WhatsNew.htm"), the same URL path will
be shown. It does not change, even though you opened a different page.
On the other hand, suppose you generate HTML5 output. The URL in the browser
may look the same as the path for regular WebHelp when the output is first displayed.
http://www.mycompany.com/docs/MyOutput.htm
But if you click on the "WhatsNew.htm" page, the URL will change to this.
http://www.mycompany.com/docs/MyOutput.htm#WhatsNew.htm
And if you click on the "Welcome.htm" page to return to it, the URL will change to this.
http://www.mycompany.com/docs/MyOutput.htm#Welcome.htm

SEARCH ENGINE
For HTML5 targets, you can choose the type of search engine you want people to use—MadCap
Search, Google Search, or Elasticsearch (for Side Navigation, Top Navigation, or skinless output).
There are additional steps that you can follow and features you can select, depending on the
search engine you choose. For MadCap Search and Elasticsearch, you can include micro content
in the output, which can especially enhance your search results. See "Setting Up a Search Engine"
on page 214.

CHAPTER 2

21

SITEMAP/SEARCH ENGINE OPTIMIZATION (SEO)
For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEO), making it easier for search indexing services (i.e., spiders, crawlers, or bots) to find your output. Therefore, the entire output is indexed and search engine results
are improved.

MICRO CONTENT
Micro content is what it sounds like—short, concise information that stands alone and is easily consumable. In Flare, it begins with the creation of a collection of brief phrases and corresponding
responses, such as questions and answers. After generating HTML5 output, these phrase/response combinations can be used in different ways as users interact with your output. Among
other benefits, it can greatly improve the user experience when people search in your HTML5 output.
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SEARCH WITH CONTEXT
If end users perform a search in your output, they will see context next to each result, rather than
terms only.

In addition, you can create topic meta descriptions, which will be used in the search results
abstract. Also, the meta description itself is searchable.
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GLOSSARY TERMS IN SEARCH RESULTS
For HTML5 output, search results display glossary terms if they are used as the search text.

This option to display glossary terms in search results is enabled by default. However, it can be
turned off in the HTML5 Target Editor.
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SMOOTHER DYNAMIC EFFECTS
Features such as drop-down text, expanding text, and popups have a smoother appearance when
they are activated.

SERVER-BASED OUTPUT
You can create HTML5 output in its regular state, or you can select an option in the Publishing tab
of the Target Editor to enable server-based functionality. This allows you to accomplish the same
results as WebHelp Plus output—searching of non-XHTML content, server-side search, and automatic runtime merging.
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Following are benefits of server-based HTML5 output:
n

Multiple Platforms You can publish to a machine running Windows Server 2003, Windows
Server 2008, or Windows 7.

n

Searching of Non-XHTML Content When end users perform a search in your online output,
you can ensure that non-XHTML files (e.g. PDF, DOC, XLS) are included in that
search. When you build WebHelp Plus or HTML5 server-based output, a subfolder named
"AutoSearch" is created and placed in the generated output folder. You can place nonXHTML files within the published AutoSearch subfolder (whether the non-XHTML files are
linked to content from your Flare project or not). When users perform a search, those nonXHTML files will also be accessible to the users.

n

Microsoft IIS Search Engine Another benefit of generating and publishing HTML5 output to a
web server is that it takes advantage of Microsoft's IIS search engine to help power your
search. This is especially useful if you have a very large Help system.

n

Automatic Runtime Merging of Flare Projects This is an easy way to merge the output from
multiple HTML5 server-based Flare targets into one Help system. These targets can be originated from the same Flare project or from different Flare projects. You simply place the
output files in the correct location on the server (i.e., within your master project's AutoMerge
folder). Flare then automatically merges the output from all of the targets when users
access the Help. From the end user's perspective, the results are seamless, appearing as
one large Help system. All of the TOCs, browse sequences, indexes, glossaries, and search
capabilities for the projects are merged.
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Comparison of HTML5 Skin Options
The following table compares the different kinds of HTML5 outputs.
Side Nav

Top Nav

Tripane

Skinless

Frameless—No Framesets
Frameless—No iframes1
Glossary Terms in Search Results
Micro Content in Search Results
Navigation Panes—Browse
Sequence, Glossary, Index, Pulse
Community, TOC
Project Merging
Pulse Integration
Responsive Content
Responsive Skin Always Enabled
Skin Component—Favicons
Skin Component—Menu
Skin Component—Search Bar
Skin Component—Search Results
Skin Component—Topic Toolbar
1If your HTML5 output is

enabled with MadCap Pulse, the comments area at the bottom of topics is wrapped

in an iframe. Therefore, the output is technically not entirely frameless. However, because it is only the comments that are contained in the iframe, the main topic content still retains the benefits (e.g., better search results) of frameless output.
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PDF and Word—Recommended Print Output
Types
Flare offers several print-based output types, but the two recommended above the others are PDF
and Word. Following are overviews of each of these.

PDF
Short for "Portable Document Format," PDF is an open standard format for electronic documentation exchange invented by Adobe. PDF files are used to represent a two-dimensional document in an device- and resolution-independent fixed-layout format. You can generate PDF output
from your project directly, or you can generate a PDF while simultaneously building Word output.
You can also set PDF options in the Target Editor. These options let you specify the way that
images, document properties, the initial view, and security are handled in the output.
PDF output consists of a file with a .pdf extension that you can print or distribute to users.

Word
Word is an output type where the generated project is exported to Microsoft Word in one of the following formats: XML (default), DOC, DOCX, XPS, PDF. However, you can also create PDF output directly, without going through Word.
If you track changes in your topics for review purposes, you can preserve these changes in Word output.
NOTE: Unless you specify otherwise, the Word target will create files with an .xml extension
only. If you want to use one of the other formats see the online Help.

NOTE: Flare supports Microsoft Word 2003 and newer versions.

NOTE: To create output in DOCX or XPS format, you need to have at least Microsoft Word
2007 installed. Also, Word 2007 allows you to create PDF files from Word without needing to
have the Adobe Distiller installed.
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Other Output Types
Following are overviews of additional output types that are somewhat unique.

Clean XHTML
Clean XHTML produces basic HTML files that are free of MadCap-specific tags and not dependent
upon other MadCap-generated files. The output does not include any skins, search, navigation, or
other extra features; it is simply your single-sourced content. This allows you to re-purpose your output in many flexible ways (e.g., you can embed the output files into other applications, such as project management tools, wikis, or eLearning systems). You might also perform other types of postprocessing tasks with the output.
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Following are some important points to keep in mind with this output type:
n

Single-Sourcing Flare’s unique features are applied during compilation so that you still end up
with single-sourced output.

n

MC Tags All mc tags and data-mc tags are removed, including keywords, concepts, conditions, etc.
NOTE: The MC tags that are removed for Clean XHTML output are related to
MadCap-specific features, such as drop-downs and cross-references. Although these
tags are removed from the output, the generated style classes that start with “MC”
are preserved, because they are needed to support these MadCap-specific features.
Therefore, these style classes are converted during the build, and they are defined in
the generated MadCap.css file.

n

Namespace The MadCap namespace is removed.

n

MadCap JavaScript For Clean XHTML output, MadCap-injected JavaScript is removed. In
other words, features such as drop-downs, Help controls, text popups, and footnotes rely on
JavaScript to work. Therefore, with Clean XHTML output, these elements are converted to
text. However, custom scripts that you might have added to topics will not automatically be
removed when you generate Clean XHTML; if you want to exclude these custom scripts, you
must do so manually (i.e., by deleting them or using conditions).

n

Images/Multimedia Images and other multimedia remain as separate files in the output and
are included in the topics by reference.

n

MadCap Styles All MadCap-specific styles are removed from the user stylesheet.
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n

Convert to Inline Styles In the Target Editor (General tab), there is an option to convert
stylesheet styles to inline styles.
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If you choose this option, the output folder will not include stylesheet files. That’s because the
styles have been integrated into the topic files.
If Option Is Not Selected

If Option Is Selected

Output Content/Resources Folder:

Output Content/Resources Folder:

Topic Markup:

Topic Markup:
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DITA
Darwin Information Typing Architecture (DITA) file content is supported in Flare. DITA is an XMLbased markup language with its own schema for authoring, producing, and delivering technical
information. It is a standard of the Organization for the Advancement of Structured Information
Standards (OASIS), and it consists of a set of design principles for creating "information-typed" modules at a topic level and for using that content in various delivery modes.
DITA allows companies (especially larger ones) to maintain better consistency throughout its documentation by establishing structural rules and standards for all of its authors to follow. The idea is
that writers will spend more of their time authoring content, rather than worrying about the presentation of that information.
In Flare you can generate output that produces DITA files. When you build this type of output, a
DITA map file is generated, with multiple DITA files in it. The XHTML tags are converted to DITA elements. In other words, although it is considered an "output" from the standpoint of the Flare process, the end result is actually a collection of "source" files, which you can later use in another tool
(or import back into Flare) to produce the final output.
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Eclipse Help
The Eclipse Help output lets you generate Eclipse Help plug-ins using your Flare content as its
source material. It displays your output content in the Eclipse Help Viewer.
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The Eclipse Help Viewer uses an embedded Jetty server to provide your users with navigation features similar to other online viewers. Jetty is a Java-based web server implementation that tightly
integrates with Eclipse and other open source projects.

The viewer's features and user interface must be customized in Eclipse. To learn about your customization options, visit this link: http://help.eclipse.org/kepler/index.jsp.
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The Eclipse Help output type (called a "plug-in" in Eclipse) consists of the following components:
n

Plug-In XML File This is an XML-based main file that defines the name and ID of the Eclipse
help plug-in that you generate with Flare.
EXAMPLE
The output generates a plugin.xml file for Eclipse:

The plugin.xml file contains the extension point definitions that the Eclipse
runtime environment needs to activate your help plug-in:
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n

HTML Content Files As with other output types, Flare publishes a separate HTML file for each
documentation topic. These are contained in the Content folder.
EXAMPLE
As with other output types, the Content folder contains your Flare target's topics:

n

Other XML Files Flare publishes separate XML files for the table of contents, keyword index,
and context-sensitive Help . These correspond to the org.eclipse.help.toc, org.eclipse.help.index, and org.eclipse.help.contexts extension points.

n

Manifest.MF File The manifest file is used only when you package your Eclipse help plug-in as
a Java archive (JAR) file. This file is required by Java when creating a JAR file.
EXAMPLE
If you package your Eclipse help plug-in as a JAR file, the META-INF folder contains the required Manifest.MF file.
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KEY FEATURES
Following are some of the key features of the Eclipse Help format:
n

Eclipse Help Plug-In and Extension Points This output type is particularly useful when you
want to create dynamic, searchable content that integrates into the Eclipse workbench as a
platform plug-in. Flare generates an XML-based plug-in file (plugin.xml) that specifies the
context Help (csh.xml), index (index.xml), and table of contents (toc.xml) files that Eclipse
needs to load your Flare content in the Eclipse Help system.

n

Eclipse Help Viewer and Dynamic Help Window You can generate the Eclipse Help output for
viewing with the Eclipse Help Viewer and the Eclipse Dynamic Help window, which displays
context-sensitive Help and search results.

n

Distribute Server-based or Local Content Your Eclipse content can be distributed over the
web via an Eclipse InfoCenter server or on local systems with a pared down version of
Eclipse, which provides the search capabilities and skin for the Eclipse Help Viewer.

n

Publish Content as a Collection of Files or Single JAR File This format lets you publish the output for the Eclipse Help plug-in as a series of files in a folder or bundled in a single Java
archive (JAR) file.

ADDITIONAL INSTALLATIONS
To take advantage of this output type, you must perform these additional installations:

JAVA RUNTIME ENVIRONMENT (JRE)
As the individual compiling the output, you need to install the required Java Runtime Environment
(JRE), which is part of the "Eclipse IDE for Java EE Developers" download. For more information
see the Flare online Help.

JAVA
As the individual compiling the output, you must download and install the Java Version 7 (Update
45) or later on your Windows operating system. For more information see the Flare online Help.
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RECOMMENDED READING
If you are new to the Eclipse platform, be sure to visit the links below to learn more about it:
n

Eclipse Foundation http://www.eclipse.org/

n

Eclipse Documentation http://help.eclipse.org/kepler/index.jsp

n

Eclipse Doc Style Guide http://wiki.eclipse.org/Eclipse_Doc_Style_Guide

NOTE: Eclipse provides its own breadcrumb and topic toolbar support. See the Platform
Plug-in Developer Guide from Eclipse at: http://help.eclipse.org/kepler/index.jsp.

NOTE: If your Eclipse Help target contains non-web safe images (e.g., WMF, EMF, BMP,
TIF, TIFF), be sure to select Generate "web-safe"images in the Advanced tab of the Target
Editor.

NOTE: The Eclipse Viewer cannot display PDFs opened from links such as those in TOCs.

NOTE: When you create a TOC intended for Eclipse output, you should make sure all
items are linked. Unlinked items may not display in the output.

NOTE: Eclipse does not use the Flare skin, so there will be no glossary pane in the output.
However, you can insert a Glossary proxy (which is normally used for print-based outputs)
as an alternative.

NOTE: Java bits and Eclipse bits must match in order to view Eclipse output in Flare. For
example, Java 64-bit and Eclipse 64-bit must both be used/installed.
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EPUB
EPUB is an online format for creating reflowable digital books (ebooks). This format is developed
and maintained by the International Digital Publishing Forum (IDPF). For additional information
about this group and the EPUB format, see http://idpf.org/.
EPUB is sort of a hybrid format. The output is designed to be viewed electronically; in that way, it is
like an online format. On the other hand, its structure is like a book or manual; in that way, it is like a
print-based format. In fact, you can follow many of the same steps for creating PDF output to produce EPUB output.
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FEATURES
Following are some of the features of the EPUB format in Flare:
n

Reflowable EPUB output allows for reflowable content, such as word wrap and resizeable
text. Therefore, the content can be displayed optimally on different devices.

n

Single File You only need to distribute a single EPUB file, rather than a collection of files and
folders.
NOTE: If you extract the EPUB file using another tool, you will find that it contains
one or more XHTML files. If you have used chapter breaks in the outline TOC, a new
XHTML file is created at each point where a chapter break occurs. If you do not use
chapter breaks, the EPUB contains just one XHTML file.

n

Embedded Metadata In the EPUB target you can provide information such as a title, author,
publisher, rights, ISBN, identifier, which become embedded in the final output. The document title you provide will usually be displayed at the top of the EPUB reader. If you do not
provide a title, the target name will automatically be used instead.
For more information about EPUB metadata and the fields supported in Flare (except "Tag"),
see:
http://idpf.org/epub/20/spec/OPF_2.0.1_draft.htm#Section2.2

n

Embedded Fonts Flare includes all of your used fonts in the final EPUB output file. Therefore,
if someone has a reader that does not have your fonts installed, that person will still be able
to see your content as you designed it.

n

Cover Page You can use the Target Editor to quickly and easily select an image file to be
used as the cover for your ebook.

n

Validate EPUB Output You can validate EPUB output so that it will be acceptable to most
online stores, such as amazon.com.

n

MOBI Output MOBI is the standard format used for the Amazon Kindle. You can use settings
in the Target Editor in Flare to generate EPUB output that uses MOBI content.

n

MathML to PNG Conversion If you use the Equation Editor to insert equations, you are in
essence creating MathML markup. This type of content is supported for EPUB output. If you
need to produce output that can be displayed on older readers, you can select an option in
the Target Editor to convert all of your MathML content to PNG image files.
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n

Enable or Disable Dynamic Content Per Target If you use dynamic content—togglers,
popups, drop-downs, expanding text, slideshows, or help controls—in your output, you may
want to enable dynamic content for your EPUB target so your users can take advantage of
these features. Likewise, you may want to disable dynamic content if your users are using
an e-reader that does not fully support dynamic content.

n

Select Reader to View Output From the Builds window pane, you can select a specific EPUB
reader (if you have more than one installed) to view the output.

READING SYSTEMS
EPUB output can be viewed on many kinds of software and hardware, across many platforms. Following are just a few examples of reading systems for EPUB output:
n

Amazon Kindle (MOBI)

n

Barnes & Noble Nook

n

Bluefire Reader (Android, iOS)

n

EPUBReader (Firefox)

n

Duokan (Kindle)

n

iPad, iPhone, iPod Touch

n

Lexcycle Stanza (iOS, Windows, Mac OS X)

n

Mobipocket (Windows, Blackberry, Symbian, Windows Mobile)

n

Sony Reader

IMPORTANT: Some readers handle EPUB output and respect your formatting better than
others.

CHAPTER 2

43

HTML Help—Legacy Online Output Type
Although HTML5 is the recommended online output type, there is an older online output type called
"HTML Help" that is also supported in Flare.
Microsoft HTML Help is an HTML-based Help format that runs on Windows 32-bit platforms and
requires Internet Explorer on the end users' systems. You can use Microsoft HTML Help to create
Help for Windows desktop applications.
The Microsoft HTML Help output consists of a single CHM file that you will distribute to users.

KEY FEATURES
Following are some of the key features of the Microsoft HTML Help format:
n

32-bit Windows Application Support

n

Internet Explorer Support

n

Local This format is a good choice if you want users to store and open the output locally,
rather than from a server, such as a website.

n

Single File This format is a good choice if you want to create output that has just one file.

NOTE: Your users need Internet Explorer (4.0 or later) installed and a 32-bit Windows operating system (Windows 95 or later).
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Deprecated Output Types
Following are output types that will be removed in a future release of MadCap Flare. It is recommended that you use HTML5 instead of these.

WebHelp
WebHelp is a Web-based Help format that can run on almost any browser or platform. You can use
WebHelp to create online documentation for the Internet or an intranet, as well as for desktop
applications.
The WebHelp output consists of a collection of files that you will distribute to users. The output will
be displayed in the user's Internet browser window. The main entry file has an .htm extension.

KEY FEATURES
Following are some of the key features of the WebHelp format:
n

Multiple Browsers This format is a good choice if your users have different Internet
browsers on their systems.

n

Multiple Languages You can produce an output interface in various languages. This is possible through the use of language skins.

n

Multiple Platforms This format is a good choice if your users are working on different platforms (operating systems).

n

Web-Based This format is a good choice if you are writing online documentation for distribution on the Internet or an intranet.

n

Sitemap/Search Engine Optimization (SEO) For web-based targets, you can generate a
sitemap when compiling your output. This helps with search engine optimization (SEO), making it easier for search indexing services (i.e., spiders, crawlers, or bots) to find your output.
Therefore, the entire output is indexed and search engine results are improved.

NOTE: The following browsers are supported for WebHelp: Internet Explorer 7.0 or later,
Firefox 3.5 or later, Safari 4.0 or later, Google Chrome, and other browsers that support
scripts and framesets.
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WebHelp Plus
WebHelp Plus is a Web-based Help format that is identical to the regular WebHelp output in most
ways. However, WebHelp Plus is designed to work on a Web server running Windows 8, Windows 7,
Windows Server 2012, Windows Server 2008 R2, Windows Server 2008, or Windows Server 2003. It
also uses Microsoft Internet Information Services (IIS) and ASP.NET. To provide faster search,
WebHelp Plus uses Microsoft Indexing Service or Windows Search. The benefit of publishing
WebHelp Plus output is that you and your users can take advantage of some advanced features,
including searching of non-XHTML content, faster server-side search, and automatic runtime
merging.
The output consists of a collection of files that you will distribute to users by publishing output to a
Microsoft IIS web server. The output will be displayed in the user's Internet browser window. The
main entry file has an .htm extension.

KEY FEATURES
Following are some of the key features of the WebHelp Plus format.
n

WebHelp Features This format lets you take advantage of features and benefits available
with the regular WebHelp output type.

n

Sitemap/Search Engine Optimization (SEO) For web-based targets, you can generate a
sitemap when compiling your output. This helps with search engine optimization (SEO), making it easier for search indexing services (i.e., spiders, crawlers, or bots) to find your output.
Therefore, the entire output is indexed and search engine results are improved.

n

Multiple Platforms This format is a good choice if you publish your output to a machine running Windows Server 2003, Windows Server 2008, or Windows 7.

n

Searching of Non-XHTML Content When end users perform a search in your online output,
you can ensure that non-XHTML files (e.g. PDF, DOC, XLS) are included in that search.When
you build WebHelp Plus or HTML5 server-based output, a subfolder named "AutoSearch" is
created and placed in the generated output folder. You can place non-XHTML files within
the published AutoSearch subfolder (whether the non-XHTML files are linked to content
from your Flare project or not). When users perform a search, those non-XHTML files will
also be accessible to the users.

n

Faster Searching Another benefit of generating and publishing WebHelp Plus or HTML5
server-based output to a web server running Microsoft IIS is that users will find the task of
performing a search to be much faster than it is otherwise. This is especially useful if you
have a very large Help system.
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n

Automatic Runtime Merging of Flare Projects This is an easy way to merge the output from
multiple WebHelp Plus or HTML5 server-based Flare targets into one Help system. These targets can be originated from the same Flare project or from different Flare projects. You
simply place the output files in the correct location on the server (i.e., within your master project's AutoMerge folder). Flare then automatically merges the output from all of the targets
when users access the Help. From the end user's perspective, the results are seamless,
appearing as one large Help system. All of the TOCs, browse sequences, indexes, glossaries,
and search capabilities for the projects are merged.

NOTE: If you want to test WebHelp Plus on your local computer, the advanced search features of WebHelp Plus are not operable.

NOTE: The following browsers are supported for WebHelp Plus: Internet Explorer 7.0 or
later, Firefox 3.5 or later, Safari 4.0 or later, Google Chrome, and other browsers that support scripts and framesets.
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CHAPTER 3

Adding Targets
You can add as many targets as you want to a project.

HOW TO ADD TARGETS
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Content section select New > Target.

n

Right-Click In the Project Organizer, right-click on the Targets folder and from the context
menu select Add Target.

The Add File dialog opens.
2. In the File Type field at the top, make sure Target is selected.
3. In the Source area select one of the following:
n

New from template Choose either the factory template file or one of your own customized template files as a starting point. The new file will take on all of the settings contained in the template. If you want to use the factory template provided by Flare, expand
the Factory Templates folder and click on a template file. If you want to use your own customized template file, expand the appropriate folder and click on a file. For more information about templates, see the online Help.

n

New from existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click the browse button
, use the Open File dialog to find a file, and double-click it.
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4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click
and select the subfolder. Otherwise,
keep the default location.
5. In the File Name field, type a new name for the target.
6. From the Output Type field, select one of the available output formats. You can always
change the output type later in the Target Editor. See "Determining the Output Type" on page
12.
7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
and select the conditions you
want to apply. Click OK.
8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click
and select the file tags you want to apply. Click OK.
9. Click Add. The target is added to the Targets folder in the Project Organizer. The Target Editor
opens to the right.

HOW TO MAKE COPIES OF TARGETS
1. Open the Project Organizer.
2. Double-click the Targets folder. The available targets are shown.
3. Click on the target that you want to copy.
4. Press CTRL+C on your keyboard.
5. Press CTRL+V on your keyboard. A copy of the target is added to the Targets folder. The new
target is given the same name as the target you copied, with the words "Copy of" before it.
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CHAPTER 4

Importing Targets
Not only can you add a new target, but you can also import an existing target (FLTAR file).

HOW TO IMPORT A TARGET
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Content section select New > Target.

n

Right-Click In the Project Organizer, right-click on the Targets folder and from the context
menu select Add Target.

The Add File dialog opens.
2. Select New from existing and click

.

3. Find and select the FLTAR file that you want to import.
4. Click Open. The Source File field now contains the path to the file that you are importing. Also,
the name of the file is displayed in the File Name field.
5. If you want to give the target a different name than that for the imported file, click in the File
name field and replace the text.
6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
and select the conditions you
want to apply. Click OK.
7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click
and select the file tags you want to apply. Click OK.
8. Click Add. The target is added and opens in the Target Editor.
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NOTE: As an alternative to importing single files from another location, you can import
linked files from a Flare source project using a featured called "Global Project Linking." This
is different than a simple import process, because in this case, the imported files remain
linked to the source project. This allows you to make future updates to those files in just one
place—in the source project file. When you perform ongoing imports using your previous settings, Flare recognizes changes to the source files. Therefore, the new files can be brought
over, replacing the outdated files.
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CHAPTER 5

Renaming Targets
When you create a new project using one of Flare's factory templates, one or more new targets are
added to your project.
It is usually helpful to rename the targets that you use to reflect the nature of your project (especially if you are using multiple targets with the same output type).

HOW TO RENAME A TARGET
1. Open the Project Organizer.
2. Double-click the Targets folder. The available targets are shown.
3. Click on the target that you want to rename.
4. Press F2. The name in the target is highlighted.
5. Type a new name for the target and press Enter on your keyboard. The target is renamed.

EXAMPLE
If you are producing a Help system for a software application called FictionSoftPro, you
might want to rename the target "FictionSoftPro." If you are creating a beginner's version and an advanced version of your Help system, you might want to name one target
"Beginner FictionSoftPro" and the other target "Advanced FictionSoftPro."

CHAPTER 5

52

CHAPTER 6

Opening Targets
When you want to modify an existing target, use the following steps to open it. You can use the first
set of steps to quickly open the primary target, or you can use the second set of steps to open a specific target (not necessarily the "primary" target).

HOW TO OPEN THE PRIMARY TARGET
Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Primary Files section select Primary Target.

n

Keyboard Shortcut Press CTRL+F9.

HOW TO OPEN A SPECIFIC TARGET FROM THE QUICK LAUNCH BAR
The Quick Launch bar allows you to search for any Flare file or command. It is located in the upperright corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.
1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any available results appear in a drop-down list.
2. From the list, click the name of the file.

HOW TO OPEN A SPECIFIC TARGET FROM THE PROJECT ORGANIZER
1. Open the Project Organizer.
2. Double-click the Targets folder. The targets in your project are displayed.
3. Double-click the target that you want to open. The Target Editor opens to the right, with the
target page shown.
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CHAPTER 7

Setting a Primary Target
You can have as many targets in a project as you want, and any of your targets can be built (generated) whenever you like. However, chances are that you will have one target that you work with
more than the others. Therefore, you can set it as your primary target.
When you first create a project, the Start New Project Wizard asks you to specify a primary target.
The steps below show you how to change which target is the primary one.
A primary target is treated just like any of your other targets, with one exception. There are certain
shortcuts in Flare that let you build, view, or publish your primary target more quickly.

HOW TO SET A PRIMARY TARGET
1. Open the Project Organizer.
2. Double-click the Targets folder. The available targets are shown.
3. Right-click on the target that you want to make the primary target. In the context menu,
select Make Primary. The new primary target has a green arrow next to it with "(Primary)"
added after the name of that target.
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CHAPTER 8

Editing Target Settings
Using the Target Editor, you can edit properties for any of your targets.
This chapter discusses the following:
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Associating a Browse Sequence with a Target

60

Associating Conditions with Targets

61

Associating an Alias File with a Target

77

Creating Pre- and Post-Build Events

78

Adding the DOCTYPE Declaration to Generated Topics

86

Specifying EPUB Options

88

Enabling Feedback in Flare

98

Associating Glossaries with Targets

100

Specifying Buttons for HTML Help Output

102

Displaying Merged Navigation in HTML Help Child Outputs

105

Patching Stylesheets and Image Links for HTML Help

107

Embedding Images in Word Output

108

Enabling Review Mode in Word Output

109

Generating Web-Safe Images

110

Disabling Auto-Sync of Import Files

111

Excluding Index Entries From Search

112

Selecting a Language
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Synchronizing Navigation Elements with TOC Entries

125

Removing MadCap Styles

132

Adding Mark of the Web

133

Associating Master Pages with Targets

136

Disabling the Use of Master Pages

137

Adding Custom Meta Tags

138

Specifying the Output File and Folder in a Target

141

Replacing Characters and Spaces with Underscores

142

Using Custom File Extensions

143

Excluding Content not Linked Directly or Indirectly from Targets

144

Converting Output File Names and Folders to Lowercase

148

Omitting the Content Folder from Output

149

Changing the Output Type for a Target

150

Associating Master Page Layouts with Targets

151

Specifying PDF Options

152

Specifying PDF Output Via Word

163

Collapsing Top Margins

165

Improving the Processing Performance of the Target

167

Specifying How Online Features are Converted in Printed Output

169

Associating Publishing Destinations with Targets

171

Integrating Flare and Pulse

173

Setting Redacted Text on Targets

209

Associating Relationship Tables with Targets

210

Associating a Search Filter Set with a Target

211

Enabling Partial-Word Search

212

Setting Up a Search Engine

214

Associating Skins with Targets

234

Adding Favicons

235

Setting All Skins to be Generated

250
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Getting the Latest Version

252

Specifying the Startup Topic in a Target

254

Associating Master Stylesheets with All Files

255

Associating a Medium with a Target

257

Converting Stylesheet Styles to Inline

258

Associating a Master TOC with a Target

260

Using the TOC Depth for Heading Levels in Print Output

261

Creating Headings for Unlinked Books in a Generated TOC

264

Removing Images from Headings in a Generated TOC

267

Overriding Variable Definitions in Targets

269

Overriding Variable Definitions in Snippets

273

Setting Up a WebHelp Plus Target

279

Enabling Mirror Margins in Word Output

281

Ignoring Warnings When Building Output

282

Preventing External URLs
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Applying Empty Alt Text
Supported In:

By default, a new image does not contain an "alt" (alternate text) attribute when you insert it into a
topic or snippet, unless you specifically add alt text in the Insert Image dialog. However, alt attributes on images are required for Section 508 compliance, even if the string is empty or null (alt="").
Also, by adding empty alt attributes to images, you can search the files to find the images without
alternate text and then add it as needed.
There are a couple of ways to quickly add empty alt tags to images:
n

When Output is Generated You can select an option in the Advanced tab of the Target Editor.
As a result, empty alt tags are automatically added to images that do not already have them.
The empty alt attribute gets added to the output when the target is generated.

n

When Images are Inserted You can use a global setting in the XML Editor tab of the Options
dialog (File > Options). This automatically adds an empty alt tag to images when you insert
them into a topic or snippet (unless you specifically add an alt tag to an image).
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In addition to images, this also works for QR codes and equations, since those elements are converted to images in the output.

HOW TO APPLY EMPTY ALT TEXT WHEN OUTPUT IS GENERATED
1. Open a target.
2. On the Advanced tab of the Target Editor, select Use empty ALT text for images that do not
have ALT text.
3. Click

to save your work.

HOW TO APPLY EMPTY ALT TEXT WHEN IMAGES ARE INSERTED
1. Select File > Options. The Options dialog opens.
2. Select the XML Editor tab.
3. Select the Insert Empty Alt Text check box. A check mark indicates the feature is enabled.
4. Click OK.
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Associating a Browse Sequence with a
Target
After you enable a browse sequence in a skin, you need to associate it with a target (unless it is
linked to another browse sequence that is associated with a target).
If you have created only one browse sequence for your project, you do not need to associate it with
a target. It will display automatically after you build the target. However, if you have added more
browse sequences, you need to specify which one will serve as the "master browse sequence." This
is the browse sequence that will be displayed in the output. The additional browse sequences will
also be displayed if you have linked to them from the master browse sequence. Use the following
steps to specify a master browse sequence, associating it with a target.

HOW TO ASSOCIATE A BROWSE SEQUENCE WITH A TARGET
1. In the Project Organizer, open the target.
2. In the Target Editor, click the General tab.
3. Click the drop-down arrow in the Browse Sequence field, and select the browse sequence to
associate with the target.
4. Click
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Associating Conditions with Targets
Supported In:

After creating and applying condition tags, you need to tell Flare what your target should do with the
condition tags that you have created and applied. Should content with a particular condition tag be
included in or excluded from that target?

HOW TO ASSOCIATE CONDITION TAGS WITH A TARGET
1. Open the Project Organizer.
2. Double-click the Targets folder. The folder opens, showing the targets in your project.
3. Double-click the target that you want to associate with one or more condition tags. The Target Editor opens to the right.
4. Click the Conditional Text tab.
5. There are two ways to use the Conditional Text tab—Basic and Advanced. By default when
you open this tab for the first time, the Basic option is selected. You can click Advanced to
switch to that mode if you are experienced at writing condition tag expressions by hand. While
the Basic section is easier for most people to use, it is also more limited in the type of expressions it can create.
With the Basic method, all of your work is done on the top half of the user interface, by just
clicking check boxes. On the other hand, with the Advanced method, most of your work is
done on the bottom portion of the user interface.
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NOTE: If you are an experienced user and want to use the Advanced mode, you
might find it helpful to begin with the Basic mode to create the initial expression and
then switch to Advanced when you are ready.
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INSTRUCTIONS FOR THE BASIC METHOD
In the Condition Tag Sets area, you can choose to view tags for all condition tag sets or you
can select a specific set. The tags associated with the selected set are shown to the right,
with their associated colors. An Action cell appears next to each condition tag. When Basic is
selected, the Action cell is shown and the Advanced section below is disabled. In the Tags
area, select a condition tag in the grid to set its action. (You can also hold down the SHIFT or
CTRL key and choose multiple rows to set the same action on all of them at once.)

The Action cell in the grid indicates the current setting for the condition. To change the setting, click the Action drop-down to the right and choose one of the options.
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EXAMPLE
Suppose you have two condition tags—one called "Beginner" and another called
"Advanced." Let's say that you have a topic containing three paragraphs. You
apply the Advanced tag to the first two paragraphs, and you apply the Beginner
tag to the last two paragraphs.
You have created a target called "Advanced Set Up." For this target, you obviously want to include all content associated with the Advanced tag, but you
want to exclude content associated with the Beginner tag.
By default, Flare will include content associated with both tags, unless you tell it
not to. So you tell Flare to exclude the content associated with the Beginner
tag. The problem is the middle paragraph from the topic mentioned above. It is
associated with both tags. You have told Flare to exclude content associated
with the Beginner tag, and it will do so, overriding the default. But you want to
make sure that paragraph is included in the "Advanced Set Up" output. That is
why you need to make sure you select the Include check box next to the
Advanced tag.

WARNING: If you do not select any check boxes at all, all of the tags will automatically be included. If you include only some tags and exclude others, any remaining tags without check marks for either Include or Exclude will automatically be
included. However, if you select Include for any of the tags (even just one) and do
not select Exclude for any tags, all of the other tags that do not have Include check
marks will automatically be excluded. If you want to be safe and always know that
the correct tags are included or excluded, you can make sure that all of the tags
have check marks with either Include or Exclude.
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When you click check boxes in the Basic section, you are creating expressions with "or" statements (e.g., "include this condition tag or that one"). And when you do this, you can see the
resulting expression displayed in the Advanced section below.
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INSTRUCTIONS FOR THE ADVANCED METHOD
If you are a more experienced user, you may decide to use the Advanced section to write
expressions manually, rather than clicking check boxes. You can type the names of the condition tags as well as any of the following tokens: OR, AND, NOT, (). This allows you to produce
more complex, robust expressions to control your output (i.e., "and" statements, as well as "or"
statements).

COPY FROM BASIC
When you select Advanced for the first time, the Basic section becomes disabled (i.e., the
check boxes are hidden), and the Advanced section is enabled but empty (even if you've previously selected conditions in the Basic section). However, you can copy the expression
from the Basic section to the Advanced section. This is a quick and easy way to create an initial expression and then tweak it with "and" statements.
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DOUBLE-CLICK TAGS
Another trick you can use while working in the Advanced section is to double-click any tag
from the Basic section. This adds the condition to the Advanced section so you do not have
to type it. Just make sure your cursor has been placed in the Advanced section before doubleclicking a condition tag. If you don't click in the Advanced section first, the newly added condition tag will overwrite all of the text you've entered previously in the Advanced section.
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WARNING ICON
When you type in the Advanced section, a yellow warning icon displays with relevant text if
you have typed an error.
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You can expect to see this icon quickly appear and then disappear as you type. However, if
the icon remains after you finish, you can click it. The error will then be highlighted in the text
below.

6. Click
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EXAMPLES OF CONDITION EXPRESSIONS
Following are some examples of condition expression strings.
EXAMPLE—OR
Primary.Website OR Primary.AllPrint
This is a simple expression that includes content that has either Website or AllPrint conditions applied to it.
So let's say you have a topic that looks like this.

In the output, you will see this.
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EXAMPLE—AND
Primary.Website AND Primary.AllPrint
This expression includes content that has Website and AllPrint conditions applied to it.
However, the output can also include other conditions not listed in the expression, since
they are not explicitly excluded.
So let's say you have a topic that looks like this.

In the output, you will see this.

Notice that the second sentence is included even though it contains not only the
AllPrint and Website conditions, but also the PDFA and PDFB conditions.
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EXAMPLE—AND/AND NOT
Primary.Website AND Primary.AllPrint AND NOT Primary.PDFA
This expression includes content that has Website and AllPrint conditions applied to it.
In addition, it specifically excludes content with the PDFA condition.
So let's say you have a topic that looks like this.

In the output, you will see this.

The second sentence with both Website and AllPrint does not display in the output
because the PDFA condition is in that sentence too, and it was set to be excluded.
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EXAMPLE—AND NOT (AND)
Primary.Website AND NOT (Primary.AllPrint AND Primary.PDFB)
This expression includes any content with the Website condition applied to it. In addition, it specifically excludes content with both the AllPrint and PDFB conditions.
So let's say you have a topic that looks like this.

In the output, you will see this.

The sentence that had both the AllPrint and PDFB conditions was excluded. However,
another sentence that has the Website and PDFB conditions was included. That's
because the exclusion only occurs if both the AllPrint and PDFB conditions have been
applied to the sentence.
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WARNING: When you switch between the Basic and the Advanced view, your work is preserved independently in both. However, be cautious when using the copy button. Because
of the way this feature is designed, it is a best practice to use either the Basic section or the
Advanced section in the long term, but not both. Although it is possible to copy expressions
from the Basic to the Advanced section, and this can save you lots of time, you should not
try to switch between sections over time. The reason for this is that every time you make
changes in the Basic section and click the button to copy the expression to the Advanced
area, your previous advanced expression will be overwritten.

NOTE: When you generate the target, Flare uses the expression from the section that is
selected—Basic or Advanced.
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Associating an Alias File with a Target
Supported In:

If you have added more than one alias file for your project, you need to associate the appropriate
alias file with the target that you plan to build. If you do not specify an alias file in a target, Flare uses
the first alias file listed in the Project Organizer.

HOW TO ASSOCIATE AN ALIAS FILE WITH A TARGET
1. Open the target.
2. In the Target Editor, click the Advanced tab.
3. Click the drop-down arrow in the Alias File field, and select the alias file that you want to associate with the target.
4. Click
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Creating Pre- and Post-Build Events
In the Target Editor, you can add pre- or post-build events to your target. This lets you run command
line events before or after the target is generated.

You can type commands directly into the fields. In addition, you can click the Insert Build Variable
button for either the pre-build or post-build event to open a dialog. This lets you insert build-specific
variables (e.g., target name, project name, project directory) into a command.

CHAPTER 8

78

HOW TO CREATE PRE-BUILD EVENTS
1. Open a target.
2. On the Build Events tab of the Target Editor, enter a command in the Pre-Build Event Command text box. Be sure to use a separate line for each command.
3. (Optional) If you need to insert a build variable into your command, click Insert Build Variable.
The Pre-Build Event Command dialog opens. Do the following:
a. In the text box, place your cursor where you want to insert a variable.
b. From the Variable column, select the variable you want to add to the command. The
variable's value is shown in the Value column.
c. Click Insert to add the variable to the command.
d. When you are finished adding variables to the command, click OK.
4. Click
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HOW TO CREATE POST-BUILD EVENTS
1. Open a target.
2. On the Build Events tab of the Target Editor, enter a command in the Post-Build Event Command text box. Be sure to use a separate line for each command.
3. (Optional) If you need to insert a build variable into your command, click Insert Build Variable.
The Post-Build Event Command dialog opens. Do the following:
a. In the text box, place your cursor where you want to insert a variable.
b. From the Variable column, select the variable you want to add to the command. The
variable's value is shown in the Value column.
c. Click Insert to add the variable to the command.
d. When you are finished adding variables to the command, click OK.
4. Click
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EXAMPLE—C OPY FILES TO OU TPU T FOLDER
Let’s say you need to place copies two PDF files—named “MyPDF1” and “MyPDF2”—into
your Output folder after the target is generated.
Instead of doing this manually after the output is compiled, you open the target and
select the Build Events tab. Then you enter a command in the Post-Build Event Command field. In this case, the command is as follows:
for %I in (C:\Users\myusername\Desktop\MyPDF1.pdf
C:\Users\myusername\Desktop\MyPDF2.pdf) do copy %I "$(OutputDirectory)"
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With this particular command, Flare will copy the PDF files from your desktop, so that’s
where you place these two original files. After you save your changes in Flare, you generate the target. When you look in the output folder in Windows, you will see the two
PDF files.
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EXAMPLE—C REATE A FOLDER
Let’s say you want to automatically create a new folder on your desktop just before
your target is generated.
First, you can open a simple text editor such as Notepad and type a command such as
this:

You save the file as a batch (.bat) file. In the following example, we saved this batch file
on our desktop, but you can save it anywhere.
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Next, you open the target, select the Build Events tab, and in the Pre-Build Event Command field you enter the command that points to the batch file. In this case, the command is as follows:
C:/Users/myusername/Desktop/Create_Directory.bat

CHAPTER 8

84

As soon as you build the target, a new folder named “MyDirectory” is added to the
desktop:

NOTE: If command line errors occur, they will be included in the build log. However, they will
not prevent the project from compiling.
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Adding the DOCTYPE Declaration to
Generated Topics
Supported In:

You can add the DOCTYPE declaration to topic files when you generate online output. This allows
browsers to render the topics in strict mode. If you do not select this option, generated topics will
not have this declaration and will be rendered by browsers in quirks mode.
Quirks mode and strict mode have to do with the evolution of web browsers and the rules they use
to interpret styles in cascading stylesheets (CSS). Quirks mode follows the old rules, and strict
mode follows the new rules. If you are not concerned about which mode is used for your online output, you do not need to add the DOCTYPE declaration to topics. However, if you want to ensure that
your output is interpreted and displayed using the newer strict mode, you should use this option.
Why use the DOCTYPE declaration? You might find the need to use the DOCTYPE declaration feature if you have text boxes, images, tables, or other objects that have float, margin, or padding settings applied to them. With settings such as this, you might notice slight alignment issues when
generating online output. For example, margin or padding settings might be pushing aligned text a
bit further than you want. To fix this, add the DOCTYPE declaration to the target.
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HOW TO ADD THE DOCTYPE DECLARATION TO GENERATED TOPICS
1. Open a target used for online output.
2. On the Advanced tab of the Target Editor, select Add DOCTYPE declaration to generated topics.
3. Click

to save your work.

NOTE: Enabling this feature for HTML Help targets may be necessary to avoid certain custom JavaScript errors. However, for some languages (e.g., right-to-left, Russian, Asian languages), this option may not function properly in HTML Help. Therefore, it is recommended
that you disable the option for non-English language content when generating HTML Help.

NOTE: The DOCTYPE declaration will exist in the main output file whether or not this option
is enabled.
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Specifying EPUB Options
If you are sending output to EPUB, you can access EPUB options in the Target Editor. These options
let you provide metadata, select a cover image, validate output, generate MOBI output, enable
MathML to PNG conversion, and enable dynamic content.

HOW TO SPECIFY EPUB OPTIONS
1. Open a target that is using the EPUB format. If necessary, you can change the output type for
a target. See "Changing the Output Type for a Target" on page 150.
2. Select the EPUB Options tab.
. The vari3. Complete the options as necessary. If you want to insert a variable, you can click
able will appear as syntax in the field, but in the output the variable definition will be shown.

METADATA
Select the MetaData tab and complete any of the following. The information becomes embedded in the final output.
n

Title The document title you provide is usually displayed at the top of the EPUB reader. If
you do not provide a title, the target name is automatically used instead.

n

Author

n

Publisher(s)

n

Tag This is a custom field that you can use for your own purposes.

n

Rights

n

Description

n

ISBN

n

Publish Date

n

Identifier

For more information about EPUB metadata and the fields supported in Flare (except "Tag"),
open this link: http://idpf.org/epub/20/spec/OPF_2.0.1_draft.htm#Section2.2.

CHAPTER 8

88

COVER IMAGE
Select the Cover Page tab and click
cover for your ebook.
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VALIDATE EPUB3 OUTPUT
Use these fields to validate EPUB output so that it will be acceptable to most online stores,
such as amazon.com.
a. Select Enable Epub 3 validation.
b. Click the Download EpubCheck link. A website opens.
c. Click the link you want to download. Newer versions are typically at the top. Select the
most recent link for binaries and follow the steps online to download it to your computer.

d. The file that you downloaded is a ZIP file, so you need to extract its contents.
e. Return to the EPUB Options tab in Flare.
f. Next to the EpubCheck field, click

.

g. Navigate to the extracted folder on your computer.
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h. In the Open dialog, double-click the file with the .jar extension (e.g., epubcheck-3.0.jar).

i. Click

to save your work.

When you are finished setting all EPUB options, you can generate the EPUB target. If validation fails, you should see related errors during the compilation process. You can then fix
the issues and try to build again.
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GENERATE MOBI OUTPUT
MOBI is the standard format used for the Amazon Kindle. You can use these fields settings to
generate EPUB output that uses MOBI content.
a. Select Generate MOBI file.
b. Click the Download KindleGen link. A website opens.
c. Click the link you want and follow the steps online to download it to your computer.
d. The file that you downloaded is a ZIP file, so you need to extract its contents.
e. Return to the EPUB Options tab in Flare.
f. Next to the KindleGen Path field, click

.

g. Navigate to the extracted folder on your computer.
h. In the Open dialog, double-click the file with the kindlegen.exe file.

i. Click
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When you are finished setting all EPUB options, you can generate the EPUB target. If you open
the output folder, you will see that Flare has created a MOBI file in addition to an EPUB file.
The MOBI file is all you need to view the ebook on a Kindle. The EPUB file can be used to view
the ebook on other readers.

ENABLE MATHML TO PNG CONVERSION
If you use the Equation Editor to insert equations, you are in essence creating MathML
markup. This type of content is supported for EPUB output.
If you need to produce output that can be displayed on older readers, you can select this
option. All of your MathML content will be converted to PNG image files.

EMBED FONTS
Flare includes all of your used fonts in the final EPUB output file. Therefore, if someone has a
reader that does not have your fonts installed, that person will still be able to see your content
as you designed it.
Embedding fonts may not be supported by all e-readers. Additionally, you may choose not to
embed fonts if you have a very large project, because this option can slow down your compile
time.
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ENABLE DYNAMIC CONTENT
If you use dynamic content—togglers, popups, drop-downs, expanding text, slideshows, or
help controls—in your output, you may want to enable dynamic content for your EPUB target
so your users can take advantage of these features.
Dynamic content makes your content look more interesting, but it is not supported on all ereaders. You may want to create one version of your EPUB content with dynamic content
enabled, and another version with dynamic content disabled to accommodate users with different e-readers.
EXAMPLE
Let's say you have an EPUB output that uses a lot of dynamic content. You
decide to create two versions of the content so readers can view it no matter
what kind of e-reader they are using.
After you create your content, you build one version of the EPUB output with the
dynamic content disabled. This version is for users who have older e-readers or
are using e-readers that do not support all dynamic content. Because they have
older e-readers, they might not be able to see all of your content, like slide shows.
Other content might be displayed as footnotes or as expanded text.
To create this output, you open the Target Editor, select the EPUB Options tab,
and make sure the Enable Dynamic Content check box is deselected. Then you
build the output.
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When you view the output, it looks like this:

Next, you create a version of the EPUB content with the dynamic content
enabled. This version is for users with newer e-readers that fully support EPUB 3,
so they can take advantage of all of the features of the output, like drop-downs
and slideshows.
To create this output, you open the Target Editor, select the EPUB Options tab,
and make sure the Enable Dynamic Content check box is selected. Then you
build the output.
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When you view the output, it looks like this:

You can now provide both outputs to your users, and they can pick the best one
for their needs.
4. Click

to save your work.

NOTE: For all supported image types (PNG, JPEG, JPG, GIF), the cover art in MOBI output
has a minimum width or height of 300 pixels.

NOTE: Dynamic content is not supported in MOBI output. To generate valid MOBI output,
you must create another EPUB target with dynamic content disabled.
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NOTE: Display issues with dynamic content may be caused settings in your browser or the
type of file you are generating.

NOTE: Because some dynamic content, like slideshows, is visible only when it is enabled,
you may want include this information elsewhere in the output or only use this kind of content for less important information. This way it is available to all users.
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Enabling Feedback in Flare
Supported In:

After obtaining the necessary Feedback license(s), you need to enable the Feedback functionality in
Flare. This is done on the Community tab in the targets.

HOW TO ENABLE FEEDBACK IN FLARE
1. From the Project Organizer, open the target.
2. Select the Community tab.
3. Click the Enable Pulse/Feedback Server check box.
4. In the Feedback Server URL field, enter the path to the server hosting the data. If you purchased the MadCap Feedback Service (as opposed to the MadCap Feedback Server), enter
madcap, which maps to feedbackserver.madcapsoftware.com.
NOTE: It is highly recommended that you purchase an SSL certificate and install it on
your web server. SSL uses encryption for certain processes, which helps to ensure
that the data transfer is secure. If you have an SSL certificate installed on your web
server, make sure you begin the path to the server with https://.
5. Enter your license key using one of the following methods:
n

If Using MadCap Feedback Service (i.e., MadCap does the hosting) Click the Enter Key
button to open the Feedback Service End User License Agreement dialog. After reviewing the agreement in the dialog, enter or copy the Feedback license that you have been
issued into the Feedback Service License Key field. Then click Accept. This button is
enabled only if "madcap" is entered in the Feedback Server URL field (i.e., you are using
MadCap Software's hosted service, as opposed to your own server).

n

If Using MadCap Feedback Server (i.e., you do the hosting) Copy the Feedback license
that you have been issued and paste it into the Feedback Service License Key field.

6. Click
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HOW TO SET THE COMMUNITY OPTIONS (DISPLAY FEEDBACK COMMENTS) USING A
STYLESHEET
1. Open the stylesheet.
2. Find and select the html style or the appropriate class.
3. In the Show filter field, select Alphabetical List.
4. Find the mc-community-features property and set it to enabled or disabled. The default setting is "enabled."
5. Click

to save your work.

This stylesheet method can be especially useful if you only want some topics to display the comment area.
NOTE: If there is a discrepancy between the skin and the stylesheet setting (e.g., the skin is
set to disabled and the CSS is set to enabled), the stylesheet setting has precedence.

NOTE: Comments at the bottom of topics are not shown in tablet or mobile view. This is the
same case for HTML5 Tripane output.

NOTE: The comments area at the bottom of topics is wrapped in an iframe. Therefore, the
output is technically not entirely frameless. However, because it is only the comments that
are contained in the iframe, the main topic content still retains the benefits (e.g., better
search results) of frameless output.
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Associating Glossaries with Targets
Supported In:

One of the final steps to creating a glossary is to associate it with a target. After you build the target,
the glossary will be incorporated into the output.

HOW TO ASSOCIATE A GLOSSARY WITH A TARGET
1. Open the target from the Project Organizer.
2. In the Target Editor, click the Glossary tab.
3. (Optional) In the Glossary Term Conversion section, select one of the options if you want to
make use of glossary term links:
n

Do not convert terms In the output, none of the glossary terms that appear in topics will
be converted to hyperlinks, popups, expanding text, or footnotes in the output (even if a
term was inserted into a topic as a glossary term link).

n

Convert only marked terms In the output, only glossary terms that were inserted into topics as glossary term links will be converted to hyperlinks, popups, expanding text, or footnotes in the output. Glossary terms that happen to exist in topics as normal text will not
be converted.

n

Convert first occurrence of term In the output, only the first occurrence of a glossary
term in a topic will be converted to a hyperlink, popup, expanding text, or footnote in the
output (per your instructions). This includes terms that were inserted as glossary term
links, as well as glossary terms that happen to exist in topics as normal text.
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n

Convert all occurrences of term In the output, every occurrence of a glossary term in a
topic will be converted to a hyperlink, popup, expanding text, or footnote in the output
(per your instructions). This includes terms that were inserted as glossary term links, as
well as glossary terms that happen to exist in topics as normal text.
NOTE: The conversion of a glossary term to a link is case-sensitive. For example, if a
term starts with an uppercase letter in the glossary, it will not be converted to a link in
the output if the term is all lowercase in the topic.

NOTE: These options are not supported in Clean XHTML targets.
4. Click the check box next to each glossary that you want to associate with the target. A check
mark is added to the box.
5. (Optional for online output) In the Glossary Master Page section, select a master page to be
associated with your glossary definitions.
The master page will be used to display the glossary in the output.
EXAMPLE
You might use a glossary master page to add custom text at the bottom of the
glossary. Or perhaps you want to add a watermark image to the background of
the glossary. To do that, you could create a class of the html style, add a background image to that style class, and select that class in the master page file.

NOTE: A glossary master page is not supported in HTML5 output.

6. Click
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Specifying Buttons for HTML Help Output
You can select the Help buttons that you would like to include in the output window (e.g., Hide, Forward, Back, Print, customized buttons).

HOW TO SPECIFY BUTTONS FOR HTML HELP OUTPUT
1. Open a Standard skin.
2. Select the HTML Help Setup tab.
3. In the Html Help Buttons section, select the buttons that you want to include in the output window.
n

Hide Opens and closes the navigation pane.

n

Locate Synchronizes the TOC with the current topic (identifying the location of the current topic in the TOC hierarchy). This is different from the option "Automatically Synchronize TOC" on the General tab. This option is a manual method (requires action from
the user), where as the other option is automatic.

n

Back Opens the topic that was viewed previously.

n

Forward Opens the next topic in a previously viewed sequence.

n

Stop Prevents a page from downloading file information.

n

Refresh Updates the content of the topic being viewed.

n

Home Opens a designated home page (such as your company's website).

n

Font Opens a font selection popup. You can choose a typeface from among those listed
in the left panel. The base size can be selected in the right panel. There are two separate
font families used by the viewer: the normal, proportional-spaced font, and a fixed-pitch
font for preformatted and "typewriter" text. The latter does not actually have to be fixedpitch; however, preformatted columns will not line up unless this is so. Pressing Apply
Font will set the currently selected font as the viewer's proportional font, and Apply Fixed
Font will set the currently selected font as the viewers "fixed" font. In either case, the display will be redrawn using the new font. The new font selection will be updated in the
.mozyrc file if it exists, so that subsequent windows will use the new font.

n

Print From the Contents tab, prints pages, headings, and subtopics, or the entire TOC.
From the Index or Search tab, opens the Print dialog for printing the current topic.
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n

Next Opens the next topic in the TOC. In order to include this button in the output, you
must also make sure Binary TOC and Binary Index are selected (use the TOC Options and
Index Options buttons). Please note that these buttons may not work correctly if the
topic file names contain spaces.

n

Previous Opens the previous topic in the TOC. In order to include this button in the output,
you must also make sure Binary TOC and Binary Index are selected (use the TOC Options
and Index Options buttons). Please note that these buttons may not work correctly if the
topic file names contain spaces.

n

Options Opens a menu that provides access to Home, Show, Back, Stop, Refresh, and
Search Highlight On/Off.

n

Jump1 Opens a customized destination. You can use this to let users open a website
(defined with a URL) or a Help topic (defined by its file name if included in the same CHM
file). You can specify the destination and label for the button by selecting Jump Button
Options.

n

Jump2 Opens a customized destination. You can use this to let users open a website
(defined with a URL) or a Help topic (defined by its file name if included in the same CHM
file). You can specify the destination and label for the button by selecting Jump Button
Options.

4. If you want to include labels below each of the buttons in the output, select Display button captions.
5. If you selected the "Jump1" or "Jump2" button options, click Jump Button Options to specify
the button text and destination. In the HTML Help Jump Button Options dialog, enter the
appropriate destination URL (e.g., http://www.acme.com) in the Jump1 URL and/or Jump2
URL fields. Then enter the label for the button in the appropriate Button text field. When you
are finished, click OK to close the dialog. (Make sure Display button captions is selected so
that users can see the button text.)
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NOTE: You can also set the jump button options on the General tab in the Target
Editor. The reason these button options are available in both the Skin Editor and Target Editor is this: If you want multiple targets to use one skin, with each target using
the same destinations for the jump buttons, you should set the jump button URLs in
the Skin Editor. If you want multiple targets to use the same skin, but you want them
to use different URLs for the jump buttons, set the URLs in the Target Editor. If URLs
are set in both the Skin Editor and the Target Editor, Flare uses the settings from the
Skin Editor.

6. Click
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Displaying Merged Navigation in HTML Help
Child Outputs
You can merge HTML Help so that the navigation (table of contents, index, search) for each CHM
file is displayed, regardless of which CHM file you open (parent or child). This can be done in a
couple of ways, depending on whether you have access to all of the Flare projects or to the CHM
files only.

HOW TO DISPLAY MERGED NAVIGATION IN HTML HELP—ACCESS TO ALL FLARE
PROJECTS
1. Open the target to be used as the parent CHM.
2. On the Advanced tab of the Target Editor, select Display merged navigation in HTML Help.
3. Click

to save your work.

4. Follow the steps for merging based on HTML Help targets.
5. Generate the parent HTML Help target.
The parent CHM file and all child CHM files are located in the same output folder, and when
you open any of those CHM files, you can see the navigation for any of the other outputs.
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HOW TO DISPLAY MERGED NAVIGATION IN HTML HELP—ACCESS TO CHM FILES
ONLY
Use this method if you do not have access to all of the Flare projects, but you do know the names of
the other CHM files that will be created. This method is more of a manual setup and is useful if you
are part of a team where different authors have access to different Flare projects that need to be
merged. This method also lets you add or remove child CHM files without needing to recompile the
parent project.
1. The author for each project (parent and child) places a simple TXT file named merge.txt in the
same folder where the Flare project file (.flprj) is located. This TXT file can be created with
Notepad and should simply list the names of all CHM files to be included in the merged output
(one on each line), with the name of the parent CHM appearing first.
EXAMPLE
MyParent.chm
MyFirstChild.chm
MySecondChild.chm
MyThirdChild.chm
2. The author for each child project generates his output and provides the author of the parent
project with the CHM file(s).
3. The author for the parent project brings the child CHM files into the parent project and follows
the steps for merging based on CHM files.
4. The author for the parent project generates the main HTML Help target.
The parent CHM file and all child CHM files are located in the same output folder, and when
you open any of those CHM files, you can see the navigation for any of the other outputs.

CHAPTER 8

106

Patching Stylesheets and Image Links for
HTML Help
If you generate Microsoft HTML Help output, some topics may not look as intended when they are
printed from the CHM file, due to stylesheet-related problems. You can use this feature to "patch"
those problems, ensuring the printed topics will look as intended.
Why would you not use this option? The only reason not to use this option is when you plan to
rename the generated CHM file. If this option is enabled and you rename the CHM file, styles in the
output are broken. This happens because, when the option is enabled, the file name of the CHM is
hardcoded into the CHM itself.

HOW TO PATCH STYLESHEETS AND IMAGE LINKS FOR HTML HELP
1. Open a target.
2. On the Advanced tab of the Target Editor, select Patch stylesheet and image links for HTML
Help printing.
3. Click
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Embedding Images in Word Output
Supported In:

An option on the Advanced tab of the Target Editor lets you ensure that images are embedded in
Microsoft Word output.

HOW TO EMBED IMAGES IN MICROSOFT WORD OUTPUT
1. Open the target being used for Word output.
2. Select the Advanced tab.
3. Click the check box next to Embed images in output so that it contains a check mark.
4. Click
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Enabling Review Mode in Word Output
If you want to automatically track any changes made to the Word document after you open it, you
can enable review mode in the Word output. This will automatically enable the Track Changes feature in Word.

HOW TO ENABLE REVIEW MODE IN WORD OUTPUT
1. Open the target being used for Word output.
2. Select the Advanced tab.
3. In the MS Word Output section, click the check box next to Enable review mode in output.

4. Click
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Generating Web-Safe Images
Supported In:

If you have used non–web-safe image formats (e.g., WMF, EMF, BMP, TIF, TIFF) in your project and
want those images to be converted to web-safe formats (e.g., GIF, JPEG, PNG) when you generate
online output—e.g., HTML5, Clean XHTML, Eclipse Help, Microsoft HTML Help, WebHelp, WebHelp
Plus—you can use an option on the Advanced tab of the Target Editor. For print-based output types
(Adobe PDF, Microsoft Word), the original image file formats will be used when you generate output.

HOW TO GENERATE WEB-SAFE IMAGES
1. Open a target.
2. Select the Advanced tab.
3. Select Generate "web-safe" images.
4. From the drop-down list, select the image format that you want to use.
5. Click

to save your work.

NOTE: If you are using this option, images that link to external locations (such as websites),
rather than to images within the project, are not affected.

NOTE: Vector images, such as SVG, are preserved in the output, unless you use this option
to generate web-safe image formats.
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Disabling Auto-Sync of Import Files
Supported In:

Let's say you have imported Microsoft Word, Adobe FrameMaker, Microsoft Excel, or Flare files
from another project, and when doing so, you selected the "Easy Sync" option to automatically reimport the files when you generate output. If you want to override that Easy Sync setting for a specific target, you can do so by using the steps below. Therefore, if you want to re-import any of the
files, you will need to do so manually.
You might decide to use this option, for example, if you are testing the generation of output and do
not want to wait the extra time for the files to be imported. After you finish your testing, you can
deselect this option to return to the automatic imports of the files.

HOW TO DISABLE AUTO-SYNC OF IMPORT FILES
1. Open the target.
2. In the Target Editor, select the General tab.
3. Select the check box labeled Disable auto-sync of all import files.
4. Click
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Excluding Index Entries From Search
Supported In:

If you insert index markers in your project, those markers by default are included in searches that
users perform in your output. If you want to exclude index entries from searches, you can do so.

HOW TO EXCLUDE INDEX ENTRIES FROM SEARCH
1. Open the target.
2. Select the Search tab.
3. In the Search Results section, click the drop-down arrow next to Advanced Search Options.
4. Click Exclude index entries from search.
5. Click

to save your work.

NOTE: This option is not available for HTML5 targets using Elasticsearch or Google Search.
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Selecting a Language
Broadly speaking, selecting a language can mean a couple of different things. First, it can mean specifying a language for the content that you are producing. However, it can also mean choosing a language for the Flare interface as you do your work.
You can select a language at any of the following levels:
n

Project

n

Target

n

Topic

n

Content within a topic or snippet

The broader the level where the language is set, the lower precedence it has in case of conflicts. In
other words, the content level has precedence over everything. The topic level has precedence over
the target and project levels. And the target level has precedence over the project level.
You can also set multiple languages at the target level, then link translated Flare projects to your current project. This allows you to create multilingual output.

CHAPTER 8

113

HOW TO SELECT LANGUAGES FOR A SPECIFIC TARGET
1. Open the target.
2. In the Target Editor, select the Language tab.
3. From the Language drop-down, you can change the language.
4. (Optional) If you want to add additional languages to your target output, do the following:
a. Click

. Another row is added to the grid.

b. In the Linked Project column, click the link to select the Lingo or Flare project you want
to link to your current project. Linking to a Lingo project allows you to skip the step in
Lingo of exporting translated content out to additional Flare projects.
If you have not added a linked project yet, the link will look like an ellipsis; if you have
already added a linked project, the link will display the project's file name.
NOTE: You can link to many separate Lingo projects, or you can link multiple
rows in this tab to the same multilingual Lingo project, or you can do both.
c. In the dialog that opens, find and select the project you want to link to your current project. Click Open.
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d. If necessary, select the linked project's language from the Language drop-down. Flare
will automatically detect the linked project's default language settings, so you should
only need to update this setting if you are pointing to a multilingual Lingo project or if it
is incorrect in the linked project.
Additionally, if default translations are available for the selected language’s skin, it will
be noted in the Localized Skins column. If you have a custom language skin for the
selected language in your linked project, Flare will automatically use your custom translations.
NOTE: If you link to a multilingual Lingo project, only the remaining languages
from a multilingual project can be chosen from the drop-down. In other words,
if you've already selected one of the languages for a previous row, it is no longer
available when you add more language rows.

NOTE: The default target output language in the Target Editor always shows
the currently selected project language. This language will update automatically if you change the project language.
e. (Optional) Continue adding rows and linked projects for each additional target output
language.
and
buttons to rearrange your projects. They will appear in
f. (Optional) Use the
your output in the order they are listed on the Language tab.
5. (Optional) If you have added links to one or more Lingo projects, you can select Sync Lingo
projects if you want to synchronize updates with those projects.
If this option is enabled, the application detects whether any of the Lingo and Flare source
files are out of sync. If they are, the Lingo project is automatically updated and these changes
are also brought into the master Flare project. This is different from the usual process, where
the translator would normally update the Lingo project manually and translate the changed or
new files.
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WARNING: You might use this feature if you want to quickly see any updated files in
your master Flare project, including non-translated content such as images. However,
enabling this option is typically not recommended, because there is always the risk of
updating the Lingo project (and therefore also the master Flare project) with content
that has not yet been translated.
6. (Optional) If you selected a right-to-left (RTL) language, you may see the following options at
the bottom, which are enabled by default for RTL languages. Leave them selected to automatically invert the following: (1) language-related style rules locally, (2) language-related
style rules in the stylesheet, (3) image callouts from MadCap Capture, and (4) page layout settings.
n

Invert left/right local styles

n

Invert left/right stylesheet rules

n

Invert Capture captions

n

Invert Page Layouts

The options that are seen depend on which output type you are using.
n

PDF/Word All four options are shown.

n

HTML5/HTML Help/EPUB/Eclipse Help/WebHelp/WebHelp Plus Local styles, CSS styles,
and image callout options are shown.

n

DITA No options are shown.

These options can be quite useful after you receive the project back from a translator. When
you generate the output, the inversion of the styles and page layouts takes place.
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EXAMPLE
Let's say you have a project in English (a left-to-right language), and you need to
have it translated into Arabic (a right-to-left language).
For your p style, suppose you have a left margin of 5 px and a right margin of 30
px.
Those settings work fine for your targets using the LTR language. But for the RTL
language, you need the settings to be flipped so that the left margin is 30 px and
the right margin is 5 px.
So after you receive the project back from the translator, you make sure the RTL
language in Flare is set at either the project or target level.
As a result, the inversion options become selected automatically, and when you
generate the output, paragraphs will have a left margin of 30 px and a right margin of 5 px.

NOTE: The option to invert page layouts controls every aspect of the page layout file
(e.g., it inverts not only frames and content within them, but also styles applied to
frame content). The other invert options have no effect on page layouts.

NOTE: If your selected language is LTR, these options cannot be accessed in the Target Editor.

7. Click
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MORE INFORMATION AND EXAMPLES
When you are ready to build your output, open the target you want to generate and click Build.
Flare will generate the linked target from each project in the order you specified. The final files will
be generated differently depending on the output you are generating.

HTML5 AND WEBHELP
Flare will create a subfolder in your Output folder for each language. When you view the output,
Flare will display the output for your browser's default language. In HTML5 outputs, you can use a
drop-down menu to switch between each generated language.
EXAMPLE
HTML5 output will look like this.
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WebHelp output will look like this.

NOTE: Be sure that the file names are the same in your master project and each of your
linked projects. This is especially important for HTML5 targets, so you can switch between
languages using the Select Language button in the output.
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NOTE: If you are using an HTML5 output, be sure to enable the Select Language button in
the skin for your master project and each linked project. This will allow you to change languages using a drop-down.
1. If you are creating Top Navigation output, you should have a Topic Toolbar skin component in your project . Open the skin component, and select the Setup tab.
If instead you are creating Tripane output, open the regular skin and select the Toolbar tab.
2. If necessary, move the Select Language button from the Available section to the
Selected section.

After you add the Select Language button to your Topic Toolbar, you also need to be sure
the toolbar appears in your master page. If the topic toolbar does not appear in each of
your master pages, you will not be able to switch languages from those page types.
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PDF
The output is merged (or “stitched”) into a single document, with each language appearing in the
order you specified. You will see a single file in your Output folder.
EXAMPLE
PDF output will look like this.

NOTE: Generating a PDF output using a multilingual target uses the same process as
PDF stitching. However, creating a multilingual target automates the process and allows
you to work from multiple Flare projects at once. Additionally, because you do not need to
generate each PDF separately every time the document is updated, generating output
from a multilingual PDF target saves considerable time.

NOTE: You can access individual PDFs for each language in the Temporary folder in your
Output folder.
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OTHER OUTPUT TYPES
Flare will create subfolders for each language in your Output folder. You can merge printed output
types manually (e.g., in Word) if you need to create a single file.
EXAMPLE
Word output will look like this.

NOTE: If you are building Eclipse Help, you will need to open your Output folder to open
your desired language output.

NOTE: You can use a tool like MadCap Lingo (or another computer-aided translation tool)
to translate your Flare content. Although you can set the language for your project in
Flare, this does not mean that Flare automatically outputs translated content.
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NOTE: You must link each language to a Flare or Lingo project before you can close the
Target Editor. Similarly, if you make changes to your linked projects and their links are no
longer valid when you build the project, you will see a warning message before the build
starts and you will be unable to build.

NOTE: In order to build output that links directly to multilingual Lingo projects, the Flare
user must have at least Lingo 10 installed on the same computer.

NOTE: When you build a target that is set up for multilingual output and you link directly to
a Lingo project, the export process runs automatically in Lingo so that the master Flare
project can grab the necessary translated Flare projects. If the Lingo export process
encounters warnings, these will not display with the other build warnings in Flare's interface. Instead, you must open the build log to find any such warnings.

NOTE: Because Flare generates output from the linked targets in each of your project
files, each linked project must have its own target file for the output you want to build
(e.g., if you are creating PDF output, each linked project needs its own PDF target). If you
do not have a needed target file in one of your linked projects, you will see a warning message before the build starts and you will be unable to build. Target files must be in the
same relative location in each project.

NOTE: If you have created a new language skin for a language, Flare will use it when you
build the project. The language skin must reside in the project that uses that language.

NOTE: If you are using right-to-left language settings in a linked project, you must enable
these settings in your master project target. Language settings in the master project target control those for each of the linked projects, regardless of the settings in your linked
projects.
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You have the option of viewing the interface in English, French, German, Japanese, or Chinese. All of
these languages are available from the same version of Flare (you do not need to purchase different
versions for different languages). When you initially launch Flare, you are asked to select your language preference. Based on your selection, the user interface is displayed in the selected language,
with the option to switch your preferences at any time from the Select UI Language dialog. If a particular element is not available in the selected language, that element displays in English.

HOW TO SELECT A LANGUAGE FOR THE FLARE INTERFACE
1. Launch Flare. The Select UI Language dialog opens.
If you have previously selected to disable this dialog when launching Flare, you can overrule
that selection. To do this:
a. Select File > Options. The Options dialog opens.
b. Select the General tab.
c. Click the check box Show Select UI Language Dialog on Startup.
d. Click OK.
e. Launch Flare again.
2. Select the language that you want to use from the drop-down list.
3. (Optional) If you do not want the dialog to display when you launch Flare, click Show this dialog on startup to remove the check mark. If you later decide that you do want to see this dialog when launching Flare, open the Options dialog and click the box to open this dialog on
startup.
4. Click OK. Flare is displayed according to your language selections.
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Synchronizing Navigation Elements with
TOC Entries
Supported In:

If you generate HTML5 output, links to the TOC (e.g., menu items, breadcrumbs, mini-TOCs) are
dynamically generated when a particular topic is opened. This allows you to keep these navigation
elements in sync with your TOC. This is particularly important if the same topic is linked to multiple
entries in your TOC; otherwise, menu items and other navigation elements might display for one
instance of that topic in the TOC when another instance is preferred.
For HTML5 Tripane output, navigation elements will always remain in sync with your TOC entries.
However, for HTML5 Side Navigation, Top Navigation, and skinless outputs, you must enable a feature in your target to synchronize navigation elements with TOC entries.

HOW TO SYNCHRONIZE NAVIGATION ELEMENTS WITH TOC ENTRIES
1. Open an HTML5 target used for Side Navigation, Top Navigation, or skinless output.
2. On the Advanced tab of the Target Editor, select Synchronize navigation elements with TOC
entries.
3. Click
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EXAMPLE
Let’s say you have a topic called “Lists” that is linked in two places in your TOC:
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With the synchronization option disabled, you generate HTML5 Top Navigation output.
You open the Lists topic under the “Links and Lists” menu, the first place that it occurs
in the TOC file:
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The topic opens, and initially everything seems fine. But if you look at a couple of navigation elements—the breadcrumbs and side menu—you will notice that the topic was
opened in the second TOC location (under “All Features”). This is the default behavior;
the last instance of the topic in the TOC will be shown, not necessarily the one you
selected.
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Therefore, you open the target and enable the option to synchronize navigation elements with TOC entries.
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After generating the target once more, you open the output and select the Lists topic in
the same way. When you do this, notice that both the breadcrumbs and side menu are
in sync with that location:
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PROS AND CONS
Synchronizing navigation elements with your TOC entries seems like an obvious decision, and for
some authors it is. However, other authors might choose not to do this for their Side Navigation, Top
Navigation, or skinless outputs. There are pros and cons.
n

Pro The obvious advantage of this feature is in the name itself; it keeps elements synchronized with the TOC appropriately.

n

Pro You do not need to worry if you have a topic linked to multiple TOC entries.
NOTE: If you decide not to use this option for your HTML5 Side Navigation, Top Navigation, or skinless output but you are still concerned about having duplicate TOC
links, there is a workaround. You can create a snippet that holds all of the content for
the topic. Then create multiple topics (as many topics as you need links to it in the
TOC), and insert that snippet into each one. Rather than linking to one topic in multiple places in the TOC, you can link to a different topic in each place. By doing that,
your navigation elements will point to the appropriate locations. However, you probably also want to disable searching in all but one of those topics; otherwise, they will
all show up in the search results.

n

Con With this option enabled, you will notice that the URL paths for your topics are quite a bit
longer and more complex.

With the option disabled, the paths are much more streamlined.
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Removing MadCap Styles
Supported In:

Due to an issue with Google Chrome, content within the body of topics inherits the hover color of
MadCap styles (e.g., MadCap|xref:hover). To prevent this situation, Flare will automatically add the
following rule at the beginning of the CSS files in your output:
@namespace MadCap url(http://www.madcapsoftware.com/Schemas/MadCap.xsd);
However, you can select an option in the Target Editor for web-based outputs if you do not want this
rule to be added to your stylesheets.

HOW TO REMOVE MADCAP STYLES
1. Open a target.
2. On the Advanced tab of the Target Editor, select Remove MadCap styles.
3. Click
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Adding Mark of the Web
Supported In:

According to Microsoft:
"The Mark of the Web (MOTW) is a feature of Windows Internet Explorer that enhances
security. MOTW enables Internet Explorer to force webpages to run in the security zone of
the location the page was saved from—as long as that security zone is more restrictive
than the Local Machine zone—instead of the Local Machine zone. When you are developing webpages, the MOTW enables you to test your HTML documents in the security
zone where you intend the pages to run. Adding the MOTW to your webpages also
enables you to fully test their compatibility with users' security settings."
So MOTW is a comment added to the HTML markup for a web page. When users open a web page
from their local machine, Internet Explorer references this comment to determine the security zone
in which it should run the page.
Therefore, if you do not have MOTW enabled in Flare, the following message displays when HTML5,
WebHelp, or WebHelp Plus output is opened locally on Internet Explorer.

If you do have MOTW enabled in Flare, this security message is not displayed.
Without MOTW, you would have to click on this message and select Allow Blocked Content to view
the output locally on Internet Explorer. By adding MOTW, you can avoid this situation.
However, please note that if you have external links in your project to non-HTML files (e.g., DOC,
PDF, JPG, GIF), those links will not work with MOTW enabled. Therefore, MOTW should not be used
unless the links in your project are limited to HTML documents only.
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HOW TO ADD MARK OF THE WEB
1. Open a target.
2. On the Advanced tab of the Target Editor, select Insert Mark of the Web.
The default comment in this field is a generic one that specifies the Local Intranet zone and is
used in situations where the domain is not yet known. You can replace it with another comment if necessary.

If you plan to use MOTW, the text field should contain some content. You should either keep
the default content or replace it with your own. If you remove any content from the field,
MOTW cannot be used.
3. Click
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NOTE: With Mark of the web enabled in your target, some links to external files may not
work properly in some versions of Internet Explorer when pages are viewed locally (file://).
This is not an issue if pages are viewed online (http://). For more information about MOTW,
see Microsoft's MSDN website.

NOTE: 3D models will not display if Mark of the Web is enabled.
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Associating Master Pages with Targets
Supported In:

If you want a master page to be applied to all topics in the output, you would associate that master
page with the target that you are building. This is useful, for example, if you want to create breadcrumbs, a mini-TOC, header content, or footer content for your online outputs.

HOW TO ASSOCIATE A MASTER PAGE WITH A TARGET
1. Open the target.
2. In the Target Editor, click the Advanced tab.
3. Click the drop-down arrow in the Master Page field, and select the master page that you want
to associate with the target.
4. Click

to save your work.

NOTE: If you want most topics to use a particular master page, but some other topics to
use a different one, you can associate the first master page with the target. Then you can
associate the other master page with the remaining topics.
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Disabling the Use of Master Pages
Supported In:

You might have used master pages in earlier versions of Flare when creating Word output, but then
decide to use the newer page layouts instead. You can manually remove all links to master pages in
your target and table of contents. However, another alternative is to automatically disable the use
of master pages in your project. By using this feature, Flare will ignore all links to master pages when
you generate the Word target. It will instead use links that you provide to any page layouts.

HOW TO DISABLE THE USE OF MASTER PAGES
1. Open the target.
2. In the Target Editor, select the Advanced tab.
3. Click the check box next to Disable Master Pages for MS Word output.
4. Click
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Adding Custom Meta Tags
Supported In:

For online outputs, you can add custom meta tags in the Advanced tab of the Target Editor. These
are added between the <head> and </head> tags in your content when you generate output.
There is a default meta tag provided. You can keep this tag, remove it, and/or add other valid tags.

EXAMPLE
You might want to enhance search engine optimization for your output, so you add the
following tag to the target: <meta name="googlebot"/>
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HOW TO ADD CUSTOM META TAGS
1. Open a target.
2. On the Advanced tab of the Target Editor, select Add meta tags to content.
3. In the area below, you can add any valid meta tags. You can also keep the default tag. If you
want to insert a variable, you can click
. The variable will appear as syntax in the field, but in
the output the variable definition will be shown.

DEFAULT TAG FOR MOST OUTPUT FORMATS
For most output formats, the default tag is as follows:
<meta http-equiv="X-UA-Compatible" content="IE=edge" />
This tag tells Internet Explorer to render with the latest version.
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DEFAULT TAG FOR HTML HELP
For Microsoft HTML Help targets, the default tag looks like this:
<meta http-equiv="X-UA-Compatible" content="IE=7" />
That's because IE=Edge can cause rendering issues on some systems.

4. Click
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Specifying the Output File and Folder in a
Target
When you build the output for a target in your project, Flare sends the output files to the Output
folder where your project is located. It also uses a default name for the main entry file to the output.
However, you can specify a different location and main entry file name for a target's output files.

EXAMPLE
Let's say you have a project called "FictionSoftPro" and have stored it in your root C:\ directory. If you create a project based on the "Empty" template and then build the output
for an Microsoft HTML Help target, Flare places the output files in:
C:\FictionSoftPro\Output\MyName\MyHtmlHelp
The main entry file (actually, the only file) named "Manual.chm."

HOW TO SPECIFY THE OUTPUT FILE AND FOLDER IN A TARGET
1. Open the target.
2. On the General tab of the Target Editor, do one or both of the following.
n

To specify the main entry file name, type the desired name in the Output File field. If you
want to insert a variable, you can click
. The variable will appear as syntax in the field,
but in the output the variable definition will be shown.
For Word output, the default file type is XML. However, you can enter one of the following
extensions at the end of the file name to use that file type: .doc, .docx, .pdf, .xps.
NOTE: The Output File field is not available for Clean XHTML and Eclipse Help targets.

n

To specify the location of the output files, click
in the Output Folder field. Then navigate to and select the location in your computer where you want to place the files.

3. Click
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Replacing Characters and Spaces with
Underscores
Supported In:

If you have spaces or unusual characters in your file names or folders, you can convert these
spaces and characters to underscores in the output. This feature is primarily useful for individuals
working in a UNIX environment. In addition to spaces, the characters that are converted to underscores include: ()&;,!'.

HOW TO REPLACE CHARACTERS AND SPACES WITH UNDERSCORES
1. Open a target.
2. On the Advanced tab of the Target Editor, select Replace reserved characters with underscores in filenames.
3. Click

to save your work.

NOTE: This feature applies to the files and folders within the root output folder, but not to
the root output folder itself.

NOTE: You should use caution with this feature because some international characters are
also converted to underscores. This includes characters such as ç, ß, and ñ. All varieties of
non-English vowels are affected, as are all Asian characters.
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Using Custom File Extensions
Supported In:

You can use specific file extensions for topics for WebHelp output types. If you do not use this feature, the output topic files will have an .htm extension. The most common alternative extensions
are .html and .aspx.

HOW TO USE CUSTOM FILE EXTENSIONS
1. Open a target.
2. Select the Advanced tab.
3. Select Use custom file extensions for topics.
4. In the field below, enter the extension that you want to use. Do not type the period, but rather
the characters only (e.g., aspx).
5. Click
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Excluding Content not Linked Directly or
Indirectly from Targets
Supported In:

One way to completely exclude content from online output is to place condition tags on the topic
files and include or exclude them from the targets. Another method—discussed here—is to use an
option in the Target Editor to include only content files that are directly or indirectly referenced from
the target. This means that if the target is using particular files such as a table of contents (TOCs),
master page, and so on, other files linked directly or indirectly from them will be part of the output.

HOW TO EXCLUDE CONTENT NOT LINKED DIRECTLY OR INDIRECTLY FROM A TARGET
1. Open a target used for online output.
2. On the Advanced tab of the Target Editor, select Exclude content not linked directly or indirectly from the target.
3. Click

to save your work.

EXAMPLE
Let's say your target points to a TOC that includes Topic A, Topic B, and Topic C. If you
generate an online output and use this option in the Target Editor, all three of those topics will be included in the output. In addition, Topic D will be included in the output.
Although Topic D is not found in the TOC, a cross-reference to it is found in Topic B;
therefore, it is linked to the TOC (and the target) indirectly. However, Topic E is not
included in the output, because it is not found in the TOC and none of the topics to be
included in the output contain a link to it.
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EXAMPLE
Let's say you have four topics in your project: Topic A, Topic B, Topic C, and Topic D.
Topic A, Topic B, and Topic C have been included in your TOC. Topic D has not been
included, and it does not contain any links to or from any other topics.
Furthermore, let's say you want to use the "list-of" proxy feature to automatically generate a list of all H2 headings in the project. All four of the topics have H2 headings in
them, and you've inserted the List-Of proxy somewhere in Topic A.
So what happens when you generate the output?
If the "Exclude…" target option is not enabled in the target, all four topics will be
included in the output. In addition, the generated list of H2 headings will show heading
text from all four of those topics.
However, if the "Exclude…" target option is enabled, only Topic A, Topic B, and Topic C
will be included in the output. This also means that the generated list of H2 headings
will show heading text only from those three topics. The H2 heading text from Topic D
will not be included.
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EXAMPLE
Let's say your primary target explicitly links to the following.
n

A TOC

n

A browse sequence

n

A stylesheet

n

One or more glossary files

n

A master page

n

A startup topic

A target can also link explicitly to one or more relationship tables and one alias file.
However, these files are not used to determine whether files should be included when
this "Exclude…" target option is enabled.
n

The TOC and the browse sequence can link to topics, other TOCs, or other
browse sequences. These files would then be included. You could even place a
link to multimedia from a TOC or browse sequence if you wanted (although this
cannot be done in the Flare user interface). It will work and those explicitly linked
resources would also be included.

n

A stylesheet may link to image resources. These resources are included.

n

A glossary file may link explicitly to a topic if a term uses a topic as its definition.
These topics are included.

n

A master page may link to a topic or resource (image/multimedia). These linked
items would be included.

n

The startup topic is, of course, included.

n

Any included topic can explicitly link to additional topics via hyperlinks, cross-references, image maps, or related topics controls (not concept links or keyword
links).
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Using this option can help prevent bloated output by excluding unused files.

EXAMPLE
Let's say you have 1000 images in your project, but only 500 of them are used in the
Microsoft HTML Help output you want to generate. By using this feature, only those
500 images are included in the output, thus keeping the output file size down to a minimum.
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Converting Output File Names and Folders
to Lowercase
You can convert online output file names and folders to all lowercase letters, even if the corresponding file names and folders in the project are not all lowercase. This option is useful, for
example, if you are working in a UNIX environment, which is case-sensitive.

HOW TO CONVERT OUTPUT FILE NAMES AND FOLDERS TO LOWERCASE
1. Open a target.
2. On the Advanced tab of the Target Editor, select Use lowercase filenames.
3. Click

to save your work.

NOTE: This feature applies to the files and folders within the root output folder, but not to
the root output folder itself.
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Omitting the Content Folder from Output
Supported In:

The Content subfolder in a project is normally used to hold all of your content files. If you do not
want this subfolder to be created when you generate online output, you can omit it. When you use
this option and build output, the content files will be placed at the root of the output folder instead,
rather than within the Content subfolder.

HOW TO OMIT THE CONTENT FOLDER FROM OUTPUT
1. Open a target used for online output.
2. On the Advanced tab of the Target Editor, select Do not use "Content" folder in output.
3. Click
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Changing the Output Type for a Target
Each target in your project is based on one of the output types that is available in Flare (Adobe PDF,
Clean XHTML, DITA, Eclipse Help, EPUB, Microsoft HTML Help, HTML5, Microsoft Word, WebHelp,
WebHelp Plus). If you want a particular target to use a different output type than is currently specified, use the following steps. You can also add an internal comment to describe the output.

HOW TO CHANGE THE OUTPUT TYPE FOR A TARGET
1. From the Project Organizer, open the target.
2. Click the General tab.
3. From the Output Type field make a selection.
4. In the message that opens click Yes.
5. (Optional) In the Comment field, you can enter an internal comment that describes the output
you are generating from the target.
6. Click

to save your work.

NOTE: For help in deciding which output type(s) you should use, see "Determining the Output Type" on page 12.
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Associating Master Page Layouts with
Targets
Supported In:

After you create a page layout and configure its frames and settings as necessary, you need to associate the page layout with the appropriate content. In most cases, you will probably want to associate different page layouts with various entries in your outline TOC (so that different page layouts
can be used for different parts or chapters in a manual). Otherwise, you would associate a single
"master" page layout with an entire target or project; in that case, the same page layout will be
applied to all topics in that target or project. You can associate a page layout with an outline TOC
entry with or without creating a chapter break at the same time.
The following steps show how to associate a "master" page layout at the target level.

HOW TO ASSOCIATE A MASTER PAGE LAYOUT WITH A TARGET
1. Open the target. The Target Editor opens.
2. Select the General tab.
3. Click in the Master Page Layout field, and from the drop-down select the page layout that you
want to use for all topics in the target.
4. Click

to save your work.

NOTE: There is an order of precedence with the three levels where you can specify a page
layout. Specific entries in an outline TOC have the highest precedence, followed by page layouts at the target level, followed by page layouts at the project level. So if you've got a page
layout set at the project or target level and it doesn't seem to be working the way you think it
should, you might check to see if you have any page layouts set on specific TOC entries that
are overriding the target- or project-level setting.
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Specifying PDF Options
If you are sending output to Adobe PDF, you can access PDF options in the Target Editor. These
options let you specify the way that images, document properties, PDF tagging, the initial view, and
security are handled in the output.

HOW TO SPECIFY PDF OPTIONS
1. Open a target that is using the PDF format. If necessary, you can change the output type for a
target. See "Changing the Output Type for a Target" on page 150.
2. Select the PDF Options tab.
3. Complete the options on the tab as necessary. If you want to insert a variable, you can click
. The variable will appear as syntax in the field, but in the output the variable definition will
be shown.

IMAGE COMPRESSION
n

Downsample images above Select this if you want to downsample images and then enter
the number of pixels per inch. Downsampling means to reduce the number of pixels in an
image, which can significantly reduce the size of the PDF.

n

Compression Select an option for the compression.
l

l

n

Automatic This uses Flare's internal lossless compression algorithm on all images.
Lossless compression allows you to reduce file size without sacrificing image quality. JPEGs remain as they are.
JPEG This converts all images to JPEG with some compression.

Quality If you select the "JPEG" option, you can also choose an option from this field. Maximum uses the least amount of compression and results in a higher file size.

DOCUMENT PROPERTIES
n

Title Enter the title for the PDF document. This information is included in the final PDF
output (e.g., shown in the file properties). The same is true for the Author, Subject, and
Keywords fields.

n

Author Enter the name of the author.

n

Subject Enter the subject of the document.

n

Keywords Enter any keywords for the document.
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n

Include non-TOC bookmarks in the bookmarks pane If you have inserted bookmarks randomly in some of your topics, by default these will not appear as links in the output navigation pane. If you want these bookmarks to be shown in the navigation pane (under
your table of contents links) you can click this check box.
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n

Create named destinations for bookmarks Select this check box if you want to automatically create named destinations everywhere a bookmark exists. This lets you create
links from a file to a specific location in a PDF. You can also insert named destinations
manually.
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n

Include Crop and Registration Marks Select this check box if you want to include crop
and registration marks in the output. These are elements that are often used when documents are sent to a professional printer.
l

l

Crop marks These are thin vertical and horizontal lines that show the edges of the
page, where it will be trimmed by the printer. The location of crop marks are determined by the page size you specify.
Registration marks These are small cross-hair target icons shown next to crop
marks. Each color in the final output is printed on its own layer. Therefore, in order to
make sure the colors are matched up accurately, printers use registration marks to
align plates on the press.
EXAMPLE
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Here is PDF output showing crop and registration marks.
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n

Convert RGB Colors to CMYK Select this check box if you have used only RGB colors in
your content and want all of those occurrences to be converted to the CMYK model in
the output. CYMK is an acronym for the four primary colors used in printing (Cyan,
Magenta, Yellow, and Key—or black). Whereas CMYK is often the preferred model for
print-based output, the RGB (Red, Green, Blue) model is primarily intended for electronic
content.

n

Convert spot colors to black and white Select this option to convert spot colors to black
and white. Spot colors include things such as font color, background color, and so on
(basically, everything except images). This is a quick way to produce a PDF that does not
contain color. The alternative is to make sure that you do not have any color settings locally in topics, in your stylesheet (or medium), in page layouts, etc. For example, you might
create some PDFs in full color, but you might need to send one to a professional printer to
be processed in black and white. So for that target, you select the option to convert spot
colors to black and white.
NOTE: If you also need the PDF to show images in gray scale, you have a couple
of options. First, you can insert one image in color and another in gray scale, then
apply conditions to them. Second, you can create and insert just one image, but
single-source it so that online outputs show it in color but print outputs show it in
gray scale.

PDF TAGGING
n

Generate tagged PDF Select this to generate a tagged PDF. This gives the file a structure
similar to that of the source XHTML documents. This structure is necessary for certain
accessibility applications, including screen readers. For more information about viewing
the tag structure in Adobe Acrobat Pro, please refer to the documentation provided with
that application.
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INITIAL VIEW
n

Magnification Select the default size for displaying the PDF output when an end user
opens it (e.g., actual size, fit page, fit width, a specific percentage).

n

Navigation Select how you want the output to be displayed by default when it comes to
navigation features (Page Only, Bookmarks Panel, and Page).

n

Page layout You can select any of the following options to set the page layout that the
reader initially sees when opening the PDF.
l

CHAPTER 8

(default) Single Page This displays one page at a time, with no portion on other
pages visible. When you slide the scroll bar, the current page does not scroll; instead,
the next page appears quickly.
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l

l

CHAPTER 8

Single Page Continuous This displays pages in a continuous vertical column that is
one page wide. When you slide the scroll bar, the current page scrolls until the next
page smoothly comes into view.

Two-Up (Facing) This displays each two-page spread with no portion of other pages
visible. When you slide the scroll bar, the current pages do not scroll; instead, the
next pages appear quickly.
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l

l
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Two-Up Continuous (Facing) This displays facing pages side by side in a continuous
vertical column. When you slide the scroll bar, the current pages scroll until the next
pages smoothly come into view.

Two-Up (Cover Page) This displays the first page by itself. After that it displays each
two-page spread with no portion of other pages visible. When you slide the scroll bar,
the current pages do not scroll; instead, the next pages appear quickly.
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l

n

Two-Up Continuous (Cover Page) This displays the first page by itself. After that it
displays each two-page spread with no portion of other pages visible. When you slide
the scroll bar, the current pages scroll until the next pages smoothly come into view.

Title bar You can select one of the following to determine the text shown in the title bar of
the PDF output.
l

l

File Name This is the text specified in the Output File field on the General tab of the
Target Editor.
Document Title This is the text specified in the Title field on the PDF Options tab of
the Target Editor.

n

Collapsed bookmarks Select this if you want the bookmark folders to be collapsed initially
in the bookmark panel of the output.

n

Open in full screen mode Select this if you want the output to be displayed initially in full
screen mode, taking over the reader's entire screen.
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SECURITY
n

Require password to open Select this if you want users to be required to enter a password in order to open the document. Then type the password you want to use.
Specify the amount of security for the document.

n

l

40-bit Not as secure, but can be viewed with Adobe Reader 3.0 and higher

l

128-bit More secure, but can be read only with Adobe Reader 5.0 and higher

Restrict permissions Select this if you want to limit what readers of the document can do
unless they have the permissions password. Then type the password you want to use.
When you set only a permissions password (also known as a "master password"), recipients don’t need a password to open the document. However, they must type the permissions password to set or change the restricted features. This option works with
Adobe Acrobat Reader 9.0 and higher.
In the Open Permissions section, specify the actions that you want to restrict.
NOTE: If the PDF is secured with both types of passwords, it can be opened with
either password. However, only the permissions password allows the user to
change the restricted features. Because of the added security, setting both
types of passwords is often beneficial. All Adobe products enforce the restrictions set by the permissions password. However, if third-party products do not
support or respect these settings, document recipients are able to bypass some
or all of the restrictions you set.

4. Click

to save your work.

NOTE: File size results with these options may vary.
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Specifying PDF Output Via Word
If you are building Microsoft Word targets, you can send the output to Adobe's Portable Document
Format (PDF). When you use this feature, Flare generates both the native Word documents, in addition to a PDF file.

Creating a PDF Via Microsoft Word
In order to send output to PDF via Microsoft Word, you need to have the following setup:
n

You must have Microsoft Word 2007 installed. Previous versions of Word do not support this
functionality.

n

You must download and install the following free add-in from Microsoft:
http://www.microsoft.com/downloads/details.aspx?familyid=4D951911-3E7E-4AE6-B059A2E79ED87041&displaylang=en
NOTE: With Word 2007 and this add-in from Microsoft, there is no need to have the
Adobe Distiller installed.
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HOW TO SPECIFY PDF OUTPUT VIA MICROSOFT WORD
1. Open the Word target.
2. In the Target Editor, do one of the following:

USE THE OUTPUT FILE FIELD ON THE GENERAL TAB
a. Select the General tab.
b. In the Output File field, enter the name that you want to use for the main output file and
add the .pdf extension at the end of it. For example, if you want your main output file to
be called "MyNewManual," you would enter the following in this field: MyNewManual.pdf

USE THE CHECK BOX ON THE ADVANCED TAB
a. Select the Advanced tab.
b. Click the check box next to Generate PDF for MS Word Output.
NOTE: If you use this second check box option, it will overrule any file extension specified for the output file name on the General tab.

3. Click

to save your work.

NOTE: You can also create PDF output directly, without going through Word.
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Collapsing Top Margins
Supported In:

In PDF targets you can collapse the top margin for all elements occurring at the top of a new page
or column.

HOW TO COLLAPSE TOP MARGINS
1. Open the target.
2. In the Target Editor, select the Advanced tab.
3. In the Margins section, select Collapse top margin at top of page/column.
4. Click
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EXAMPLE
Let's say you have top margins set on your headings. If the "collapse top margin" option
is not enabled, the results are something like this (a red border has been added to the
body frame so you can see the subtle difference):

If the option is enabled, the results are something like this:
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Improving the Processing Performance of
the Target
Supported In:

You can improve the speed that your output loads for end users in several ways.

HOW TO IMPROVE THE PROCESSING PERFORMANCE OF A TARGET
1. Open a target.
2. In the Target Editor select the Performance tab
3. Select the option(s) that you want to use:
n

Condense JavaScript Files You can condense any JavaScript files in your output. This
causes all of the output's runtime scripts to be merged into one file and improves web
server performance by causing there to be fewer requests when loading the output.

n

Pre-load Images You can pre-load your images that are not initially visible when output is
opened. When those images are triggered to be displayed, they will appear faster since
they were pre-loaded. This happens at the cost of the output taking slightly longer to initially open since it must download more content. On the other hand, disabling pre-loading
images will cause the output to open faster. Instead they will have to be downloaded
when they are triggered to be displayed.
NOTE: This option is not available for HTML5 targets.
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n

Chunk Large Index/TOC/Glossary Files You can control the size of "chunks" used when
generating the index, TOC, and glossary files for a target. After you choose this option,
select the number of bytes for each chunk. The chunk size affects the speed that a Help
system loads for a user. Depending on the Internet connection, different results will be
seen. The smaller the chunk size, the greater the number of chunks that will be sent. A
large number of chunks may result in a slower speed, especially if you have many merged
"sub-projects" and the index is being merged. Chunking may slow down the generation of
your output somewhat, but it increases the speed that the output loads for end users. For
best results, you should test the different chunk sizes.
NOTE: The option for chunking large glossary files is only available in HTML 5 targets.

4. Click

to save your work.

5. Build and publish the output.
6. Open the output from the published destination to test the loading performance of the output.
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Specifying How Online Features are
Converted in Printed Output
The online features from your project (e.g., text hyperlinks, expanding text, Help controls) are converted to print-based output in various ways, as described in the following table.
Online feature

How it is converted in print-based output

Breadcrumbs

Not included in the document

Browse
sequences

Not included in the document

Context-sens- Not included in the document
itive Help
Cross-references

You can convert the cross-references to page number references (e.g., "See My
Topic" can become "See page 36"). This is done by using a stylesheet medium and
changing the property settings for the cross-reference style for the print medium.
You also need to make sure the print medium is associated with the target you
wan to build.

Drop-down
text

Hotspot converted to text; body expanded inline

Expanding
text

Hotspot converted to text; body can be converted (in the Target Editor) to (1) footnotes, (2) inline text, or (3) removed. See steps below.

Favorites

Not included in the document

Glossary
term links

Converted to footnotes at the bottom of pages

Help controls
(related topics, concept
links,
keyword
links)

Not included in the document
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Online feature

How it is converted in print-based output

Popups

Hotspot converted to text; body can be converted (in the Target Editor) to (1) footnotes, (2) inline text, or (3) removed. See steps below.

Rules (horizontal lines)

Not included in the document

Scripts

Not included in the document

Search

Not included in the document

Text hyperlinks

Converted; for some outputs (e.g., Word), users can press CTRL key and click link
to go to destination

Togglers

Hotspot converted to text; destination converted to inline text

Topic popups

Converted to text with link removed

HOW TO SPECIFY THE WAY ONLINE FEATURES ARE CONVERTED IN PRINTED
OUTPUT
Some online features in your project are automatically handled in one way or another when you produce printed output. However, there are some features (expanding text and popup effects) where
you can specify how you'd like them to be treated in the printed output.
1. Open the target that you plan to build for your printed output. The Target Editor opens.
2. Click the Advanced tab.
3. In the Expanding Text Effects and Text Popup Effects sections, select an option for each type
of online feature:
n

Convert to footnote The body for the expanding text or popup effect is displayed as a
footnote in the printed output.

n

Expand text inline The body for the expanding text or popup effect is displayed as a text
(after the "hotspot" text) in the printed output.

n

Remove the "body" The body for the expanding text or popup effect is not included in the
printed output.

4. Click
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Associating Publishing Destinations with
Targets
After you create a publishing destination, you need to associate it with a target that you plan to
build. You can associate the same publishing destination with as many targets as you want.

HOW TO ASSOCIATE A PUBLISHING DESTINATION WITH A TARGET
1. Open the Project Organizer.
2. Double-click the Targets folder. The existing targets are shown.
3. Double-click the target that you want to associate with the destination. The target opens in its
own page in the Target Editor.
4. Click the Publishing tab. All publishing destinations that have been added to the project are displayed. If a destination contains a check mark next to it, that means it is associated with the
target. If it does not contain a check mark, it is not yet associated with the target.
5. Click the check box in the Publish column next to any destinations that you want to associate
with the target. A check mark appears next to any destinations that you select.
6. If you are associating an Elasticsearch destination with a target, click the drop-down arrow in
the Elasticsearch Destination column. Select your Elasticsearch destination from the dropdown list.
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NOTE: Elasticsearch destinations will not display in the list of destinations on the Publishing tab in your Target Editor. This is because you will select one from the Elasticsearch Destination field on the Publishing tab of the Target Editor.

7. Click

CHAPTER 8

to save your work.

172

Integrating Flare and Pulse
To integrate the embedded discussion forms and other Pulse features with your Flare output, add a
new community in Flare. This action automatically creates a new system in Pulse, allowing your
web server to host, store, and serve the embedded discussion forms that appear below the topics in
your Flare output. This system also gives you and your team members the ability to moderate and
administer the Pulse features and content from the Pulse dashboard.

Integration Options
If you are developing an online Flare target for a single product, service, or purpose, integrating Flare
is a straightforward process. You simply install Pulse and then add a new Flare community to create
a corresponding system in Pulse. However, because many organizations develop multiple Flare targets, you also have these options:
n

Add a Single Flare Community for Use With Multiple Targets In this scenario, you add one
Flare community which creates a corresponding Pulse system. Then you associate that community with multiple Flare targets. This method gives you less-granular reporting capabilities
in Pulse.

n

Add a Unique Flare Community for Each Different Target In this scenario, you add a unique
Flare community for each different target. This creates a separate system in Pulse. The
advantage of using this option is that it gives you more granular reporting capabilities, letting
you generate usage reports for each community.
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Enabling the Pulse Server
To give Flare the ability to interact with Pulse, you must supply the Flare community in the target
with the appropriate connection information and administrative access credentials for the Pulse
web server.

HOW TO ENABLE THE PULSE SERVER
1. Open the desired Flare project.
2. In the Project Organizer, open the desired WebHelp or HTML5 target.
3. In the Target Editor, select the Community tab.
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4. Enable the server as follows:
a. At the top of the Community tab, place a check mark in the Enable Pulse/Feedback
Server box.
b. In the URL field, type the URL for the Pulse web server.

NOTE: To find the URL, log in to the Pulse dashboard as an administrator. Then
select Administration > Settings > General Settings. The URL above corresponds
to the value in the Site URL box.

NOTE: If you have installed a Secure Sockets Layer (SSL) certificate on the
Pulse web server, ensure that the URL starts with the https:// protocol (instead
of http://).
c. Enter the access credentials as appropriate:
n

If this is the first time you are enabling the Pulse community in the Flare target, the
Log In dialog automatically appears.
OR

n
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If you want to change the existing login information, click the Logout button to clear
the existing credentials. Then click Login. The Log In dialog appears.
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d. In the Log In dialog, type the appropriate User name and Password. The account that you
use must have administrative permissions to Pulse. You have these options:
n

Use the PulseAdmin Account This is the default administrator account that was created by the person who installed Pulse.

n

Use an Account that is a Member of the Administrators Group This can be any
account belonging to a registered Pulse user who is a member of the Administrators
group.

e. Click OK or press Enter to close the Log In dialog.
f. Before you can save the Flare target, you must associate a Flare community with the
Pulse system.
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Setting Up the Community in Flare
After enabling the Pulse server in the desired target, you can set up the community in Flare. If you
are setting up Flare for the first time, you will add a new Flare community.

HOW TO ADD A NEW FLARE COMMUNITY
If this is the first time you are integrating Flare andPulse, add a new Flare community to your project's Flare target. This process automatically creates a new "system" on the Pulse server. In Pulse,
a system hosts the following items:
n

The activity streams that are used when moderating your topics with the Pulse dashboard

n

The embedded discussion forms that registered Pulse users can access in the Flare output

IMPORTANT: To integrate Flare content with Pulse integration, you must always add new
or use existing communities in Flare. While you have the ability to create systems using the
Pulse dashboard, you do not have the ability integrate those systems with a Flare community.

1. In the Community tab, locate the Communities list and then click Manage.

2. In the Manage Community dialog, click Add.
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3. In the Enter Name dialog, type a name for your community. In this example, we are creating a
community to use with a Flare target about Pets. Then click OK.

4. In the Manage Communities dialog, the new community appears. Click OK to close the dialog.
5. Click Refresh to update the Current Pulse Configuration info. This provides you with basic
information about the community, such as the status of the server, and the total number of
users.
After the community is associated with the Flare target, the Remap Topics button becomes available so you can map your community topics to Pulse for the first time.
You also have the ability to select an existing community, delete a community, provide a published
URL, and rename a community as follows:

HOW TO SELECT AN EXISTING FLARE COMMUNITY
If you need to publish any updates for your Flare output and do not wish to create a new community
for your documentation release, select the community that you previously created for the target.
This gives you the ability to ensure that any new, removed, and updated topics are mapped to the
appropriate embedded discussion forms in the Pulse system.
1. In the Community tab, locate the Community area.
2. From the Communities list, select an existing community.
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3. Click Refresh to update the Current Pulse Configuration info. This provides you with basic
information about the community, such as the status of the server, and the total number of
users.

NOTE: The Communities list in Flare initially only includes communities that have
been added with the Flare user interface. If you create Pulse systems using the Pulse
dashboard, those systems will be not be listed as Flare communities until you remap
the topics.

NOTE: You can associate multiple Flare targets with a single community if desired.
However, for best results with reporting, we recommend that you create a separate
community for each target. This will also simplify any mapping/remapping tasks
when you publish updates.

NOTE: If you want to verify that the Flare community you added is now a system in
Pulse, log in to the Pulse dashboard using an account that is a member of the Administrators or Employees group. The select Systems > Find Systems from the menu.
The community you created will appear in the list.
After the community is activated, the Remap Topics button becomes available so you can
remap the community topics to Pulse.
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HOW TO DELETE A FLARE COMMUNITY
If you want to delete a Flare community, use the steps below. This deletes both the Flare community and the Pulse system.
1. In the Community tab, locate the Communities list and click the Manage.

2. In the Manage Community dialog, select the community that you want to remove. Then click
Delete.
3. When prompted to confirm the delete action, click Yes. This removes your selection from the
Communities list.
4. Click OK to close the Manage Communities dialog.
5. Click Remap Topics and confirm the topics to remove.
6. Click
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HOW TO PROVIDE A PUBLISHED URL FOR A COMMUNITY
You can assign a URL path to your community from your Flare target. This can also be done from
the Pulse dashboard (by selecting Administration > Settings and clicking Communities), but using
the Flare target is recommended.
1. Under the Community area, click the Manage button.
2. In the Manage Communities dialog, highlight the community that you want to edit. Then click
Edit
3. In the Edit Community dialog, click in the Enter published url field and enter a path to the main
landing page of your Flare output.
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When you enter a published URL path, make sure you include http:// at the beginning of the
URL.
EXAMPLE
Let's say you've generated a target called "FlareOutput" and you've uploaded the
output so that users access it
here: help.mycompany.com/FlareOutput/Default.htm. In that case, enter
http://help.mycompany.com/FlareOutput in the Published Url field.
4. Click OK to close the Edit Community dialog. Click OK to close the Edit Community dialog.
5. Click OK to close the Manage Communities dialog.
6. Click

to save your work.

Why is it a good idea to assign a URL path to a community? Because it allows topic feeds to open in
context.
EXAMPLE
Let's say you have not provided a published URL for your community. You receive an
email notification stating that a user has posted a comment in one of your topics. So
you click the topic name link in the email notification to see the feed where the comment was posted. The feed opens in the dashboard view of Pulse, which shows only
the feed and not the topic associated with it.
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On the other hand, let's say you provide a published URL to your community. In that
case, when you click the topic link, the topic opens in the actual Flare output. You see
both the topic and the Pulse feed below it, therefore giving context to the post.
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HOW TO RENAME A FLARE COMMUNITY
1. In the Community tab, under Current Pulse Configuration, click the Refresh button.
2. Under the Community area, click the Remap Topics button ensure your topics have been
mapped
3. Under the Community area, click the Manage button.
4. In the Manage Community dialog, highlight the community that you want to rename. Then
click Rename.

In order to add the embedded discussion forms to the Flare output that you will publish, you
must map/remap the community topics in Flare for Pulse.
5. In the Enter Name dialog, type a new name for your community. Then click OK.
This changes the name of the community in Flare, as well as the name of its corresponding
Pulse system.
NOTE: If an error message appears, try clicking the Refresh button and the remapping the topics. This typically resolves any issues.
6. Click OK to close the Manage Communities dialog.
7. Click
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Mapping/Remapping a Flare Community to Pulse
In order to add the embedded discussion forms to the Flare output that you will publish, you must
map/remap the community topics in Flare for Pulse.

HOW TO MAP A NEW FLARE COMMUNITY TO A PULSE SYSTEM
If this is the first time you are setting up a Flare community for a target, you will need to map the topics for your community to Pulse.
1. Make the desired changes to your Flare target. Always be sure to update the TOC before
remapping the topics.
2. In the Target Editor, select the Community tab.
3. From the Communities drop-down list, select the appropriate community.
4. Click Remap Topics.
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This opens the Remap Community Topics dialog.
5. In the Remap Community Topics dialog, make sure the New Topics tab is selected and review
the topics in the list.
EXAMPLE
A topic count appears in the label of the New Topics tab. The tab lists the topic
titles and paths to the topics. These items will be mapped to a corresponding
stream in Pulse. In a new community, the counts in the other tabs will typically be
zero (0).

6. When finished, click OK. The system automatically maps each community to a stream in
Pulse. The community updated message appears.
7. Click
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HOW TO REMAP A FLARE COMMUNITY TO AN EXISTING PULSE SYSTEM
As you prepare to publish content updates to a Flare target, you can review the new, removed, and
updated topics and then reassign any of the topics to the appropriate stream in the Pulse system.
This stream corresponds to the embedded discussion form at the bottom of the Flare topic.
1. Make your content changes in Flare. Be sure to make all of the desired updates in the Flare
TOC associated with your target.
2. Open the Flare target.
3. In the Target Editor, select the Community tab.
4. From the Communities drop-down list, select the appropriate community.
5. Click Remap Topics. This opens the Remap Community Topics dialog so you can review the
updates:

NEW TOPICS TAB
The New Topics tab lists Flare updates that have an effect on the Pulse mapping definitions:
n

New Topics New topics that have been added to the Flare TOC associated with the target.

n

Moved Topics Existing topics that have been moved to a different folder or location in
the Content Explorer.

n

Renamed Topics (New Name) Existing topics where the actual file name has changed.
The new file name appears in this tab.
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REMOVE TOPICS TAB
The Remove Topics tab lists Flare updates that have an effect on the Pulse mapping definitions:
n

Deleted Topics Topics that have been removed from the Flare TOC associated with the
target.

n

Moved Topics Existing topics that have been moved to a different folder or location in
the Content Explorer.

n

Renamed Topics (Former Name) Existing topics where the file name has changed. The
former file name appears in this tab.

UPDATE TOPICS TAB
The Update Topics tab only lists community topic updates that specifically relate to Pulse
mapping definitions. This includes topic updates such as title changes, reassigned links, and
so on.
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EXCLUDE TOPICS TAB
The Exclude Topics tab lists all topic files where Flare changes have no effect on the Pulse
mapping definitions.

When finished, click OK. The community updated message appears.
6. Review the topics in each tab and then reassign the links as desired. See below for instructions.
7. When finished, click OK. The community updated message appears.
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HOW TO REASSIGN A LINK
When you are preparing to publish content updates for a Flare target, there may occasionally be
times when you want to reassign a link that is associated with a community topic. This lets you take
the embedded discussion form associated with a topic and associate it with a different topic.
EXAMPLE
Let's say you have a topic with the file name, "Feeding_Cats.htm" and you decide to
rename it, "Feeding_a_Cat.htm." When you make this change, the Remap Community
Topics dialog will list this change in two places.
The New Topics tab will shown the new topic file name. If you click OK in the dialog,
the system would add a new stream for the topic in the Pulse system:

The Remove Topics tab will show the former file name. If you click OK in the dialog,
the system would remove the corresponding stream for the topic in the Pulse system:
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Instead of creating a new stream for the new topic named "Feeding_a_Cat.htm", let's
say you want to keep the discussion from the existing stream associated with "Feeding_Cats.htm." You can reassign the link to tie the discussion with the old file name to
the new file name.
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HOW TO REASSIGN A LINK
1. Make your content changes in Flare. Be sure to make all of the desired updates in the Flare
TOC associated with your target.
2. Open the Flare target.
3. In the Target Editor, select the Community tab.
4. Select the appropriate Flare community in the Community drop-down list.
5. Click Remap Topics. This opens the Remap Community Topics dialog so you can review the
updates. In this example, we've renamed a topic file from "Feeding_Cats.htm" to "Feeding_a_
Cat.htm."

6. In the New Topic tab, right-click the new topic and select Reassign Link from the context
menu.

This opens the Reassign Community Link dialog.
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7. From the Select Links drop-down list, select the desired topic. This will map the embedded
discussion form for the selected link with the topic. In this example, we will select the topic
formerly named, "Feeding_Cats.htm."

8. When finished, click OK. The community updated message appears.
When you republish your Flare target, the discussion originally linked to the former file is now
linked to the new file.
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HOW TO VERIFY THE COMMUNITY TOPICS IN THE PULSE SYSTEM
To see the community topics that have been created for your Flare output:
1. Log in to the Pulse dashboard with an appropriate user account.
NOTE: To access systems, you must be a member of the Administrators or Employees group.
2. In the menu bar, select Systems > Find Systems. The Find Systems page appears.
3. Under New Systems, click the Pulse system that corresponds to the appropriate Flare community.
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4. In the community page, click the Topics link.

5. In the list of topics, click a topic. Any community activity for the topic will be reflected in the
stream.
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Enabling the Community Tab in the Output
You need to decide whether you want to include or exclude the Community tab with your published
output. For HTML5 output, this can be done for Tripane skins only.
Below is an example of the Community tab:

You can enable or disable this feature by editing the general features of the skin associated with the
Flare target.
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The benefits of including the Community tab in your output include:
n

Gives site visitors the ability to register for a Pulse account. Also gives registered users the
ability to log in to Pulse directly from the Flare output.
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n

Gives registered users the ability to edit their profile, which includes changing their avatar
image, updating personal information, and modifying notification preferences.

NOTE: You cannot add a Community pane to Top Navigation or skinless HTML5 output,
because those outputs do not use panes. However, registered users can open the dashboard in a browser and access some of the features that are normally available in the Community pane in the Flare output (depending on the access level).
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Setting the Community Options—Comments and Search
Results
You can set community options, which control the display of comments and search results. For
both Standard and HTML5 skins, you can do this in the Skin Editor. For HTML5 outputs—including
skinless—you can also use your stylesheet to display or hide topic comments; this makes it possible
to show comments for some topics but hide them for others.

HOW TO SET THE COMMUNITY OPTIONS USING A SKIN
1. In the Project Organizer, open a Standard or HTML5 skin.
2. In the Skin Editor, click the Community tab. You have these options:

TO DISPLAY TOPIC COMMENTS
If you want registered Pulse users to have the ability to post comments in the embedded discussion forms that Pulse includes at the bottom of the Flare topics, place a check mark in the
Display topic comments at the end of each topic check box. This check box is selected by
default.

TO DISPLAY COMMUNITY SEARCH RESULTS
You can configure the Flare skin to give the Flare search engine the ability to index the Pulse
system and return any community results when end users perform searches.
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EXAMPLES
In HTML5 output, Pulse posts matching the search query are listed on the
Search Results page under a Community Results link:
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If a user clicks the Community Results link shown above, only the matching
Pulse content appears in the results page:

Users can then hover the mouse cursor over the content to reveal a links that
open either the matching Pulse post, the matching Flare topic and the matching Pulse post, or the Pulse user feed.

This feature works similarly in WebHelp output.
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TO DISPLAY SEARCH RESULTS
a. Open a Standard or HTML5 skin.
b. Click the Community tab.
c. Place a check mark in the Display community search results box.
d. (Optional) In the Number of community search results field, you can enter the number
of community search results shown by default when a search is made in the output.
The default number in this field is 3.
NOTE: The Feedback area in the Community tab of the Skin Editor is only relevant to
Feedback Server Admin. The Feedback option is not supported by Pulse.

3. Click

to save your work.

HOW TO SET THE COMMUNITY OPTIONS (DISPLAY COMMENTS) USING A
STYLESHEET
1. Open the stylesheet.
2. Find and select the html style or the appropriate class.
3. In the Show filter field, select Alphabetical List.
4. Find the mc-community-features property and set it to enabled or disabled. The default setting is "enabled."
5. Click

to save your work.

This stylesheet method can be especially useful if you only want some topics to display the comment area.
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EXAMPLE
Let's say you create a Flare project and structure it in much the same way that some of
Flare's project templates are structured. In other words, you have a main Home page
that looks much different than the rest of your topics and serves primarily as a landing
page with links, not to provide content. Therefore, you do not want the Pulse comment
area to be displayed at the bottom of that topic.
However, you do want the comments to appear at the bottom of all of your other topics.

CHAPTER 8

203

You have two stylesheets—one for the Home topic and another for all the other topics.
So you open the stylesheet that is designated for the Home page and for a special html
style class you've created (called "HomePage"), you set the mc-community-features
property to disabled.
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Then you open the Properties dialog for that Home topic. You associate the topic with
the stylesheet and choose the HomePage style class.

As far as the other topics are concerned, they are using a different stylesheet. But you
don't need to set the mc-community-features property in it, because the default setting
is to enable the Pulse comments area. Therefore, the comment area will automatically
be displayed. The only thing you need to do is make sure all of those topics are using
the appropriate stylesheet.

NOTE: If there is a discrepancy between the skin and the stylesheet setting (e.g., the skin is
set to disabled and the CSS is set to enabled), the stylesheet setting has precedence.

NOTE: Comments at the bottom of topics are not shown in tablet or mobile view. This is the
same case for HTML5 Tripane output.
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NOTE: The comments area at the bottom of topics is wrapped in an iframe. Therefore, the
output is technically not entirely frameless. However, because it is only the comments that
are contained in the iframe, the main topic content still retains the benefits (e.g., better
search results) of frameless output.

STYLES FOR GENERATED PULSE AND SEARCH TOPICS
Sometimes your output may display content that is entirely auto-generated, rather than pulling content from one of your topics. This occurs when search results are displayed. It also occurs if your
output is integrated with MadCap Pulse and a user clicks the Edit User Profile button, which then displays information on the Pulse home page, with no topic content shown.

STYLE CLASSES
For HTML5 Side and Top Navigation (and skinless outputs), you can add the following classes of the
html style to control the look of these generated pages:
n

pulseTopic This style class controls the look of a generated Pulse page (i.e., page opened via
the Edit User Profile button).

n

searchTopic This style class controls the look of a generated search results page.

n

templateTopic This style class controls the look of all generated pages and has precedence
over the other the pulseTopic and searchTopic classes.
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SUGGESTED STYLE SETTING
If you include a side menu—via a Menu proxy—that is not context-sensitive, this menu may display
on generated pages, not just in regular topics. This is probably something you want to avoid.
Therefore, to prevent this issue, you may want to copy the following to your stylesheet via the
Internal Text Editor.
html.templateTopic div.sideContent
{
display: none;
}

NOTE: These styles are supported only in HTML5 Top Navigation and skinless outputs.
They are not supported in HTML5 Tripane output.
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Building and Publishing the Flare Output
Once you set up the community features, you can build and publish your Flare output.
When building the output, you may see a message that states, "Some community features will not
be displayed in tablet and mobile outputs." This means that when users are viewing your responsive
output on a tablet or phone, they will not see comments or the Community tab. However, Pulse still
tracks hits on pages in those formats for reporting purposes. You can hide the warning if you do not
want to see it in future builds.
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Setting Redacted Text on Targets
Supported In:

For each PDF document that needs to include redacted content, you can open the target. Then you
can use the Advanced tab to specify how the content marked as "redacted" should be treated in the
output.

HOW TO SET REDACTED TEXT ON TARGETS
1. Open the appropriate PDF target.
2. In the Target Editor, select the Advanced tab.
3. In the Redacted text section, select one of the following.
n

Black out Displays black rectangles in places of content that has been redacted.

n

Highlight Displays content that has been redacted with a highlighted background.

n

Display as normal text Displays content that has been redacted in the same way that it
displays other content.

Why are there choices other than "black out"? Those options are available in case you need to
generate another output that shows the redacted text.
EXAMPLE
Let's say you need to generate one PDF that blacks out the redacted text (e.g.,
the version being released to the public) and another PDF that shows the text
rather than hiding it (e.g., the version being distributed to authorized individuals).
In that case, you can open the target to be used for public release and set the
redacted text option to "Black out." For the target to be used for authorized individuals, you can set the redacted text option to either "Highlight" or "Display as
normal text."
4. Click
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Associating Relationship Tables with
Targets
Supported In:

If you have created relationship tables in your project, you need to tell Flare which tables to use for
which targets.

HOW TO ASSOCIATE RELATIONSHIP TABLES WITH TARGETS
1. Open the target from the Project Organizer.
2. In the Target Editor, click the Relationship Table tab.
3. Click next to each relationship table that you want to use for that target so that it has a check
mark.
4. Click
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Associating a Search Filter Set with a Target
Supported In:

After you create search filters, you need to associate the search filter set with the target that you
want to build.

HOW TO ASSOCIATE A SEARCH FILTER SET WITH A TARGET
1. Open the target that you plan to build.
2. In the Target Editor, click the Advanced tab.
3. Click the drop-down arrow in the Filter File field, and select the search filter set that you want
to associate with the target.
4. Click
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Enabling Partial-Word Search
Supported In:

For some online outputs, you can provide end users with partial-word search capabilities. This lets
users type part of a word or any string (including numbers), press Enter or click the Search button,
and see search results matching those characters.

HOW TO ENABLE PARTIAL-WORD SEARCH
1. In the Project Organizer, open the target.
2. Select the Search tab.
3. In the Search Results section, place a check mark in the Partial word searching box.
4. In the Minimum word size field, enter the number of characters a user must type before seeing results. The minimum value is 3, the maximum value is 10.
NOTE: The higher the minimum word size that you enter, the smaller the search database.

5. Click
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EXAMPLE
Let’s say that in the Search field, you enter cond.
Search finds matches in "conditioning" and "second."

This feature is not limited to words only. It works with any string (including numbers) that starts and
ends with a space. For example, let's say that the IP address numbered "192.168.10.1" is included in
one of your topics. To find the topic that includes the match, simply type 10.1 in the search field.

NOTE: Partial-word search is not supported in server-based output.

IMPORTANT: Enabling partial-word search in client-based outputs increases the size of the
search database included with your target output. It also increases the amount of time it
takes to build and publish the output.
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Setting Up a Search Engine
Supported In:

For HTML5 targets, you can choose the type of search engine you want people to use—MadCap
Search, Google Search, or Elasticsearch (for Side Navigation, Top Navigation, or skinless output).
There are additional steps that you can follow and features you can select, depending on the search
engine you choose. For MadCap Search and Elasticsearch, you can include micro content in the output, which can especially enhance your search results.
See the online Help for more information about search engine type available for your output.
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Comparison of Search Engine Options
There are benefits to any of the search methods offered by Flare. Some users might prefer the
search results returned by Google. However, others might prefer the results returned by MadCap.
Or some users might want all of the configurable options provided by Elasticsearch.
TIP: To determine the type of search that is best for you, we recommend that you generate
different outputs using each method. Then perform several different searches and see
which results you like best.
Elasticsearch

Google Search

MadCap Search

Time and Effort
to Set Up

Setting up Elasticsearch
is done within the Target
Editor and Destination
Editor in Flare. Web servers also need to be configured to support Flare,
along with the Elasticsearch service.

Setting up a Google custom search engine
(CSE) and performing
other necessary tasks
requires a combination
of steps in both Google
and Flare. This can take
a bit of time to complete. However, it is usually just a one-time
setup.

Setting up MadCap
Search in a Flare project
takes only a few
seconds.

Public Versus
Local Output

Output must be published on a server in
order to use the full capability of Elasticsearch.

Output must be available
publicly so that you can
use Google. Output cannot be behind a firewall.

Output can be
searched whether it is
available publicly or locally.
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Elasticsearch

Google Search

MadCap Search

Number of Outputs

You can manage multiple HTML5 targets that
use Elasticsearch
through the Content Services Portal.

You can add multiple
folders/sites to be
included in your Google
custom search engine
(CSE). Each of these
sites can be a separately
published Flare output.
When users search from
one of the published
Flare outputs, results will
display for all of the outputs.

Searches will include results for only the Flare output that is open.

Other File
Types

Most file types are
included in the search
results.

If you have added
other types of files (e.g.,
PDF) to the site(s) associated with your CSE,
they may be included in
search results.

In order to include file
types such as PDF in
your search results, you
need to generate and
publish server-based output.

Search Tailored
to Flare Projects

Elasticsearch does not
provide any direct mapping of search criteria to
the structure of a Flare
project.

Google does not recognize the unique characteristics of a Flare
project (e.g., index
keywords, glossaries).
Therefore, those elements will have no
effect on how Google
ranks pages in the results.

MadCap Search rankings are specifically
tailored for Flare users.
They take into account
not only H1-H6 headings,
but also index keywords,
glossary terms, etc.

Micro Content
in Results

Elasticsearch lets you
include micro content in
your search results,
which can especially
improve the experience
for users.

Google does not include
micro content (created
in Flare) in your search
results.

MadCap Search lets
you include micro content in your search results, which can especially
improve the experience
for users.
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Elasticsearch

Google Search

MadCap Search

Glossary Definitions in Results

Elasticsearch does not
provide an option to
include glossary terms in
your search results.

Google will not fetch
your project’s glossary
terms and feature them
at the top of search results.

MadCap Search will
fetch your project’s glossary terms and feature
them at the top of
search results.

Incorrectly
Typed
Searches

The partial-word
search and fuzzy match
settings allow for numerous searches to be
returned when these settings are enabled.

If an end user incorrectly enters a search
term (e.g., types “Tble”
instead of “Table”),
Google will often guess
the correct term and
show results anyway.

Incorrectly typed search
terms will not return results.

Search and
Indexing Speed

The administrator
portal allows for the
search indexes to be
managed closely. This
will assist in keeping
search result times
optimal.

Search results might lag
at times, depending on
the size of the output
and whether Google is
finished with the indexing (i.e., making your output available for
searches).

Search results might
be faster because the
output is immediately
indexed once it is generated. You do not need
to spend any extra time
indexing your pages or
waiting for search results
to appear.

Google will index your
pages automatically
over time, but it can take
awhile, sometimes
weeks.
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Elasticsearch

Google Search

MadCap Search

Mobile Devices

Search results always
come from a server, so
you do not need to be
concerned about the ability of the mobile device
to handle the information.

Search results always
come from a server, so
you do not need to be
concerned about the ability of the mobile device
to handle the information.

Search results are
“chunked” and then collapsed so that they can
be displayed when a
search is performed.
This is usually okay on
PCs, but if you try to perform a search on a
mobile device, the results might be slow or
even crash because the
device cannot handle the
number of search results.

Advertisements

No advertisements
are included in search
results.

Users might see advertisements in search results.

No advertisements
are included in search
results.

Auto-Complete
Results

You can enable multiple options to include a
mix of personal and
global searches on your
output. There is also an
option to include project
content information
such as topic titles and
the file path in your project.

While Google Search
does provide auto-complete results, it does not
provide the ability to customize these results.

There are no options
available for auto-complete results.

Predictive
Search

There are multiple
options that allow you to
obtain predictive results
when searching, especially when using autocomplete options.

Google Search provides
a measure of predictive
results, although it is not
customizable within
Flare.

MadCap Search does
not offer any predictive
methods in obtaining
search results.
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NOTE: Google Search is not supported for HTML5 Tripane output.

NOTE: For MadCap Search, the look of the search bar and results can be customized
through these skins and components: Top Navigation skin, Side Navigation skin, Search Bar
skin component, and Search Results skin component. However, with Google Search, any
changes in these skins are not supported. Instead, the look is controlled via Google.

NOTE: Keep in mind that the exact steps in Google may change over time as the user interface is adjusted.
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Setting the Search Abstract Character Limit
Supported In:

In HTML5 output, you can set a character limit for automatically generated abstracts that appear in
your search results. This allows your users to see a brief summary of each topic in the search results, while keeping the search results page easy to scan. You can set the character limit as long or
as short as you like. When creating an automatic abstract, Flare scans all text elements in the topic,
including headings and paragraphs, and includes them in the abstract until the character limit is
met.
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HOW TO CHANGE THE ABSTRACT CHARACTER LIMIT IN SEARCH RESULTS
If you want change the abstract character limit, do the following.
1. Open an HTML5 target.
2. Select the Search tab.
3. Select MadCap Search in the Search Engine field.
4. In the Abstract Character Limit field, enter the number of characters you want to allow in the
topic's abstract. By default, the number of results per page is 300.
5. Click

to save your work.

NOTE: In order to use this field, you must be using MadCap Search. Elasticsearch uses a
similar field called Fragment character limit. This feature is not supported for Google
Search .

NOTE: Setting the abstract character limit to 0 will remove the abstract completely.

NOTE: If a word is too long and would push the abstract past its character limit, it is not
included in the abstract. Flare will not leave incomplete words at the end of the abstract.

NOTE: If you need to provide a longer or shorter search abstract, or if you do not like the
default text that appears in the abstract, you can manually enter a meta description for the
topic in the topic's Properties dialog.
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Enabling Micro Content in Search Results
If you intend to use micro content in your HTML5 output search results, you need to make sure it is
enabled in the target.

HOW TO ENABLE MICRO CONTENT
1. Open an HTML5 target.
2. Select the Search tab.
3. From the Search Engine section, make sure MadCap Search or Elasticsearch is selected.
4. Expand the Advanced Search Options section.
5. Select Include micro contents results.
6. Click
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Including Glossary Terms in Search Results
Supported In:

For HTML5 output, search results display glossary terms if they are used as the search text. In order
to use this feature, you must be using MadCap Search. This feature is not supported for Google
Search (see "Setting Up a Search Engine" on page 214).

CHAPTER 8

223

HOW TO INCLUDE GLOSSARY TERMS IN SEARCH RESULTS
1. Open an HTML5 target.
2. In the Target Editor, select the Search tab.
3. In the Search Engine field, make sure MadCap Search is selected.
4. Select Include Glossary Results to enable the feature.
5. Click

to save your work.

NOTE: In order for a glossary term to display in the search results, the end user's search
text must match the glossary term exactly, with no additional words (although it is not casesensitive). For example, in the example above, only the word "table" was included in the
search; therefore, the glossary term "Table" was displayed. But if we had searched for "table
topic," no glossary term would have been displayed in the search results.

NOTE: If you open a Side Navigation, Top Navigation, Tripane, or Search Results skin, you
will notice Search Glossary styles that let you control the look of this new feature (e.g.,
change the font color to make it stand out from the other search results). The Search Glossary Result style is used to control the entire area displaying the glossary search result. The
Search Glossary Term and Search Glossary Definition styles are used to control the look of
only the term and definition, respectively.
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Setting Search Result Importance
Supported In:

In HTML5 output, the Flare search engine uses a combination of factors to rank search results.
When you search, the search engine considers the number of links to a topic (Importance) as well
as the number of times a search term appears in a topic. This gives you the most accurate results.
You can choose to turn off Importance and search using only the number of search term hits in
each topic. This is not recommended unless you have one topic that is linked to so many times that
it would skew your search results. You must be using Elasticsearch or MadCap Search to use this
feature. It is not supported for Google Search.

HOW TO INCLUDE OR EXCLUDE IMPORTANCE IN SEARCH RESULTS
1. Open an HTML5 target.
2. Select the Search tab.
3. From the Search Engine section, make sure MadCap Search or Elasticsearch is selected.
4. Expand the Advanced Search Options section.
5. Select Include Importance.
6. Click
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EXAMPLE
Here is an example of a search with Importance turned on.
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Here is an example of a search in the same content with Importance turned off.
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Notice how the search results are different. This is because in the first example, with
Importance turned on, the search engine considers the number of links to that topic
when ranking the search results. In the second example, the results are ranked only
using the location of the search term in the topic (e.g., in a heading, in an index
keyword, in the body text).
If you want your users to be able to find a topic that you refer to—and link to—often in
your content, you should turn on the Importance setting so the topic appears higher in
the search rankings.

NOTE: Links that occur in a master page are not considered when calculating Importance.
For example, suppose you have a link in the master page footer that appears on every page
in your output. Because you can access the page it links to from every other page, it should
be the most important page in the output, but it is excluded from Importance rankings so it
does not skew results.
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Setting the Number of Search Results Per Page
Supported In:

You can change the number of search results that appear on each page. This makes it easier for
users to navigate between pages of search results and improves loading times, especially for users
who access your output from a mobile device. Setting a reasonable number of results per page also
makes it easier for search indexing services (i.e., spiders, crawlers, or bots) to locate pages in your
output, improving search results. In order to use this feature, you must be using MadCap Search.
This feature is not supported for Google Search (see "Setting Up a Search Engine" on page 214).
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HOW TO CHANGE THE NUMBER OF SEARCH RESULTS PER PAGE
1. Open an HTML5 target.
2. Select the Search tab.
3. From the Search Engine section, make sure either MadCap Search or Elasticsearch is selected.
4. In the Results Per Page field, use the arrows to set the number of results you want to display
on each page. By default, the number of results per page is 20 for MadCapSearch and 100 for
Elasticsearch.
5. Click
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Generating Sitemaps for SEO
Supported In:

For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEO), making it easier for search indexing services (i.e., spiders, crawlers, or bots) to find your output. Therefore, the entire output is indexed and search engine results
are improved.

HOW TO GENERATE A SITEMAP FOR SEARCH ENGINE OPTIMIZATION
1. Open a web-based target.
2. On the Search tab of the Target Editor, select Generate Sitemap.
3. In the Web URL field enter the path where the output is ultimately published. For example,
https://help.madcapsoftware.com/flare2019/.
NOTE: Be sure to include the full path—including "http://"—when entering the web
URL.

4. Click

to save your work.

NOTE: If you are generating HTML5 output, you can also set up your search engine—
MadCap Search, Google Search, or Elasticsearch (for Top Navigation, Side Navigation, or
skinless outputs). See "Setting Up a Search Engine" on page 214.
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Associating Skins with Targets
Supported In:

After you add a skin to your project and edit the settings, you can associate it with a target. After
you build the target, the output will be displayed in the skin. For HTML5 targets, you can also tell
Flare not to use any skin at all.

HOW TO ASSOCIATE A SKIN WITH A TARGET
1. Open the target from the Project Organizer.
2. Do one of the following, depending on the type of output:
n

HTML5 Select the Skin tab.

n

Others Select the General tab.

3. Click the drop-down arrow in the Skin field and select the skin that you want to associate with
the target.
If you have opened an HTML5 target and do not want to use a full skin at all, you can instead
select none. If you do this, you might want to insert various kinds of proxies and use related
skin components in order to provide navigation for your users.
4. Click

to save your work.

NOTE: If you are producing HTML5 output, you can also associate skin components with a
target, although it is more common to associate them with proxies.
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Adding Favicons
Supported In:

Short for “favorite icons,” favicons are supported in Flare for HTML5 output. A favicon is the image
that you sometimes see in a browser tab, address bar, bookmark, Windows tiles, etc.
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They can also be used on smart phones when a website is saved to the home screen.

There are several places in the output where a favicon image might display. Therefore, it is common to use different sizes of an image to satisfy each instance appropriately (e.g., small image
used for bookmark but larger image used for Windows tile). Fortunately, Flare makes this easier by
letting you select a large master favicon image; this image is then automatically resized for most of
the different uses in the output.
To use custom favicons, you first need to add a new “Favicons” skin component to your project.
Within this skin component, you can choose your image and other settings. The Favicons skin component is slightly different from the other kinds of skin components that can be added to a project in
that it does not require a corresponding proxy. Instead, you simply create and edit the Favicons skin
component and it will automatically be integrated with your HTML5 output.
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HOW TO ADD A FAVICONS SKIN COMPONENT TO A PROJECT
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Content section select New > Skin.

n

Right-Click In the Project Organizer, right-click on the Skins folder and from the context
menu select Add Skin.

The Add File dialog opens.
2. In the File Type field at the top, make sure Skin is selected.
3. In the Source area select New from template.
4. Under Factory Templates, select HTML5 Component - Favicons.

CHAPTER 8

237

5. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click
and select the subfolder. Otherwise,
keep the default location.
6. In the File Name field, type a new name for the skin component.
7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
and select the conditions you
want to apply. Click OK.
8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click
and select the file tags you want to apply. Click OK.
9. Click Add. The skin component is added to the Skins folder in the Project Organizer. The
Favicon Skin Editor opens to the right. Continue with the steps for editing the skin component.
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HOW TO EDIT A FAVICONS SKIN COMPONENT
1. Open your skin component (if it is not already open).
and select an image—PNG, JPG, or GIF. (ICO files cannot
2. In the Master Favicon field, click
be selected for the master favicon, but you can select an ICO file to override the master
favicon in certain fields below.)
TIP: For best results, select a square image that is 558 pixels or larger. If you select a
smaller image, it might not be automatically generated for some of the favicon uses
shown in the Options sections of the Favicon Skin Editor.
In the sections below, you can see the image has been added to the previews.
n
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Browser This shows how the image will be shown when viewed in a standard web
browser. The preview shows the image on a tab, but the image will appear in other
places as well, such as next to bookmarked pages.
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n

iOS/Android This shows how the image will be shown on iPhone and Android smart
phone screens when a user adds a web page from your output to the home screen.

n

Windows This shows how the image will be shown in the tile format used in Windows 8
and Windows 10.
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3. (Optional) Under the Browser, iOS/Android, and Windows sections, click Options.
Various fields are shown under each section. Notice that, depending on the size of the image
that you added as the master favicon, “(generated)” is shown in many of the fields. This
means that the master favicon image will be used for each of these fields and auto-sized as
necessary.
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NOTE: If you see a warning icon
next to a field, this means the master favicon
was not auto-generated for that field. Hover over the warning icon to see the reason.
You can then either select a master favicon of a different size, or you can select a different image for the field where the warning icon appears.
to override the master favicon image for
4. (Optional) In the Browser section, you can click
any of the fields, although most users will likely keep the generated image. The different sizes
shown (16, 32, and 96 pixels) are necessary to be compatible with various types and versions
of browsers on the market.
to override the master favicon image
5. (Optional) In the iOS/Android section, you can click
with a different icon image (180 pixels). This will be shown when a user adds a shortcut to
your output on the home screen.
NOTE: If you add an image that has a transparent background, iOS devices will
replace the transparency with a black background. Also, images on iOS devices will
have rounded borders. So keep this in mind when designing and choosing an image.
next to the Small, Medium, Wide, or Large
6. (Optional) In the Windows section, you can click
fields to choose a different image for the tile design in Windows 8 and Windows 10.
The Wide field will typically never be auto-generated from the master favicon, so you will need
to choose a different image in this field if you want to provide a picture for that type of tile.
That’s because the master favicon is square, whereas the Wide field requires a rectangular
image. The recommended size is 558 pixels wide by 270 pixels high.
NOTE: Windows 8 acts somewhat differently than Windows 10 in the way tiles are
shown in the interface.
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EXAMPLE
Let’s say you are using Windows 10 and you open HTML5 output in a Microsoft
Edge browser. You then open the options menu from the upper-right corner of
the browser and select Pin this page to Start.
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When you click the Start button in the lower-left corner of your screen, you see
tiles for different kinds of shortcuts. If you scroll down to the bottom of the tiles,
you will see the favicon for the HTML5 output that you pinned. Initially, you will
see the medium-sized image.
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Next, you right-click this favicon and select Resize. From the menu, you can
choose any of the other sizes (Small, Wide, Large).
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If you select Small, the favicon will look something like this:
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If you select Wide, the favicon will look something like this:

And if you select Large, the favicon will look something like this:
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7. In the Web URL field, enter the path where your output will be published (e.g., http://mycompany.com/help/product/). Completing this field is necessary because Windows tile
images are relative to the root location of your output. You can also click
able into the URL field.
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8. (Optional) In the Tile Color field, you can use the drop-down to the right to choose a background color for the tile displaying your favicon.

9. Click

to save your work.

NOTE: Microsoft Edge and Internet Explorer do not support favicons unless the output is
published to a web server.

NOTE: If you generate the target from a MadCap Central license, any custom favicons that
you have set will be overridden by the Central favicons.
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Setting All Skins to be Generated
Supported In:

An option on the Advanced tab of the Target Editor controls whether every skin in the project or just
the selected skin in the target (which is set on the Skin tab for HTML5 targets and the General tab
for other targets) will be generated for the output. This option is enabled by default.
One reason to enable this option is if you need the ability to make context-sensitive Help (CSH) calls
to different skins. In this case, each of those skins must be generated so that they are available in
the output for the CSH calls. If you are not using multiple skins for CSH calls, you might want to disable this option. If you disable it, the size of the entire output will be minimized because unnecessary skins will be excluded.
Another reason to enable this option is to use runtime skins for HTML5 outputs, where end users are
able to choose the skin to display the output.
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HOW TO SET ALL SKINS TO BE GENERATED
1. Open a target used for online output.
2. On the Advanced tab of the Target Editor, select Generate all skins so that it has a check
mark.

3. Click
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Getting the Latest Version
After you bind a Flare project to a source control application, you can get the latest version of any of
the source control files. When you do this, you are copying the most current files stored in the
source control application to your local Flare project without necessarily checking out the files. This
means that the "Read Only" designation will remain associated with the files until you check them
out.
Following are steps for getting the latest version of all files in a project automatically, as well as
steps for getting the latest version of files manually.

Automatic Get
You might use this option if you are working with a team of authors and want to make sure that you
include the latest changes from other writers in the output (without having to manually get those
files).
With this option:
n

You will not be prompted before the "get" is performed.

n

Flare will not get the latest copy of the files in the Targets folder, because that would conflict
with the generation of the output.

n

Conflicts with files will not cause local files to be overwritten. Therefore, if your local files are
writable or already checked out, those files will be kept, rather than overwritten with the source
control files.

HOW TO GET THE LATEST VERSION OF SOURCE CONTROL FILES AUTOMATICALLY
1. Open the target.
2. In the Target Editor, select the General tab.
3. Select the check box labeled Automatically get latest version of all files before generating the
target.
4. Click

to save your work.

5. Build the target.

NOTE: The "automatic get" feature is not supported if you are building output using the
command line, as opposed to the Flare interface.
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Manual Get
You can manually get the latest version of all of the files in the Flare project or specific files only.

HOW TO GET THE LATEST VERSION OF SOURCE CONTROL FILES MANUALLY
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Source Control ribbon. In the File section select Get Latest Version (for
selected files). Alternatively, in the Project section you can click Get Latest Version All
(for all files in the project).

n

Right-Click If you have the Content Explorer, Project Organizer, Pending Changes window
pane, or File List open, right-click the file you want to get and select Source Control > Get
Latest Version.

n

Source Control Explorer With the Pending Changes pane open, right-click the file you
want to update and select Get Latest Version.

2. If the local and server files are the same, a message tells you so. Click OK.
If the local file is different from the file on the server, the Resolve Conflicts dialog opens. If you
want to accept all of the differences between the local and server files, thus merging them,
click Auto Merge All. If you want to review the differences in the files side by side and resolve
each conflict, click Resolve.

NOTE: By default, when you open a project that is bound to source control, a message automatically asks if you want to get the latest version of files. However, you can disable this
prompt in the Options dialog (File > Options).

NOTE: If you update your read-only files with read-only files and you do not perform a check
out, the files will appear to be submitted without actually updating the server-side version.
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Specifying the Startup Topic in a Target
Supported In:

You can specify which topic is the first one that users see when they open the online output. If you
have written a welcome or introduction topic, you will likely want this to be the "startup" topic displayed in your output.

HOW TO SPECIFY THE STARTUP TOPIC IN A TARGET
1. Open the target.
2. On the General tab of the Target Editor, click the browse button
field.

next to the Startup Topic

3. In the Link to Topic dialog, find and double-click the appropriate topic.
4. Click
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Associating Master Stylesheets with All
Files
When you want to use styles in your content, the stylesheet needs to be made available for the content in question. In Flare, you can associate regular stylesheets with individual files. However, you
also have the option of using a regular stylesheet as a "master," applying it at either the project or target level, or both.
n

Master Stylesheets at the Project Level You can associate a master stylesheet with an entire
Flare project. The styles will therefore be available to all content in the project. You can set
the project-level master stylesheet in the Project Properties dialog (select Project > Project
Properties).

n

Master Stylesheets at the Target Level You can associate a master stylesheet with an entire
Flare target. The styles will therefore be used for the content in the target. If you have specified a master stylesheet at the project level and another at a target level, the stylesheet at
the target level will take precedence. If you are using different master stylesheets for different targets, the stylesheet associated with the primary target determines what you see in
the XML Editor. You can set the target-level master stylesheet on the General tab of the Target Editor.
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HOW TO ASSOCIATE A MASTER STYLESHEET WITH A PROJECT
1. Select the Project ribbon. In the Properties section select Project Properties. The Project
Properties dialog opens.
2. Select the Defaults tab.
3. In the Master Stylesheet field, click the drop-down and select the stylesheet to be used as the
master.
4. (Optional) If you have one or more additional stylesheets in your project and you want to be
able to associate them locally with content files, select Allow local stylesheets.
5. Click OK.

HOW TO ASSOCIATE A MASTER STYLESHEET WITH A TARGET
1. From the Project Organizer open the target.
2. Select the General tab.
3. In the Master Stylesheet field, click the drop-down and select the stylesheet to be used as the
master.
4. (Optional) If you have one or more additional stylesheets in your project and you want to be
able to associate them locally with content files, select Allow local stylesheets.
5. Click
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Associating a Medium with a Target
Supported In:

After you decide on a medium for an output, you need to associate it with the target. After you build
the target, the medium will be used to display the correct style settings in the output.

HOW TO ASSOCIATE A MEDIUM WITH A TARGET
1. From the Project Organizer, open the target.
2. In the Target Editor, select the Advanced tab.
3. Click the drop-down arrow in the Medium field, and select the medium that you want to associate with the target.
NOTE: Only mediums can be selected. Media queries are not available from this field.

4. Click

to save your work.

NOTE: When you create a print-based target (Adobe PDF, Microsoft Word), the print
medium is automatically associated with that target (on the Advanced tab of the Target
Editor). However, you can always select a different medium if you want.
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Converting Stylesheet Styles to Inline
Supported In:

For Clean XHTML targets, you have the option to keep your stylesheet styles or to convert them to
inline styles.

HOW TO CONVERT STYLESHEET STYLES TO INLINE
1. Open a Clean XHTML target.
2. On the General tab of the Target Editor, select Convert stylehseet styles to inline styles.
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If you choose this option, the output folder will not include stylesheet files. That’s because the
styles have been integrated into the topic files.
If Option Is Not Selected

If Option Is Selected

Output Content/Resources Folder:

Output Content/Resources Folder:

Topic Markup:

Topic Markup:

3. Click
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Associating a Master TOC with a Target
In most situations, you will have one TOC that you use for a particular output (target). In that case,
you simply associate the appropriate TOC with the target. If you have multiple TOCs that you want
to include in the same project or output target, the TOC that you associate with the project or target
serves as the "master" TOC. In your master TOC, you have the option of creating links to the other
TOC that you want to include in the output. If you do not select a TOC, Flare will use the first one in
the project (if there is more than one). If you have specified a master TOC at the project level and
another at a target level, the TOC at the target will take precedence.

HOW TO ASSOCIATE A MASTER TOC WITH A TARGET
1. Open the target from the Project Organizer.
2. On the General tab in the Target Editor, click the drop-down arrow in the Master TOC field, and
select the TOC that you want to associate with the target.
3. Click
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Using the TOC Depth for Heading Levels in
Print Output
When creating print output, you can determine which topic headings will be displayed at which level
in the generated TOC. For example, even though all of your topics may use a heading style of h1,
you might want some of those topic headings to display at the first level in the print TOC (acting as
an h1), others at the second level (acting as an h2), and still others at the third level (acting as an
h3).
You can base the heading levels on the structure you create in the outline TOC. If a TOC entry is at
the extreme left of the TOC Editor, it will display at the first level of the print TOC; if an entry is indented to the right one level, it will display at the second level; and so on. Not only will those headings be
reflected in the generated TOC in the output, but the corresponding headings will be converted in
the main body too (e.g., if a heading becomes an h2 in the TOC, it will become an h2 in the text as
well).

HOW TO USE TOC DEPTH FOR HEADING LEVELS
1. Open the target.
2. In the Target Editor, select the Advanced tab.
3. In the Generated TOC section, select Use TOC depth for heading levels.
4. Click

to save your work.

EXAMPLE
Let's say the first paragraph in each topic that you create uses the h1 style (except
your title page and print TOC topic), and you structure the outline TOC like this:
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If you do not use the depth feature, the print TOC will look like this in the output:

But if you turn this feature on, the result will instead look like this in the output:

Notice that "NewTopic3" is indented to the third level in the print TOC (because that is
its position in the outline TOC). The other topics are at the second level. The books
("Chapter 1" and "Chapter 2") are at the first level, but they are not linked to topics;
therefore, they are not included in the output. If you want the unlinked books to be
included in the output, you can create headings for them (see the online Help for
steps).

NOTE: If you create books in the outline TOC (whether they are linked to topics or not), they
will affect the heading level in the print TOC. If you want unlinked books to be converted to
headings in the output (both in the print TOC and in the main body), you can do so. See
"Creating Headings for Unlinked Books in a Generated TOC" on page 264.
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NOTE: What happens if you are using classes of heading styles and then select the "Use
TOC depth for heading levels option"? For example, let's say you have classes of your h1 and
h2 heading styles. Suppose you created h1.Special (with a blue font), and h2.Special (with a
red font). Meanwhile the primary h1 and h2 styles both use a black font. In your topics,
you've applied your heading style classes to some heading content. And in your outline TOC,
you organized the structure like this:

Because you selected the option to use TOC depth for heading levels, some of the level-1
headings will become level-2 headings or even level-3 headings in the output. If you have
headings where you used h1.Special but their level in the output was not affected (i.e., they
remain as level-1 headings), they will keep the properties from the style class. In other
words, they will stay blue. But if the structure of the outline TOC causes them to become
level-2 headings in the output, they will take on the properties of the h2.Special tag—
because the class has the same name ("Special") as its h1 counterpart. Therefore, those
headings will have a red font. However, let's say that your level-2 class was named something different (e.g., h2.Red). In that case, h1.Special headings that are pushed to become
level-2 headings will instead use properties from the main h2 style. In other words, they will
have a black font—not blue like h1.Special and not red like h2.Red.
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Creating Headings for Unlinked Books in a
Generated TOC
Supported In:

When creating print output, you can determine which topic headings will be displayed at which level
in the generated TOC. For example, even though all of your topics may use a heading style of h1,
you might want some of those topic headings to display at the first level in the print TOC (acting as
an h1), others at the second level (acting as an h2), and still others at the third level (acting as an
h3).
You can base the heading levels on the structure you create in the outline TOC. If a TOC entry is at
the extreme left of the TOC Editor, it will display at the first level of the print TOC; if an entry is indented to the right one level, it will display at the second level; and so on. Not only will those headings be
reflected in the generated TOC in the output, but the corresponding headings will be converted in
the main body too (e.g., if a heading becomes an h2 in the TOC, it will become an h2 in the text as
well). See "Using the TOC Depth for Heading Levels in Print Output" on page 261.
If you create books in the outline TOC (whether they are linked to topics or not), they will affect the
heading level in the print TOC. If you want unlinked books to be converted to headings in the output
(both in the print TOC and in the main body), you can do so.

HOW TO CREATE HEADINGS FOR UNLINKED BOOKS IN A GENERATED TOC
1. Open the target.
2. In the Target Editor, select the Advanced tab.
3. In the Generated TOC section, select Inject headings for unlinked books in TOC.
4. Click
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EXAMPLE
Let's say the first paragraph in each topic that you create uses the h1 style (except
your title page and print TOC topic), and you structure the outline TOC like this:

If you use the TOC depth feature, the print TOC will look like this in the output:

Notice that "NewTopic3" is indented to the third level in the print TOC (because that is
its position in the outline TOC). The other topics are at the second level. The books
("Chapter 1" and "Chapter 2") are at the first level, but they are not linked to topics;
therefore, they are not included in the output.
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If you use the feature to include the unlinked books, the print TOC will look like this in
the output:
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Removing Images from Headings in a
Generated TOC
Supported In:

If you have inserted images into the headings in your topics, you can make sure those images do not
appear in the generated TOC of the printed output.
This option works somewhat differently depending on the output type.

WORD
n

If the option is disabled, images appear in both content headings and the print TOC.

n

If the option is enabled, images are removed from both content headings and the print TOC.

PDF
n

If the option is disabled, images appear in content headings only.

n

If the option is enabled, images are removed completely.

HOW TO REMOVE IMAGES FROM HEADINGS IN A GENERATED TOC
1. Open the target.
2. In the Target Editor, select the Advanced tab.
3. In the Generated TOC section, select Remove images from paragraphs with heading levels.
4. Click
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NOTE: Keep in mind that, with this feature, the images are also removed from the heading
in the content of the document. Therefore, if you want to have the images in the content,
but not in the print TOC, you should not use this feature. Instead, you must remove the
images from the print TOC manually after generation (if you compile an editable output,
such as Word).
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Overriding Variable Definitions in Targets
The variables that you create and define in the Variable Set Editor are available to your entire project. However, if you want the definition for a variable to be different in a particular target, you can
override the project-level definition for that target in the Target Editor.

HOW TO OVERRIDE A VARIABLE DEFINITION IN A TARGET
1. Open the Project Organizer.
2. Double-click the Targets folder. The available targets are shown.
3. Double-click the target for which you want to override a variable definition. The Target Editor
opens to the right, with tabs that you can use to customize that specific target.
4. Click the Variables tab. The Variables tab shows all of the variable sets in your project and
their associated variables.
5. Select the appropriate variable set.
6. Do one of the following, depending on whether the variable has only one or multiple definitions
in the Variable Set Editor. For information on adding multiple definitions, see the online Help.
n

Single Definition Click in the Definition cell for the variable that you want to override and
press F2 on your keyboard. Then type a different definition and press Enter on your keyboard.

n

Multiple Definitions In the Definition cell, click the down arrow and select an alternative
definition.
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to save your work. The alternative variable definition will be used in the output for this
7. Click
target. However, for other targets in your project, the original variable definition will be used.

EXAMPLES—DIFFERENT TYPES OF VARIABLE DEFINITIONS
Use the examples below to help you determine which type of variable definition you
should use.
n
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n

Target-Level Variable Definitions Used when generating output for specific targets. Overrides the project-level variable definition, but only for the defined target. For example, if you use a company name variable in your documents, you
may want to change it to say "ABC Corporation" in one document and
"XYZ Company" in another.

n

Topic-Level Variable Definitions Used to change a variable definition in a single
topic. Applies only to variables in snippets, and overrides project-level and targetlevel variable definitions. For example, if you use a phone number variable
throughout your project, but a handful of topics are about a different location
(and therefore use a different phone number), you can set a different variable
definition that applies only to those topics.
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n

Snippet-Level Variable Definitions Used to change a variable definition in a single
snippet. Applies only to variables in snippets, and overrides project- and targetlevel variable definitions, as well as topic-level snippet variable definitions. For
example, if you use a product name variable throughout your project but a few
snippets refer to a different product, you can set a different variable definition
that applies only to those snippets.

NOTE: If you preview a topic, the variable definition associated with the primary target is
displayed.

NOTE: If you click the Edit Set button at the bottom of the tab, the Variable Set Editor
opens. When you use that editor, you are editing variables for all targets, not those for a specific target or snippet.
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Overriding Variable Definitions in Snippets
The variables that you create and define in the Variable Set Editor are available to your entire project. However, if you want the definition for a variable to be different for one or more snippets in a
topic, you can override the topic- or snippet-level definition of the variable.

HOW TO OVERRIDE A SNIPPET VARIABLE DEFINITION IN A TOPIC
Use this option if you want to change the definition of all of the variables that appear in snippets in a
single topic. Topic-level snippet variable definitions take priority over your original variable definitions or target-level variable definitions.
1. Open the Content Explorer.
2. Locate the topic in which you want to override a variable definition.
3. In the local toolbar, click

. The Properties dialog for the topic opens.

4. Click the Snippet Variables tab. The Snippet Variables tab shows all of the variable sets in your
project and their associated variables.
5. Select the appropriate variable set.
6. Do one of the following, depending on whether the variable has only one or multiple definitions
in the Variable Set Editor. For information on adding multiple definitions, see the online Help.
n

Single Definition Click in the Definition cell for the variable that you want to override and
press F2 on your keyboard. Then type a different definition and press Enter on your keyboard.

n

Multiple Definitions In the Definition cell, click the down arrow and select an alternative
definition.

7. Click OK.
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to save your work. The alternative variable definition will be used for all instances of
8. Click
the variable that appear in snippets in this topic. However, if the variable appears elsewhere in
the topic (i.e., not in a snippet), or in other topics in the project, the original variable definition
(or the target-level variable definition, if applicable) will be used.
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HOW TO OVERRIDE A SNIPPET VARIABLE DEFINITION IN A SNIPPET
Use this option if you want to change the definition of a variable within a specific snippet. Snippetlevel snippet variable definitions take priority over topic-level snippet variable definitions.
1. Open the Content Explorer.
2. Locate the topic in which you want to override a variable definition.
3. In the topic, right-click the instance of the snippet in which you want to override the variable
definition and select Snippet Variables from the context menu.
The Snippet Variables dialog opens. The Snippet Variables dialog shows all of the variable
sets in your project and their associated variables.
4. Select the appropriate variable set.
5. Do one of the following, depending on whether the variable has only one or multiple definitions
in the Variable Set Editor. For information on adding multiple definitions, see the online Help.
n

Single Definition Click in the Definition cell for the variable that you want to override and
press F2 on your keyboard. Then type a different definition and press Enter on your keyboard.

n

Multiple Definitions In the Definition cell, click the down arrow and select an alternative
definition.

6. Click OK.
to save your work. The alternative variable definition will be used for all instances of
7. Click
the variable that appear in the selected snippet. However, if the variable appears elsewhere in
the topic (i.e., in other snippets or outside of snippets) or in other topics, the topic-level snippet variable definition, the target-level variable definition (if applicable), or the original variable
definition will be used.
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EXAMPLES—DIFFERENT TYPES OF VARIABLE DEFINITIONS
Use the examples below to help you determine which type of variable definition you
should use.
n
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n

Target-Level Variable Definitions Used when generating output for specific targets. Overrides the project-level variable definition, but only for the defined target. For example, if you use a company name variable in your documents, you
may want to change it to say "ABC Corporation" in one document and
"XYZ Company" in another.

n

Topic-Level Variable Definitions Used to change a variable definition in a single
topic. Applies only to variables in snippets, and overrides project-level and targetlevel variable definitions. For example, if you use a phone number variable
throughout your project, but a handful of topics are about a different location
(and therefore use a different phone number), you can set a different variable
definition that applies only to those topics.
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n

Snippet-Level Variable Definitions Used to change a variable definition in a single
snippet. Applies only to variables in snippets, and overrides project- and targetlevel variable definitions, as well as topic-level snippet variable definitions. For
example, if you use a product name variable throughout your project but a few
snippets refer to a different product, you can set a different variable definition
that applies only to those snippets.

NOTE: If you click the Edit Set button at the bottom of the tab, the Variable Set Editor
opens. When you use that editor, you are editing all variables, not those for a specific snippet or target.
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Setting Up a WebHelp Plus Target
The following steps show you how to set up your WebHelp Plus target for server-based output.

HOW TO SET UP THE WEBHELP PLUS TARGET
1. In Flare, open the WebHelp Plus target.The Target Editor opens.
2. Select the Publishing tab.
3. In the Indexing Service Catalog Name field, type the catalog that you are using for the output.
In most cases, this will be Web, which is the default value. However, if you or someone in your
company (e.g., network administrator) creates a custom catalog, you need to enter that
name in the field.

What is a catalog? Microsoft Indexing Service stores all of its index information in catalogs. A
catalog comprises index information and stored properties for a particular group of file system directories. If Internet Information Services (IIS) is installed, the Indexing Service also creates a web catalog, which contains an index of IIS, the default virtual server of the World Wide
Web.
NOTE: This step is necessary only for Windows Server 2003.

4. Click

to save your work.

5. Generate the target.
6. Publish the output to any location on the web server. If you want to use the default location
that was created after you installed IIS, you can publish the output to C:\Inetpub\wwwroot. If
you do this, you can use the "Default Web Site" folder that you will encounter when performing
the next set of steps (i.e., configuring IIS on the production server).
If you are working on your local machine for testing purposes, you do not need to publish the
output. You can simply view your WebHelp Plus output. When you view WebHelp Plus output
on your local computer, Flare creates a special folder called "MCPreview" within your "C:\Inetpub\wwwroot" folder, and it places a copy of your WebHelp Plus output files in it. This enables
you to test the advanced features of WebHelp Plus on your local machine.
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The following steps show you how to enable WebHelp Plus search. These steps must be done for
each catalog that you are using on the server (or on your local machine, if you are viewing WebHelp
Plus output on your computer for testing purposes).
1. Navigate to the output folder for the WebHelp PlusHTML5 target on the server or on your local
machine.
If you are enabling WebHelp PlusHTML5 on your local machine, you can quickly find the output folder by doing the following.
a. Open the Project Organizer.
b. Double-click the Targets folder.
c. Right-click on the target and select Open Output Folder.
2. In the output folder, double-click the Service folder.
3. Double-click the folder labeled Console.ConfigureSearch.
4. Double-click ConfigureSearch.exe. A window appears very briefly and then disappears.
5. Create a folder called "AutoMergeCache" at the root of the site. Then you must set security
preferences on the AutoMergeCache folder so the application can create and update files.
a. Right-click on the root folder and choose Explore to open Windows Explorer.
b. Right-click on AutoMergeCache and choose Properties.
c. On the Security tab click the Edit button.
d. Click Add.
i. Type Everyone and click Check Names, making sure it gets underlined.
ii. Click OK.
e. Make sure Everyone is highlighted and check the option for Full Control.
f. Click Apply.
g. Click OK to exit the Permission dialog.
h. Click OK to exit the Properties dialog.
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Enabling Mirror Margins in Word Output
Let’s say you create a page layout with mirror margins on pages (e.g., the odd pages are set up to
have a left margin of 2 inches and a right margin of 1 inch, whereas the even pages are set up to
have a left margin of 1 inch and a right margin of 2 inches). In such a case, Microsoft Word is unable
to display the correct margins without a little help. Therefore, you need to enable mirror margins by
selecting a single check box in the Target Editor. When you generate Word output, you will then see
the appropriate margins on each page.

HOW TO ENABLE MIRROR MARGINS IN WORD OUTPUT
1. Open the target being used for Word output.
2. Select the Advanced tab.
3. Click the check box next to Generate "Mirror Margins" for MS Word Output.
4. Click
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Ignoring Warnings When Building Output
Supported In:

You can tell Flare to ignore certain warnings so that they do not display as such in the Builds window
pane when generating output. This can be done globally for all targets in all projects. You can also
override those global settings for a specific target in a project.
By default, Flare will use the global settings that are specified in the Options dialog. So if you want all
of your projects and targets to have the same settings for ignoring warnings, it's best to just use the
Options dialog. However, if you want the settings to be unique for a particular target, you can override the global settings by using the Target Editor.

HOW TO IGNORE WARNINGS GLOBALLY
1. Select File > Options.
The Options dialog opens.
2. Select the Build tab.
3. In the Warnings section of the tab, you can remove check marks next to any warning that you
want Flare to ignore. By default, all check boxes are initially selected.

CHAPTER 8

282

If you want to return to the default settings where all of the check boxes are selected, you can
click Reset Warnings at the bottom of the tab.
4. Click OK.
If you are building targets, the Ignored Warnings column in the Builds window pane indicates how
many warnings were ignored during the build.
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HOW TO IGNORE WARNINGS FOR A TARGET
1. Open a target.
2. Select the Warnings tab.
3. Click Use target build warnings instead of global settings. This enables the area below with all
of the check boxes.
4. You can remove check marks next to any warning that you want Flare to ignore for that target. By default, all check boxes are initially selected.

5. Click
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SEARCH BY ID
Each type of warning has a numerical ID to the left of it. You can use the search field to quickly jump
to a particular warning.

WARNING: It is recommended that you be careful with which compiler warnings you
choose to ignore. Only ignore warnings that you are certain you do not need to receive.
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NOTE: You can only ignore warnings; you cannot ignore errors, which prevent output from
being generated.

NOTE: If you open a target that contains old accessibility warning settings from previous
versions of Flare, that target file will become "dirty" (i.e., an asterisk is shown next to the file
name in the Target Editor) and you will see a message indicating that Flare is updating the
file to use the new report warning system. You can then simply save the target file with the
new settings. This does not affect your target in any other way.

CHAPTER 8

286

Preventing External URLs
Supported In:

In Flare's web targets, you can prevent people from loading an external website in the topic pane by
appending a foreign URL at the end of your output's URL. You might use this feature to prevent
someone from appending a malicious website to the end of your normal URL.

This option does not prevent external links that are inserted in a topic from opening (e.g., a hyperlink
on some text that is pointing to http://madcapsoftware.com will still open that website). Those
types of links point directly to the external URL and will not append to your Help system's URL.
However, this option does prevent external websites from being loaded from the table of contents
(TOC) or a browse sequence. For example, if you have a TOC node that points to www.madcapsoftware.com, it will not load with this option enabled since that node creates a hash tag followed by the linked URL (e.g., Path/To/HTML5/Default.htm#http://www.madcapsoftware.com). If
such a link exists on a TOC or browse sequence node, it will simply open the starting topic in your
output when clicked. Therefore, if you want to use the option to prevent external URLs, you should
also avoid putting external links on TOC or browse sequence entries.
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HOW TO PREVENT EXTERNAL URLS
1. Open a target.
2. On the Advanced tab of the Target Editor, select Prevent external URLs from frames.

3. Click
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CHAPTER 9

Building and Publishing Output
After you have created a project, added and formatted content, and developed a target, you are
ready to build and publish the final output. Of course, you can build the output at any point during the
development process, but if you make additional changes to content, targets, or the look and feel,
you will need to build the output again to make sure the changes are included in the files that you
deliver to your end users.
This chapter discusses the following:
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Ways to Build and Publish Targets
Building the final output involves generating one or more targets in your project, usually with just the
click of a button or two. You can build output in the following ways:
n

Primary Target Do this if you are only concerned about building and publishing the primary target for your project. See "Building and Publishing the Primary Target" on page 316.

n

Single Target Do this if you want to build and publish a target that may or may not be designated as your primary target. See "Building and Publishing a Single Target" on page 318.

n

Multiple Targets Do this if you want to quickly build and publish multiple targets using an
option in the Builds window pane. The targets do not need to be within the project that you currently have open. This is an alternative to using batch targets. See "Building and Publishing
Multiple Targets" on page 319.

n

Batch Target Do this if you want to build and publish one or multiple targets in a batch file, perhaps scheduled to run at a specific time. See "Building Output Using a Batch Target" on page
320.
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Interface or Command Line
You can build and publish output (primary, single, multiple, or batch targets) using either the Flare
interface or your system's command line. There are benefits to using each method.

User Interface
This method lets you build output using options in Flare's workspace. When you generate a target
using this method, the Builds window pane opens at the bottom of the workspace. You can continue
working in your project while targets are generated behind the scenes.
Following are some of the important aspects of this method:

MAXIMUM CONCURRENT BUILDS
On the Build tab of the Options dialog (File > Options), you can limit the number of targets that can
be generated at the same time. This can be done by changing the number in the Maximum Concurrent Builds field. If you are concerned about Flare slowing down during builds, you may want to
make sure this number is not too high.
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EXAMPLE
Let's say you have three targets in your project and you have the Maximum Concurrent Builds field set at 2.
You generate Target 1, and then shortly after, you also generate Target 2. These targets compile simultaneously.
Then you tell Flare to generate Target 3. But because your maximum number is 2, Target 3 is queued for the moment.
Let's say Target 2 finishes building. At that point, Target 3 begins its build process
while Target 1 also continues its generation.

BUILDS WINDOW PANE
When you generate a target from Flare's user interface, the Builds window pane opens at the bottom of the interface.

You can also open the Builds window pane manually by selecting View > Builds or Project > Builds.
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CHARACTERISTICS OF BUILDS WINDOW PANE
Following are some important characteristics of the Builds window pane:
n

Rows in the Grid Each row in the grid represents a target for which you have initiated a build.
By default the top row is the most recent build.

n

Status/State The Status and State columns in the grid may display any of the following,
depending on the progress of the target build: Running (Building), Finished (Build Complete/Build Failed), Queued, or Terminated (Cancelled).
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n

Warnings and Errors The last three columns display the number of warnings and errors for
the target. You can open the build log to see details for the warnings or errors. In addition, if
you have set Flare to ignore certain warnings—in the Options dialog (File > Options) or Target
Editor—that number is also given.
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n

Background Colors The Progress cells display colored backgrounds, depending on what happens with the build. When a build is in progress, the background is light green. If the build finishes with no errors (although there may be warnings), the background turns dark green. If
an error prevents the build from finishing, the background is red. If you manually stop the
build, the background is yellow.

Following are descriptions of the three progress columns:
l

l

l

n

Build Progress This column indicates the progress of the entire build for a target.
Compile Progress This column indicates the progress of individual parts of a target's
build.
Publish Progress This column indicates the progress of a target that is being published
to a destination you have set up.

Compile Status As a target is generated, the contents of the Compile Status column change
rapidly (e.g., showing the files being processed).
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n

Warning for Changed Files Because this feature allows you to continue working while targets are generated, it's possible that you might change a file that is included in a target while
it is still compiling. If that happens, the target continues to build without those changes, but
you will see a warning in the build log to let you know.

If this happens, will your changes make it into the output? That depends on the file(s) that
you changed. Flare processes your source files in the order that it finds them. So if the generation process already passed the point where it would have grabbed a particular source
file, your changes from that file will not make it into the output. However, if Flare's build process has not yet reach the file in question, then the changes might make it into the output.
You can refer to the warnings you receive in the build log and then look at the files in the output to see if your changes made it.

CHAPTER 9

296

n

Build Logs Anytime you build a target, a build log is automatically created. By default it is
stored at the root level of the output folder for that target (e.g., <project>\Output\<user
name>\<target name>). However, in the Options dialog (File > Options) you can choose
where your log file will be stored when you build a target. As an alternative to the default location, you can choose to place it in the Reports folder of the Project Organizer, or you can
select a custom location.

CHAPTER 9

297

A build log file has an .mclog file extension. The next time you generate the target, the old
log file is replaced with a new one.

In the local toolbar of the Builds window pane, you can click Open Build Log to see it in Flare.
You can then see more details of any warnings or errors you may have gotten when building
the target.

n

Batch Targets In addition to single targets, if you build a batch target, the process for each
one is shown in the Builds window pane.
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TOOLBAR AND CONTEXT MENU OPTIONS
Following are actions you can take in the Builds window pane by clicking a button in the local toolbar. In most cases you can also right-click on a row and select one of these options from the context menu.
n

Clear Finished This clears all rows from the Builds window pane.

n

View Output This opens the output for the selected row if the target finished compiling
without errors. You may need to click on the row (to first give the grid focus) in order to see
this option in an enabled state. You can also double-click a row to open the output for a successful build. Depending on the type of output, you can select the device or browser you
want to use to view the output from a drop-down menu.

n

Open Build Log This opens the log file of the selected row so you can see more information
about any issues with the build. You can also double-click a row to open the log file for a target that failed to build.

n

Stop Build This cancels generation of the target. You will see yellow cells as a result.

n

Rebuild Target This rebuilds the target for the selected row.

n

Build Targets This lets you build multiple targets. Following are the primary benefits of this
feature:
l

l

l

You do not need to have a Flare project open at all in order to use this feature.
You can select targets for any Flare project, even if that project is different from one
you happen to have open at the moment.
This feature functions sort of like a batch target, in that you can choose to build and/or
publish multiple targets. The difference is that, with this feature, you do not need to first
create a batch target file in Flare.
NOTE: Batch targets have their own advantages over this feature. For
example, they allow you to retain your build and publish settings for each target,
so that you can easily reuse them in the future. Also, you can schedule batch
targets to run any time in the future, even if you're not at your computer.

n

Open Output Folder This opens the output folder in Windows for the selected row.

n

Clean Target This lets you remove the content from the output folder for the selected target.
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ORGANIZING COLUMNS
You can reorder or hide columns in the Builds window pane. There are a few ways to do this.
n

First, you can click on a column header and drag it to the right or left, dropping it in a new location.
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n

Second, you can right-click any column header, which displays a menu. Click next to the
column titles (adding or removing check marks) to show or hide those columns in the Builds
window pane.
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n

Third, from the right-click menu, you can select Columns. This opens the Manage Columns
dialog.
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Again, you can show or hide columns by adding or removing check marks next to the column
titles. You can also click and drag the rows up or down to change the order of the columns in
the Builds window pane. Finally, you can click Reset to Factory Settings if you want to undo
all of your changes and return to how everything was initially set.

Command Line
This option lets you build targets from your operating system's command line. Using this method,
you do not have to open Flare at all. In addition, this method allows you to build a single target or all
targets in your Flare project in one batch. The best way to use this feature is to create a batch file
with the necessary commands in it. Then you can use a scheduling tool (such as the "Scheduled
Tasks" utility in Windows) to run the batch file automatically whenever you want. This is similar to
the "batch target" feature. However, the command line feature works outside of the Flare interface,
is a bit more manual, and does not support as many processes. For steps see the online Help.
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Build Then View Automatically
If you select an option in the user interface to view output from a target, Flare shows that output if it
is up to date. But if there is no output or it is out of date, Flare gives you a message, asking if you
want to build the output.
You can select an option to avoid seeing this message for all targets in all projects. This can be done
in the Options dialog (File > Options) by selecting the Build tab and choosing Build target (if needed)
after selecting 'View'.

Where Output Files are Stored
When you build a target, Flare creates output files and places them in a folder named after the target, which is stored in a subfolder of your project called "Output." For example, let's say your project
is stored here: C:\MyProject. In that case, after you generate output, the files would be stored here:
C:\MyProject\Output\MyName\TargetName
Depending on the output type associated with the target, the generated output might consist of
many files.
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Publish Features
You can publish Flare output to different places in various ways. This includes manually, by using the
destination feature, or via MadCap Central.

Retrieving Files Manually
Select the Project ribbon. In the Build section select Open Output Folder.

You can also select this button in the Builds window pane.
Navigate to the folder showing the name of your target. Then you can copy those files to any location you want, whether it is on a network, in a version control directory, or up on a web server. You
might need to work with your network or web administrator to learn the proper way to move files in
your company, including login credentials.
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Using the Publishing Destination Feature
You can use Flare's publishing destination feature to automatically send a copy of the output files to
another location (e.g., to a network folder or a website).
To use this automated feature, you must first create a publishing destination for your output.
Next, associate the publishing destination with the target that you are using. See "Associating Publishing Destinations with Targets" on page 171.
Then when you build your output (or after you build it) you simply use the Publish button or check
box, depending on the method you use for generating the output (e.g., build primary target, single
target, batch target).
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Using MadCap Central
If your project is integrated with MadCap Central, you can build output from the Central interface.
After that, you can mark that build as “Live” or “Keep” with the click of a button. Setting a build to
“Live” means that the output can be viewed by the public. You can also set a build to “Keep” in case
you want to avoid deleting it, perhaps with the intention of rolling back to it at some point (i.e., setting it to “Live”).
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MadCap Connect for Salesforce®
If you decide to use the publishing destination feature, there are different ways that you can publish
the output (e.g., FTP, SFTP, source control). One of the unique methods is MadCap Connect for
Salesforce ®. With this integration, you can set up a destination file in Flare so that your Clean
XHTML output is published directly to Salesforce ®.
To use MadCap Connect for Salesforce ®, there are a few steps you must complete before editing
the destination file:
1. In your Salesforce ® account, make sure you turn on Knowledge. You need to create an article
type that includes a rich text field. For more information, please refer to the Salesforce ® documentation.
After completing the necessary tasks in Salesforce ®, you are ready to integrate it within a
Flare project.
2. When installing Flare, choose Custom as the type of installation, and click Next.
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3. On the next page of the wizard, select MadCap Connect for Salesforce ®.

4. After Flare is installed, open your project, create a destination file, and complete the MadCap
Connect for Salesforce ® fields.
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MadCap Connect for Zendesk
This plug-in allows you to publish Flare output to your Zendesk Help Center dashboard. This is beneficial if you have a knowledge base or FAQ that supports any service desk tickets on your dashboard.
You can publish directly to categories and sections you have created in Zendesk.
You have the option to install the plug-in when you install or upgrade Flare. The MadCap Connect
plug-in for Zendesk supports outputs using Clean XHTML and skinless HTML5 outputs.
Zendesk provides multilingual support to publish your articles.
There are a few steps that you need to complete before you can create the Zendesk destination
file.
1. When you install Flare, choose Custom as the type of installation. Click Next.
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2. On the next page of the installation wizard, select MadCap Connect for Zendesk. Click Next.

3. Click Install.
4. After the Flare installation is completed, open your project and create the destination file for
Zendesk.
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Files to be Distributed with Each Type of Output
The number of files that are generated and need to be distributed depends on the output type you
are creating and the settings that you provide when developing your project.

EPUB
EPUB output consists of a file with an .epub extension that you can distribute to users, who will be
able to open the file on a variety of ebook readers.
NOTE: Although EPUB is not really classified as either online or print-based output, it is
structured more like a print-based manual than a Help system. Therefore, you can treat its
distribution somewhat like an electronic PDF file.

HTML HELP
There is only one file that needs to be included—the CHM file, which is [Name of your project].chm
(e.g., FictionSoftPro.chm). Microsoft HTML Help is designed to be used on a desktop, rather than
being accessed from a web server.

HTML5
This output type requires that all files and folders in your project's Output folder be included for
your end users.
HTML5 is designed primarily to be published on a web server, but it can be stored locally as well.
However, if you enable advanced server-based output for HTML5, it is designed to be published to
a web server running Microsoft Internet Information Services (IIS), rather than attached to an
application or distributed otherwise.
For information about server-based HTML5 output and making it available to users, see and .

PDF
PDF output consists of a file with a .pdf extension that you can print or distribute to users.

WEBHELP
This output type requires that all files and folders in your project's Output folder be included for
your end users.
WebHelp is designed primarily to be published on a web server, but it can be stored locally as well.
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WEBHELP PLUS
This output type requires that all files and folders in your project's Output folder be included for
your end users.
WebHelp Plus is designed to be published to a web server running Microsoft Internet Information
Services (IIS), rather than attached to an application or distributed otherwise.
For information about WebHelp Plus and making it available to users, see and .

WORD
Depending on your settings, Microsoft Word consists of one or more XML, DOC, DOX, XPS, or PDF
files that you will distribute to users.

CHAPTER 9

313

Frequently Asked Questions
Following are some common questions about building and publishing output.

WHAT FILES ARE PRODUCED WHEN YOU BUILD OUTPUT?
This varies depending on the output format. Some formats will produce a single output file, such as
a PDF. Other formats might produce many files and folders. To see the exact files and folders that
are produced when you generate a target, select the Project ribbon. Then in the Build section select
Open Output Folder.
Also, a log file is created whenever you build a target and is stored by default with the rest of the output. This file provides important information about the build, such as whether any warnings
occurred in the process. However, if you do not want your log file to be included with the rest of the
files, you can open the Options dialog (File > Options), select the Build tab, and choose an external
location for log files.
For more details of the generated files that you need to provide to end users, see "Files to be Distributed with Each Type of Output" on page 312.

WHAT IS PRODUCED WHEN YOU PUBLISH OUTPUT?
Publishing isn’t a matter of producing anything. Instead, it’s simply a matter of taking those output
files, making a copy of them, and placing them somewhere that end users can access them. This
can be accomplished manually or automatically by using a destination file. See "Publish Features"
on page 305.

WHAT HAPPENS TO OLD FILES WHEN YOU REBUILD A TARGET?
In Flare, the previously generated files are all removed when you rebuild a target. These are then
replaced by the newly generated files. Therefore, if you want to preserve files from an older build,
you will need to open Windows Explorer and copy those files to another location so that they are not
overwritten by new files.
However, the situation is different if you are using MadCap Central to generate output. In Central,
each build is preserved until you delete it.

WHAT HAPPENS TO OLD FILES WHEN YOU REPUBLISH OUTPUT?
This depends on how you choose to publish your output.
If you manually replace previously published files with new ones, it is generally best to delete all of
the old files and then upload or paste the new ones in the same location.
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If you use a destination file, you have the option in the Destination Editor of uploading only files that
have changed since the previous publication. You also have the option of automatically removing
stale files (i.e., those that were removed in your local project since that last publication).

WARNING: Do not publish your output into your source folders (Content or Project). It is
always best to publish output outside your main project folder altogether. Otherwise, you
might lose your source files.

WARNING: If your computer's anti-virus (AV) software scans the Output folder during the
build process and you experience one or more "Build Failed" errors, the AV software may be
preventing the build process from accessing the output files. To avoid this, you can temporarily turn off or disable your AV scan. You may also be able to exclude the Output folder,
add Flare to an exceptions list, or postpone/reschedule scans to a different time. See your
AV vendor for information.

TIP: You do not need to build the target to see how a particular topic will look in the final output. You can always preview topics as you develop your project by clicking
in the local
toolbar of the XML Editor. If you click the face of the button, the preview is shown based on
the format specified in the primary target. If you click the down arrow, you can select any of
the targets in your project from a menu. The preview is then displayed using the output
format specified in that target. In addition, you can continue to edit the topic with the Preview window pane open. The preview will automatically update as you save changes to the
topic.
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Building and Publishing the Primary Target
Use the following steps if you want to quickly build and publish the primary target for your project.
What do we mean by this? It has to do with the final output of your project. When all is said and done
with your project, you want your output to look and behave in a certain way. But not all authors have
the same audience or work for the same company with the same needs and the same computer
networking setup. Therefore, Flare lets you choose the best type of output for your needs.
Now, in your project, you can use one or more of Flare's output types. You can even make copies of
one output type and make changes to it. Each instance of an output type is called a "target."
This concept of targets may seem a bit confusing if you are new to Flare. But don't worry. It will
become much more clear as you become more familiar with Flare.
So what is the big deal with the primary target? It is simply about convenience. Although you can
use more than one target for your project—you will most likely use just one target most of the time.
So Flare lets you designate one target as your primary target and gives you shortcuts to perform certain tasks with it, including building the output from the primary target.
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HOW TO BUILD AND PUBLISH THE PRIMARY TARGET
1. (Optional) If you plan to use the publishing destination feature to automatically copy your generated output files to a specific location, make sure you have already created the destination
file and associated it with your target.
2. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Build section select Build Primary (to build only)
or Publish Primary (to publish a target that has already been generated).

n

Local Toolbar Open the target. In the local toolbar of the Target Editor click
build only) or

n

(to

(to publish a target that has already been generated).

Keyboard Shortcut Press F6 (to build only) or CTRL+F6 (to publish a target that has
already been generated).

3. (Optional) A row is added to the Builds window pane, showing the progress of the target as it is
generated and/or published. If the target generates or publishes successfully, the color of the
Progress column changes from light to dark green, and the State column displays "Publish
Complete" (if you published). You can then double-click that row or select it and click View Output.
4. (Optional) The log file is generated and saved automatically at the location you specified on
the Build tab of the Options dialog (File > Options). The default location is the root level of the
output folder for that target. You can tell if errors or warnings have occurred by looking at the
appropriate columns in the Builds window pane. You can then select that row and in the local
toolbar click Open Build Log.
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Building and Publishing a Single Target
Use the following steps if you want to build and publish a single target in your project that may or
may not be designated as your primary target.

HOW TO BUILD AND PUBLISH A TARGET
1. (Optional) If you plan to use the publishing destination feature to automatically copy your generated output files to a specific location, make sure you have already created the destination
file and associated it with your target.
2. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Build section, select Build Primary > Build [name
of target] (to build only) or Publish Primary > Publish [name of target] (to publish a target
that has already been generated).

n

Local Toolbar Open the target. In the local toolbar of the Target Editor click
build only) or

n

(to

(to publish a target that has already been generated).

Right-Click In the Project Organizer, expand the Targets folder, right-click on a target, and
from the context menu select Build [name of target] (to build only) or Publish [name of target] (to publish a target that has already been generated).
NOTE: If you choose to publish a target that does not have generated output (or it is
out of date), Flare will let you know and ask if you want to build it first. If you select
Yes, Flare will build the target and then immediately publish the output files.

3. (Optional) A row is added to the Builds window pane, showing the progress of the target as it is
generated and/or published. If the target generates or publishes successfully, the color of the
Progress column changes from light to dark green, the Status column displays "Finished," and
the State column displays "Publish Complete" (if you published). You can then double-click
that row or select it and click View Output.
4. (Optional) The log file is generated and saved automatically at the location you specified on
the Build tab of the Options dialog (File > Options). The default location is the root level of the
output folder for that target. You can tell if errors or warnings have occurred by looking at the
appropriate columns in the Builds window pane. You can then select that row and in the local
toolbar click Open Build Log.
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Building and Publishing Multiple Targets
Use the following steps if you want to quickly build and publish multiple targets using an option in the
Builds window pane. The targets do not need to be within the project that you currently have open.
This is an alternative to using batch targets (see "Building Output Using a Batch Target" on the next
page).

HOW TO BUILD AND PUBLISH MULTIPLE TARGETS
1. (Optional) If you plan to use the publishing destination feature to automatically copy your generated output files to a specific location, make sure you have already created the destination
file and associated it with your target.
2. Open the Builds window pane (View > Builds).
3. In the local toolbar of the Builds window pane, click Build Targets. The Select Targets to Build
dialog opens.
4. On the left side of the dialog, navigate to the Flare project whose targets you want to build.
When you find the project, select the FLPRJ file. Any targets in the selected project are automatically listed on the right side of the dialog.
5. Click the Build and/or Publish check boxes for each target you want to compile or publish.
6. Click OK. In the Builds window pane, rows are added for each target you select and they begin
to compile and/or publish.
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Building Output Using a Batch Target
Use the following steps if you want to generate and/or publish one or multiple targets in a batch
from the user interface, perhaps scheduled to run at a specific time.

EXAMPLE
Let's say you have a project with 17 targets and you need to build and publish 12 of
those targets at the beginning of each day. Rather than manually building and generating each of these targets, you can use a batch target. Within this batch target, you
can select the check boxes at the top of the Build and Publish columns. This automatically selects the check boxes for each target. Then you can manually deselect the
5 targets you do not wish to build or publish. Furthermore, you can use the Schedule
tab in the batch target to specify that the batch should be run each night at 2 a.m.
When you arrive at the office each morning, the outputs for those 12 targets will
already be generated and placed in the appropriate publishing destination folders.
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Batch Generate Interface Versus Command Line
The batch target in the Flare interface is similar to the command line feature. However, the command line feature works outside of the Flare interface, is a bit more manual, and does not support as
many processes.
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Create a Batch Target
First, you must create a batch target. The batch target is a simple file that points to other targets
and stores information such as whether to build or publish targets, as well as scheduling commands. After creating the file, you can specify its settings in the Batch Target Editor. A batch target
file has an .flbat extension and is stored in the Project Organizer under the Targets folder.

HOW TO CREATE A BATCH TARGET
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Content section select New > Batch Target.

n

Right-Click In the Project Organizer, right-click on the Targets folder and from the context
menu select Add Batch Target.

The Add File dialog opens.
2. In the File Type field at the top, make sure Batch Target is selected.
3. In the Source area select one of the following:
n

New from template Choose either the factory template file or one of your own customized template files as a starting point. The new file will take on all of the settings contained in the template. If you want to use the factory template provided by Flare, expand
the Factory Templates folder and click on a template file. If you want to use your own customized template file, expand the appropriate folder and click on a file. For more information about templates, see the online Help.

n

New from existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click the browse button
, use the Open File dialog to find a file, and double-click it.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click
and select the subfolder. Otherwise,
keep the default location.
5. In the File Name field, type a new name for the batch target.
6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
and select the conditions you
want to apply. Click OK.
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7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click
and select the file tags you want to apply. Click OK.
8. Click Add. The target is added to the Targets folder in the Project Organizer.
9. A message asks if you want to create a scheduled task. Click Yes. The Batch Target Editor
opens to the right.
10. The Targets tab in the editor displays all of the non-batch targets already contained in your
project. Click the Build and/or Publish check boxes next to the targets that you want to be
affected when the batch runs. You can also click the check boxes at the top of each column;
this selects all of the check boxes in that column. Clicking the top check box again deselects
all of the check boxes in the column.
NOTE: In order for targets to be published when the batch runs, you must also create
and associate a publishing destination with the target(s).

11. Click
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(Optional) Schedule Build or Publish Processes
After you create a batch target in the Flare user interface, you can start that batch whenever you
need to (i.e., tell it to start building and/or publishing the related targets). However, you also have
the option of creating scheduled tasks. You might do this if you want your targets to be generated or
published automatically overnight. Scheduled builds are created using the Windows Task Scheduler. However, the user interface in Flare makes it easier for you to create scheduled tasks without
leaving the application. If you use this scheduling feature, you do not need to have Flare open at the
time the batch runs.
When a scheduled task runs, the command prompt window opens on your computer and minimizes
while the batch runs. This window closes automatically when the batch process is finished. If any
errors or warnings occur during the process, a report is automatically saved so you can review the
messages. You can then open the error report file from the Reports folder in the Project Organizer.
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HOW TO SCHEDULE BUILD OR PUBLISH PROCESSES
1. From the Targets folder in the Project Organizer, open the batch target file.
2. In the Batch Target Editor, click the Schedule tab.
3. If a message indicates that you must create a scheduled task, click Yes.
4. At the bottom of the tab, click New.

The New Trigger dialog opens.
5. In the Settings area, select how often you want the trigger in the batch to be run. You can also
click in the Start fields to change the beginning date and/or time:
n

If you select One Time, click in the Start fields to change the beginning date and/or time.

n

If you select Daily, a field displays so that you can specify a certain number of days for
the process to recur.

n

If you select Weekly, a field displays so that you can specify a certain number of weeks
for the process to recur. In addition, check boxes are available so that you can select certain days of the week for the process to run.
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n

If you select Monthly, additional fields are displayed so that you can select certain
months for the process to run, even on specific days during particular months.

6. (Optional) In the Advanced Settings area, you can set any of the following.
n

Repeat task every You can specify if you want the trigger for the batch to run periodically
after a certain number of minutes or hours.

n

For a duration of You can specify how long you want the trigger for the batch to be
repeated.

n

Expire You can specify whether the trigger for the batch should stop running after a certain date.

n

Enabled By default the trigger for the batch will be enabled. However, you can disable the
trigger if necessary. The trigger will remain in the batch file (even though it will not run
while being disabled). You can re-enable it in the future if you want.

7. Click OK.
TIP: Because scheduled tasks in batch targets use Windows Task Scheduler, the settings
in that utility are applied. By default, scheduled tasks will run only if you are logged on.
However, you can change this setting in Windows Task Scheduler so that the batch runs
whether you are logged on or not. To accomplish this, first open Windows Task Scheduler.
The steps may be different depending on the operating system. For example, in Windows 7
click the Start button and select All Programs > Accessories > System Tools > Task Scheduler. Then select Task Scheduler Library to see a list of your scheduled tasks. In the list
select the appropriate task and click Properties. Click Run whether user is logged on or not
(in Windows 7 this is on the General tab). Click OK. You will be prompted to enter your Windows login password. When you are finished working for the day, log off your computer
(instead of shutting down completely). The task will run as scheduled.

NOTE: If you create a scheduled task in a batch target, a .job file is automatically created in
Windows Task Scheduler. If you delete the batch target from within Flare, the .job file is
automatically removed from Windows Task Scheduler. However, if you delete the project or
batch target from Windows (outside of Flare), the .job file remains in Windows Task Scheduler. Therefore, you will need to remove the .job file manually from there.
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(Optional) Manually Start Build or Publish Processes
Although you can schedule a batch target to run at a specific time, you can always open the batch
target and manually start the batch.

HOW TO MANUALLY START BUILD OR PUBLISH PROCESSES
1. From the Targets folder in the Project Organizer, open the batch target file.
2. In the local toolbar of the Batch Target Editor, click any of the following.
n

Builds and publishes the selected targets (if they have check marks in
the Build and Publish boxes in the batch target).

n

Builds the selected targets (if they have check marks in the Build box in the
batch target).

n

Publishes the selected targets (if they have check marks in the Publish
boxes in the batch target).
NOTE: When you click the Publish Only option, Flare makes sure that each selected target already has generated output files. If so, those targets are published. If
output has not yet been generated, Flare builds the target and then publishes its
output files.

CHAPTER 9

327

3. (Optional) For each target in the batch, a row is added to the Builds window pane, showing the
progress of the target as it is generated. If the target generates successfully, the color of the
Progress columns changes from light to dark green, and the Status column displays "Finished." You can then select that row and in the local toolbar click View Output.
4. (Optional) For each target a log file is generated and saved automatically at the root level of
the output folder for that target, whether or not there are errors or warnings. You can tell if
errors or warnings have occurred by looking at the appropriate columns in the Builds window
pane. You can then select that row and in the local toolbar click Open Build Log.

NOTE: You can also select a target row in the Builds window pane and click Rebuild Target
to generate the output again.

NOTE: When you publish output using a batch target, changed files are replaced and stale
files are always removed.

NOTE: You cannot use scheduled tasks for batch targets if you are working in trial mode.
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CHAPTER 10

Viewing Output
You can view the generated output for any of the targets in your project in the following ways:
n

Primary Target View output for the primary target. See "How to View Output for the Primary
Target" on the next page.

n

Specific Target View output for a specific target in your project. See "How to View Output for
a Specific Target" on page 331.

n

Automatic View outputs automatically after generating targets. See "How to View Outputs
Automatically" on page 333.

n

Build Then View Automatically If you select an option in the user interface to view output from
a target, Flare shows that output if it is up to date. But if there is no output or it is out of date,
Flare gives you a message, asking if you want to build the output. This feature lets you avoid
seeing this message for all targets in all projects. See "How to Build Outputs Automatically if
Needed When Selecting View" on page 334.
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HOW TO VIEW OUTPUT FOR THE PRIMARY TARGET
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Content section select the face of the View
Primary button.
Alternatively, if you want to view your output using a specific browser, you can do this
from the ribbon. An extra flyout is provided in the drop-down if a particular target has generated output and your computer is set up to view it in different browsers or viewers.

n

Local Toolbar In the local toolbar of the Target Editor click

.

Alternatively, if you want to view your output using a specific browser, you can do this
from the Target Editor. An extra flyout is provided in the drop-down if a particular target
has generated output and your computer is set up to view it in different browsers or viewers.

n

Keyboard Shortcut Press SHIFT+F6.

2. If the output for the target has not yet been generated or is out of date, a message lets you
know and asks if you want to generate the output. Click Yes. The generated output opens.
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HOW TO VIEW OUTPUT FOR A SPECIFIC TARGET
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Project ribbon. In the Build section select View Primary > View [name
of target].

n

Local Toolbar In the local toolbar of the Target Editor click

n

Right-Click In the Project Organizer, open the Targets folder, right-click on a target, and
from the context menu select View [name of target].

n

Builds Window Pane In the grid of the window pane, double-click the target row whose
output you want to view.

.

Alternatively, you can select the row, then in the local toolbar click View Output. Depending on the type of target, you can choose a specific browser or device (such as an EPUB
reader) to view the output.

If you generated output that is enabled with responsive design, the View Output button in
the Builds window pane includes view options not only for seeing output on a full browser
output, but also on a tablet or smart phone.
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A preview of the output is shown based on your selection.
2. If the output for the target has not yet been generated or is out of date, a message lets you
know and asks if you want to generate the output. Click Yes. The generated output opens.
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HOW TO VIEW OUTPUTS AUTOMATICALLY
1. Select File > Options.
The Options dialog opens.
2. Select the Build tab.
3. Select View output after successful build.

4. Click OK.
After you generate a target, the output will automatically open, without asking you first.
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HOW TO BUILD OUTPUTS AUTOMATICALLY IF NEEDED WHEN SELECTING VIEW
1. Select File > Options.
The Options dialog opens.
2. Select the Build tab.
3. Select Build target (if needed) after selecting 'View'.

4. Click OK.
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APPENDIX A

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
USER GUIDES

Accessibility Guide

HTML Help Guide

Analysis and Reports Guide

HTML5 Guide

Architecture Guide

Images Guide

Autonumbers Guide

Importing Guide

Condition Tags Guide

Index Guide

Context-sensitive Help Guide

Key Features Guide

Eclipse Help Guide

Language Support Guide

Getting Started Guide

MadCap Central Integration Guide

Global Project Linking Guide

Master Pages Guide
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Micro Content Guide

Source Control Guide: Git

Movies Guide

Source Control Guide: Perforce

Navigation Links Guide

Source Control Guide: Subversion

Plug-In API Guide

Source Control Guide: Team Foundation Server

Print-based Output Guide

Styles Guide

Project Creation Guide

Tables Guide

Pulse Guide

Tables of Contents Guide

QR Codes Guide

Targets Guide

Reports Guide

Templates Guide

Reviews & Contributions Guide

Topics Guide

Search Guide

Touring the Workspace Guide

SharePoint Guide

Transition From FrameMaker Guide

Skins Guide

Variables Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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APPENDIX B

Output Type Comparison Tables
Following are tables that show the various output types available, with the distinguishing features of each.
This chapter discusses the following:

APPENDIX B

General

339

Accessibility

340

Context-sensitive Help

341

Generated Content

342

Glossaries

347

Images

349

Indexes

351

Language Support

354

Master Pages and Page Layouts

357

Merging Output

358

Miscellaneous Features

359

337

Multimedia

362

Navigation Links

367

Responsive Output

369

Search

370

Skins

381

Social Media (Pulse and Feedback)

387

Tables of Contents and Mini-TOCs

388

Target Settings

390

Variables

395

NOTE: If an item does not have a check mark, that does not necessarily mean the feature is unavailable in the output. Rather, it
means that the feature cannot be added in Flare. For example, search cannot be added in Flare for EPUB output, but some
ebook readers may have search built in.
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General
Following are general features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

.NET Integration
Single Output File
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Accessibility
Following are accessibility features (e.g., Section 508, WCAG) supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Accessibility Supported
Compiler
Warnings
Empty Alt
Text for
Images
Scrolling
for Toolbars and
Navigation
Frames
(Enable)
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Context-sensitive Help
Following are context-sensitive Help (CSH) features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

CSH Supported
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Generated Content
Following are generated content features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Autonumbers1
Breadcrumbs
Browse
Sequences
Concept
Links
Keyword
Links
Glossaries
from Proxies
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ONLINE

PRINT

OTHER

LEGACY

Indexes
from Proxies
List of Concepts
List of Elements
List of Endnotes
Lists
(Numbered
and Bulleted)
Menus from
Proxies
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ONLINE

PRINT

OTHER

LEGACY

Mini-TOCs
from Proxies
Page Numbers
Related Topics Links
Relationship
Links
Scripts
Search Bars
from Proxies
Search Results from
Proxies
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ONLINE

PRINT

OTHER

LEGACY

Shortcut
Controls
TOCs from
Proxies
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ONLINE

PRINT

OTHER

LEGACY

Topic Toolbars from
Proxies
1It is

possible to use autonumbering in online outputs, but only in a limited way. For example, if you have notes throughout your project, you can create

an autonumber format on a paragraph style class that simply has the text "Note:" followed by a space. Then whenever you want to apply that style
class to note content, it will automatically start with "Note:" so that you don't have to type it each time. However, in the traditional sense where
autonumbering is used to increment numbers for elements such as chapters, figures, and tables, it is really only intended for print-based outputs. If
you are creating both online and print output and want the autonumbering to be used only for content in the print output, you can use a print medium to
specify the autonumbering settings for the print output.
2In most cases,

browse sequences are generated via a skin. This method is supported in HTML5 Tripane output, but not in HTML5 Side Navigation,

Top Navigation, or skinless output. However, another way to use a browse sequence is by associating it with a menu proxy. With this method, browse
sequences are supported in all HTML5 output formats.
3For Clean XHTML

output, MadCap-injected JavaScript is removed. In other words, features such as drop-downs, Help controls, text popups, and foot-

notes rely on JavaScript to work. Therefore, with Clean XHTML output, these elements are converted to text. However, custom scripts that you might
have added to topics will not automatically be removed when you generate Clean XHTML; if you want to exclude these custom scripts, you must do so
manually (i.e., by deleting them or using conditions).
4In HTML5,

the proxies and related skin components for search bars and search results are supported only in Side Navigation, Top Navigatino, and

skinless outputs. They are not supported in Tripane output.
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Glossaries
Following are glossary features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Glossaries Supported
(Via
Proxy)1
Glossaries Supported
(Via Skin)
Auto-Generate
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ONLINE

PRINT

OTHER

LEGACY

Glossary
Term
Links
Sorting
1For most online

outputs, creating a glossary via a skin is the preferred method. However, it is possible to use a proxy to include glossaries in these

outputs as well.
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Images
Following are image features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Absolute
Positioning
Image
Hyperlinks
Image
Maps
Pre-Compile Resized
Images
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ONLINE

PRINT

OTHER

LEGACY

Thumbnail
Images
Web-Safe
(Convert
from
Non—WebSafe)
1For Clean XHTML

output, thumbnail images that are set as popups are converted to linked thumbnail images (i.e., the enlarged image opens in a new

window instead of in a popup).
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Indexes
Following are index features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Indexes
Supported
(Via
Proxy)1
Indexes
Supported
(Via Skin)
Auto-Generate
Binary
Indexes
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ONLINE

PRINT

OTHER

LEGACY

Bookmarks in
Index
Entries
Index
Links
Search
(Can
Exclude
Index
Entries
from
Search)
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ONLINE

PRINT

OTHER

LEGACY

Sorting
(Index
Links)
1For online

outputs, creating an index is typically done via a skin. By default, the MadCap style that controls index proxies is set to support only print-

based outputs. However, you can change this. To do so, open your stylesheet, select the MadCap|indexProxy style, and set the mc-output-support
property to all (all-print is the default setting). By doing this, you can use the index proxy method to generate an index in some online outputs as well.
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Language Support
Following are language support features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Author and
Generate
Output in
Left-toRight (LTR)
and Rightto-Left
(RTL) Languages
Invert
Image Callouts to
RTL
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ONLINE

PRINT

OTHER

LEGACY

Invert Page
Layouts to
RTL
Invert
Styles to
RTL
Multilingual
Support
(Link to
External
Projects in
Target)
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ONLINE

PRINT

OTHER

LEGACY

Output
Interface
(Display in
LTR and
RTL)
Language
Skins
Separate UI
Text Tab in
Skin Editor
for Localization
1This

is controlled on the UI Text tab in a regular HTML5 skin.

2This

is controlled in a language skin.

3As

an alternative to using language skins, you can use the UI Text tab in the Skin Editor to perform all of the localization tasks for HTML5 targets. Be

aware that translations in the Skin Editor are prioritized over translations in a language skin, so you should try to perform your localization tasks in one
place to avoid conflicts.
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Master Pages and Page Layouts
Following are master page and page layout features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Master
Pages
Supported
Page Layouts Supported

APPENDIX B

357

Merging Output
Following are merging output features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Merge
Output
Supported
Merge
Output at
Runtime
Stitch Output
1

Flare's HTML5 Side and Top Navigation skins do not support project merging.

2

HTML5 outputs do not support pre-merging.
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Miscellaneous Features
Following are miscellaneous features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Equations
Footnote1
Horizontal
Rules
MadCap
Central
(Build Output from
Central)
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ONLINE

PRINT

OTHER

LEGACY

MadCap
Central
(View Output from
Central)
Micro Content
Object Positioning
Preview
Topics in
Output
Type
QR Codes
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ONLINE

PRINT

OTHER

LEGACY

Redacted
Text
Salesforce
Publishing
Slideshow
Snippets
Tables
Text Boxes
Zendesk
Publishing
1For online
2This

outputs, footnotes are converted to popups.

is supported only if you are using Elasticsearch or MadCap Search, but not Google Search.

3If you publish output to Zendesk,
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Multimedia
Following are multimedia features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

3D Models
(U3D)
Audio/Video
ASF
ASX
AU
AVI4
M4V4
MID
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ONLINE

PRINT

OTHER

LEGACY

MIDI
MP3
MP4 4
MPA
MPE
MPEG
MPG
OGG4
OGV4
OPUS
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ONLINE

PRINT

OTHER

LEGACY

SWF
WAV
WEBM4
WMA
WMV

MadCap Mimic Movie Links
Flash
(SWF)
Format

APPENDIX B

364

ONLINE

PRINT

OTHER

LEGACY

HTML5
Format
(Depending on
Browser)4
Mimic
Movie
Format
Silverlight
Format
Vimeo
Embedded
Videos
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ONLINE

PRINT

OTHER

LEGACY

YouTube
Embedded
Videos
1EPUB

support for each element or file type depends on if a particular reader supports it.

2PDF support for 3D

Models requires Adobe Reader 7.0+.

3For this

output, the 3D Model opens in a separate window.

4To view

HTML5 movie output, end users must have a newer browser that supports these types of videos.

5This

file format does not work in Internet Explorer.

6If you generate

Microsoft HTML Help, YouTube videos are rendered smaller than in other outputs and Vimeo Advanced settings are not supported.

However, you can make it work by adding the default meta tag to your target: <meta http-equiv="X-UA-Compatible" content="IE=Edge" />.
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Navigation Links
Following are navigation link features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

CrossReferences Supported
CrossReferences
(Contextsensitive)
DropDown Text
Expanding
Text
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ONLINE

PRINT

OTHER

LEGACY

Text Hyperlinks
Text
Popups
Togglers
Topic
Popups
Topic Toolbars
Web Toolbars
1This

is available in the Tripane output only. It is not available in Side or Top Navigation outputs.
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Responsive Output
Following are responsive output features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Responsive Content 1
Responsive Skins
1This

refers to the use of the Responsive Layout window pane (Home > Responsive Layout) to create content that adjusts automatically, depending on

the screen size.
2Responsive
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Search
Following are search features supported in each online output type.

General Support
The table below summarizes search support in each output type:
ONLINE

PRINT

OTHER

LEGACY

Search
Supported
Via Flare
Integration

End User Search Features
The table below summarizes the key search features and capabilities for each output type. With HTML5 and WebHelp outputs, you can
distribute either client- or server-based outputs. This is why the table below lists them twice—under client- and server-based output.
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End user search features are supported by the Eclipse Help Viewer and search operations are provided by a plug-in that you develop
using the Eclipse platform (for more information, see help.eclipse.org). The Flare search engine does not handle Eclipse Help search
operations.
CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Glossary Search
(Find Matching
Terms)
Index Search
(Find Matching
Terms)
Predictive Search
Search Favorites
(Save Queries to
Favorites List)
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Search Query
(Asterisk
(*) Wildcard Character)
Search Query
(Boolean Operators)
Search Query
(Full-text Search—
not case sensitive)
Search Query
(Enclose Terms in
Quotes)
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Search Results
(Narrow Search
Scope Using
Search Filter
Sets)
Search Results
(Results Listed in
Ranked Order and
Show Rank Number)
Search Results
(Search Hits Highlighted in Topics)
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Search Results
(Search Hits Bolded)
1Select the

operator from the built-in list.

2Search filters
3Results

are not supported in Elasticsearch.

are listed in order. Rank number is not visible.
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Content Developer Search Features
This table summarizes the key search features and capabilities that are available to you, the content developer, for each output type.
With HTML5 and WebHelp outputs, you can distribute either client- or server-based outputs. This is why the table below lists them
twice—under client- and server-based output.
CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Enable
Content Optimization
Setting the Search
Abstract Character Limit
Content Optimization
Setting Search Result
Importance
Content Optimization
Including Glossary Terms
in Search Results
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Content Optimization
Setting the Number of
Search Results Per Page
Elasticsearch
About Elasticsearch
Google Search
Setting Up a Search
Engine
Micro Content Featured
Snippets
Enabling Micro Content
in Search Results
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Search Highlighting
Customizing the Highlight Color for Search
Hits
Search Optimization
Enabling Partial-word
Search
Search Optimization
Including Stop Words in
Search
Search Performance
Excluding Index Entries
From Search
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Search Performance
Excluding Non-words
from Search
Search OptimizationPerformance
Setting the N-Gram Size
for Search
Search Performance
Chunking Large Search
Database Files
Search Performance
Pre-merging Search Database Files
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Search Results
Customizing Search Filter Ordering
Search Toolbar
Specifying Web Toolbar
Settings—WebHelp Outputs
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CLIENT-BASED OUTPUT

SERVER-BASED OUTPUT

Styles
Styles for Generated
Pages
1HTML5 skin.
2Standard skin.
3This

is supported if you are using Elasticsearch or MadCap Search, but not Google Search.

4This

is supported only in HTML5 Side Navigation, Top Navigation, and skinless outputs. It is not supported in HTML5 Tripane output.

5Stop words

are always enabled.

6Index entries
7Non-words
8SQL

are always excluded.

are always excluded.

Server Compact is required.
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Skins
Following are skin features supported in each output type:
ONLINE

Skin Type

HTML5

PRINT

OTHER

LEGACY

Std

Std

Std

About Box
Accordion
Titles
(Exclude)
Browser Settings
Caption for
Output Window
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ONLINE

PRINT

OTHER

LEGACY

Elements
Such as Tabs,
Accordions
(Specify
Default Element)
Elements
Such as Tabs,
Accordions
(Specify
Which to
Include)
Feedback
Comments,
Email Notifications,
User Profile
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ONLINE

PRINT

OTHER

LEGACY

Generate All
Language
Skins
Menu Skin
Component
Navigation
Links in Standalone Topics
Navigation
Pane Settings
Preview Skin
for Output
Type
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ONLINE

PRINT

OTHER

LEGACY

Runtime
Skins
(Choose Different Skins
at Runtime)
Search Bar
Skin Component
Search Results Skin
Component
Separate UI
Text Tab in
Skin Editor
for Localization
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ONLINE

PRINT

OTHER

LEGACY

Styles
TOC Entry
(Select Skin
For)
Topic Toolbar
(Custom Settings)
Web Toolbar
(Add via Skin)
Web Toolbar
(Custom Settings)
Window
(Size/Position)
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ONLINE

PRINT

OTHER

LEGACY

Window
(User-defined
Size/Position)
1This

is available in the Tripane skin only. It is not available in the Side or Top Navigation skins.

2This

is handled through the org.eclipse.help.base plug-in.

3As

an alternative to using language skins, you can use the UI Text tab in the Skin Editor to perform all of the localization tasks for HTML5 targets. Be

aware that translations in the Skin Editor are prioritized over translations in a language skin, so you should try to perform your localization tasks in one
place to avoid conflicts.
4This

is available in the Side and Top Navigation skins only. It is not available in the Tripane skin.

5Only some
6Topic

styles (e.g., Feedback, toolbar) are supported.

toolbar settings can be controlled in a Topic Toolbar skin component, as well as in a Topic Toolbar proxy.
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Social Media (Pulse and Feedback)
Following are the social media features supported in each output type (Pulse is the newer, and recommended solution; Feedback is a legacy method):
ONLINE

PRINT

OTHER

LEGACY

Feedback
Supported
Feedback
Search
Results
Pulse Supported
1For HTML5,
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Tables of Contents and Mini-TOCs
Following are table of contents (TOC) and mini-TOC features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

TOCs(Via
Proxy)
TOCs(Via
Skin)
Auto-generate
Binary
TOCs
Mark as
New
Mini-TOCs
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ONLINE

PRINT

OTHER

LEGACY

Skin (Select
for TOC
Entry)
Synchronize
With Topics
1Some

ebook readers have a built-in TOC.
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Target Settings
Following are target features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Auto-generate Glossary, Index,
TOC for Print
Characters
and Spaces
(Replace
With Underscores)
CMYK
Content
Folder (Omit
from Output)
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ONLINE

PRINT

OTHER

LEGACY

Crop and
Registration
Marks
(Include in
Output)
DOCTYPE
Declaration
Empty Pages
(Inject Automatically)
File Extensions (Custom)
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ONLINE

PRINT

OTHER

LEGACY

Languages
(Link to
External Projects—Create
Multilingual
Output)
Mark of the
Web
Meta Tags
(Custom)
Micro Content Featured
Snippets in
Search
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ONLINE

PRINT

OTHER

LEGACY

Navigation
Elements
(Synchronize
with TOC
Entries)
Startup Topic
Stylesheet
Medium
Stylesheets
(Convert
Styles to
Inline)
Tracked
Changes (Preserve)
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ONLINE

PRINT

OTHER

LEGACY

Warnings
(Ignore)
1We

recommend disabling this option for non-English content.

2This

feature is supported in HTML5 Side and Top Navigation outputs, but not in HTML5 Tripane output. Navigation elements are always automatically

synchronized with TOC entries in Tripane output without selecting an option to enable it.
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Variables
Following are variable features supported in each output type:
ONLINE

PRINT

OTHER

LEGACY

Basic
Variables
Date &
Time
Variables
Heading
Variables
Running
HF Variables
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ONLINE

PRINT

OTHER

LEGACY

Snippet
Variables
System
Variables
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